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Preface
Welcome to the MSP430 IAR C/C++ Compiler Reference Guide. The 
purpose of this guide is to provide you with detailed reference information 
that can help you to use the MSP430 IAR C/C++ Compiler to best suit your 
application requirements. This guide also gives you suggestions on coding 
techniques so that you can develop applications with maximum efficiency.

Who should read this guide
You should read this guide if you plan to develop an application using the C or C++ 
language for the MSP430 microcontroller and need to get detailed reference information 
on how to use the MSP430 IAR C/C++ Compiler. In addition, you should have a 
working knowledge of the following:

● The architecture and instruction set of the MSP430 microcontroller. Refer to the 
documentation from Texas Instruments for information about the MSP430 
microcontroller

● The C or C++ programming language

● Application development for embedded systems

● The operating system of your host computer.

How to use this guide 
When you start using the MSP430 IAR C/C++ Compiler, you should read Part 1. Using 
the compiler in this guide.

When you are familiar with the compiler and have already configured your project, you 
can focus more on Part 2. Reference information.

If you are new to using the IAR Systems build tools, we recommend that you first study 
the MSP430 IAR Embedded Workbench® IDE User Guide. This guide contains a 
product overview, tutorials that can help you get started, conceptual and user 
information about the IAR Embedded Workbench IDE and the IAR C-SPY® Debugger, 
and corresponding reference information.
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What this guide contains
What this guide contains 
Below is a brief outline and summary of the chapters in this guide.

Part 1. Using the compiler

● Getting started gives the information you need to get started using the MSP430 IAR 
C/C++ Compiler for efficiently developing your application.

● Data storage describes how data can be stored in memory, with emphasis on the 
different data models and data memory type attributes. 

● Functions gives a brief overview of function-related extensions—mechanisms for 
controlling functions—and describes some of these mechanisms in more detail.

● Placing code and data describes the concept of segments, introduces the linker 
command file, and describes how code and data are placed in memory.

● The DLIB runtime environment describes the DLIB runtime environment in which 
an application executes. It covers how you can modify it by setting options, 
overriding default library modules, or building your own library. The chapter also 
describes system initialization and introduces the file cstartup, as well as how to 
use modules for locale, and file I/O.

● The CLIB runtime environment gives an overview of the CLIB runtime libraries and 
how they can be customized. The chapter also describes system initialization and 
introduces the file cstartup.

● Assembler language interface contains information required when parts of an 
application are written in assembler language. This includes the calling convention.

● Using C++ gives an overview of the two levels of C++ support: The 
industry-standard EC++ and IAR Extended EC++.

● Efficient coding for embedded applications gives hints about how to write code that 
compiles to efficient code for an embedded application.

Part 2. Reference information

● External interface details provides reference information about how the compiler 
interacts with its environment—the invocation syntax, methods for passing options 
to the compiler, environment variables, the include file search procedure, and the 
different types of compiler output. The chapter also describes how the compiler’s 
diagnostic system works.

● Compiler options explains how to set options, gives a summary of the options, and 
contains detailed reference information for each compiler option.

● Data representation describes the available data types, pointers, and structure types. 
This chapter also gives information about type and object attributes.
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● Compiler extensions gives a brief overview of the compiler extensions to the 
ISO/ANSI C standard. More specifically the chapter describes the available C 
language extensions.

● Extended keywords gives reference information about each of the MSP430-specific 
keywords that are extensions to the standard C/C++ language.

● Pragma directives gives reference information about the pragma directives.

● Intrinsic functions gives reference information about the functions that can be used 
for accessing MSP430-specific low-level features.

● The preprocessor gives a brief overview of the preprocessor, including reference 
information about the different preprocessor directives, symbols, and other related 
information.

● Library functions gives an introduction to the C or C++ library functions, and 
summarizes the header files. 

● Segment reference gives reference information about the compiler’s use of 
segments.

● Implementation-defined behavior describes how the MSP430 IAR C/C++ Compiler. 
handles the implementation-defined areas of the C language standard.

Other documentation
The complete set of IAR Systems development tools for the MSP430 microcontroller is 
described in a series of guides. For information about:

● Using the IAR Embedded Workbench® IDE with the IAR C-SPY Debugger®, refer 
to the MSP430 IAR Embedded Workbench® IDE User Guide

● Programming for the MSP430 IAR Assembler, refer to the MSP430 IAR Assembler 
Reference Guide

● Using the IAR XLINK Linker, the IAR XAR Library Builder, and the IAR XLIB 
Librarian, refer to the IAR Linker and Library Tools Reference Guide

● Using the IAR DLIB Library functions, refer to the online help system

● Using the IAR CLIB Library functions, refer to the IAR C Library Functions 
Reference Guide, available from the online help system.

● Porting application code and projects created with a previous MSP430 IAR 
Embedded Workbench IDE, refer to MSP430 IAR Embedded Workbench® 
Migration Guide

● Developing safety-critical applications using the MISRA C guidelines, refer to the 
IAR Embedded Workbench® MISRA C Reference Guide.

All of these guides are delivered in hypertext PDF or HTML format on the installation 
media. Some of them are also delivered as printed books.
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FURTHER READING

The following books may be of interest to you when using the IAR Systems 
development tools: 

● MSP430xxxx User’s Guide provided by Texas Instruments

● Barr, Michael, and Andy Oram, ed. Programming Embedded Systems in C and 
C++ . O’Reilly & Associates. 

● Harbison, Samuel P. and Guy L. Steele (contributor). C: A Reference Manual. 
Prentice Hall.

● Kernighan, Brian W. and Dennis M. Ritchie. The C Programming Language. 
Prentice Hall. [The later editions describe the ANSI C standard.]

● Labrosse, Jean J. Embedded Systems Building Blocks: Complete and Ready-To-Use 
Modules in C. R&D Books.

● Lippman, Stanley B. and Josée Lajoie. C++ Primer. Addison-Wesley.

● Mann, Bernhard. C für Mikrocontroller. Franzis-Verlag. [Written in German.]

● Stroustrup, Bjarne. The C++ Programming Language. Addison-Wesley.

We recommend that you visit the following web sites:

● The Texas Instruments web site, www.ti.com, contains information and news about 
the MSP430 microcontrollers.

● The IAR Systems web site, www.iar.com, holds application notes and other 
product information.

● Finally, the Embedded C++ Technical Committee web site, 
www.caravan.net/ec2plus, contains information about the Embedded C++ 
standard.

Document conventions 
When, in this text, we refer to the programming language C, the text also applies to C++, 
unless otherwise stated.

TYPOGRAPHIC CONVENTIONS

This guide uses the following typographic conventions:

Style Used for

computer Text that you enter or that appears on the screen.

parameter A label representing the actual value you should enter as part of a 
command.

Table 1: Typographic conventions used in this guide 
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[option] An optional part of a command.

{option} A mandatory part of a command.

a|b|c Alternatives in a command.

bold Names of menus, menu commands, buttons, and dialog boxes that 
appear on the screen.

reference A cross-reference within this guide or to another guide.

… An ellipsis indicates that the previous item can be repeated an arbitrary 
number of times.

Identifies instructions specific to the IAR Embedded Workbench 
interface.

Identifies instructions specific to the command line interface.

Identifies helpful tips and programming hints.

Style Used for

Table 1: Typographic conventions used in this guide  (Continued)
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Part 1. Using the compiler
This part of the MSP430 IAR C/C++ Compiler Reference Guide includes the 
following chapters:

● Getting started

● Data storage

● Functions

● Placing code and data

● The DLIB runtime environment

● The CLIB runtime environment

● Assembler language interface

● Using C++

● Efficient coding for embedded applications.
C430-7
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Getting started
This chapter gives the information you need to get started using the MSP430 
IAR C/C++ Compiler for efficiently developing your application.

First you will get an overview of the supported programming languages, 
followed by a description of the steps involved for compiling and linking an 
application.

Next, the compiler is introduced. You will get an overview of the basic settings 
needed for a project setup, including an overview of the techniques that enable 
applications to take full advantage of the MSP430 microcontroller. In the 
following chapters, these techniques will be studied in more detail.

IAR language overview
There are two high-level programming languages you can use with the MSP430 IAR 
C/C++ Compiler:

● C, the most widely used high-level programming language used in the embedded 
systems industry. Using the MSP430 IAR C/C++ Compiler, you can build 
freestanding applications that follow the standard ISO 9899:1990. This standard is 
commonly known as ANSI C.

● C++, a modern object-oriented programming language with a full-featured library 
well suited for modular programming. IAR Systems supports two levels of the 
C++ language: 

● Embedded C++ (EC++), a subset of the C++ programming standard, which is 
intended for embedded systems programming. It is defined by an industry 
consortium, the Embedded C++ Technical committee. See the chapter Using 
C++.

● IAR Extended Embedded C++, with additional features such as full template 
support, multiple inheritance, namespace support, the new cast operators, as well 
as the Standard Template Library (STL).

Each of the supported languages can be used in strict or relaxed mode, or relaxed with 
IAR extensions enabled. The strict mode adheres to the standard, whereas the relaxed 
mode allows some deviations from the standard. For more details, see the chapter 
Compiler extensions.
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Supported MSP430 devices
It is also possible to implement parts of the application, or the whole application, in 
assembler language. See the MSP430 IAR Assembler Reference Guide.

For more information about the Embedded C++ language and Extended Embedded 
C++, see the chapter Using C++.

Supported MSP430 devices
The MSP430 IAR C/C++ Compiler supports all devices based on the standard Texas 
Instruments MSP430 microcontroller, which includes both the MSP430 architecture 
and the MSP430X architecture. In addition, the application can use the hardware 
multiplier if available on the device.

Building applications—an overview
A typical application is built from a number of source files and libraries. The source files 
can be written in C, C++, or assembler language, and can be compiled into object files 
by the MSP430 IAR C/C++ Compiler or the MSP430 IAR Assembler.

A library is a collection of object files that are added at link time only if they are needed. 
A typical example of a library is the compiler library containing the runtime 
environment and the C/C++ standard library. Libraries can also be built using the IAR 
XAR Library Builder, the IAR XLIB Librarian, or be provided by external suppliers.

The IAR XLINK Linker is used for building the final application. XLINK normally uses 
a linker command file, which describes the available resources of the target system.

Below, the process for building an application on the command line is described. For 
information about how to build an application using the IAR Embedded Workbench 
IDE, see the MSP430 IAR Embedded Workbench® IDE User Guide.

COMPILING

In the command line interface, the following line compiles the source file myfile.c 
into the object file myfile.r43 using the default settings:

icc430 myfile.c

In addition, you need to specify some critical options, see Basic settings for project 
configuration, page 5.
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LINKING 

The IAR XLINK Linker is used for building the final application. Normally, XLINK 
requires the following information as input:

● A number of object files and possibly certain libraries

● The standard library containing the runtime environment and the standard language 
functions

● A program start label

● A linker command file that describes the placement of code and data into the 
memory of the target system

● Information about the output format.

On the command line, the following line can be used for starting XLINK:

xlink myfile.r43 myfile2.r43 -s __program_start -f lnk430.xcl 
cl430f.r43 -o aout.a430 -r

In this example, myfile.r43 and myfile2.r43 are object files, lnk430.xcl is the 
linker command file, and cl430f.r43 is the runtime library. The option -s specifies 
the label where the application starts. The option -o specifies the name of the output file, 
and the option -r is used for specifying the output format UBROF, which can be used 
for debugging in C-SPY®.

The IAR XLINK Linker produces output according to your specifications. Choose the 
output format that suits your purpose. You might want to load the output to a 
debugger—which means that you need output with debug information. Alternatively, 
you might want to load the output to a flash loader or a PROM programmer—in which 
case you need output without debug information, such as Intel-hex or Motorola 
S-records. The option -F can be used for specifying the output format. (The default 
output format is msp430-txt.)

Basic settings for project configuration
This section gives an overview of the basic settings for the project setup that are needed 
to make the compiler generate the best code for the MSP430 device you are using. You 
can specify the options either from the command line interface or in the IAR Embedded 
Workbench IDE.

The basic settings are:

● Processor configuration, that includes to select core for either the MSP430 or the 
MSP430X architecture, and whether there is a hardware multiplier or not

● Normal or position-independent code

● Data model
C430-7
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Basic settings for project configuration
● Size of double floating-point type

● Optimization settings

● Runtime environment.

In addition to these settings, there are many other options and settings available for 
fine-tuning the result even further. For details about how to set options and for a list of 
all available options, see the chapters Compiler options and the MSP430 IAR Embedded 
Workbench® IDE User Guide, respectively.

PROCESSOR CONFIGURATION

To make the compiler generate optimum code, you should configure it for the MSP430 
microcontroller you are using.

Core

The MSP430 IAR C/C++ Compiler supports the MSP430 microcontroller, both the 
MSP430 architecture that has 64 Kbytes of addressable memory and the MSP430X 
architecture that has the extended instruction set and 1 Mbyte of addressable memory.

In the IAR Embedded Workbench IDE, choose Project>Options and select an 
appropriate device from the Device drop-down list on the Target page. The core option 
will then be automatically selected.

Note: Device-specific configuration files for the XLINK linker and the C-SPY 
debugger will also be automatically selected.

Use the --core={430|430X} option to select the architecture for which the code is to 
be generated.

Hardware multiplier

Some MSP430 devices contain a hardware multiplier. The MSP430 IAR C/C++ 
Compiler supports this unit by means of dedicated runtime library modules.

To direct the compiler to take advantage of the unit, choose Project>Options and select 
the Target page in the General Options category. Select a device, from the Device 
drop-down menu, that contains a hardware multiplier unit.

To use the hardware multiplier, you should, in addition to the runtime library object file, 
extend the XLINK command line with an additional linker command file:

-f multiplier.xcl

For more information, see Hardware multiplier support, page 68.
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POSITION-INDEPENDENT CODE

Most applications are designed to be placed at a fixed position in memory. However, by 
enabling the compiler option --pic and choosing a dedicated runtime library object 
file, you will enable support for a feature known as position-independent code, that 
allows the application to be placed anywhere in memory. This is useful, for example, 
when developing modules that should be loaded dynamically at runtime.

The drawback of position-independent code is that the size of the code will be somewhat 
larger, and that interrupt vectors cannot be specified directly. Also note that global data 
is not position-independent.

Note: Position-independent code is not supported for the MSP430X architecture.

DATA MODEL (MSP4300X ONLY)

For the MSP430X architecture, there is a trade-off regarding the way memory is 
accessed, ranging from cheap access to small memory areas, up to more expensive 
access methods that can access any location.

In the MSP430 IAR C/C++ Compiler, you can set a default memory access method by 
selecting a data model. However, it is possible to override the default access method for 
each individual variable. The following data models are supported:

● The Small data model specifies data16 as default memory type, which means the 
first 64 Kbytes of memory can be accessed. The only way to access the full 1-Mbyte 
memory range is to use intrinsic functions.

● The Medium data model specifies data16 as default memory type, which means data 
objects by default are placed in the first 64 Kbytes of memory. If required, the entire 
1 Mbyte of memory can be accessed.

● The Large data model specifies data20 as default memory type, which means the 
entire memory can be accessed.

The chapter Data storage covers data models in greater detail. The chapter also covers 
how to fine-tune the access method for individual variables.

SIZE OF DOUBLE FLOATING-POINT TYPE

Floating-point values are represented by 32- and 64-bit numbers in standard IEEE754 
format. By using the compiler option --double={32|64}, you can choose whether 
data declared as double should be represented with 32 bits or 64 bits. The data type 
float is always represented using 32 bits.
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Basic settings for project configuration
OPTIMIZATION FOR SPEED AND SIZE

The MSP430 IAR C/C++ Compiler is a state-of-the-art compiler with an optimizer that 
performs, among other things, dead-code elimination, constant propagation, inlining, 
common subexpression elimination, and precision reduction. It also performs loop 
optimizations, such as unrolling and induction variable elimination.

You can decide between several optimization levels and for the highest level you can 
choose between different optimization goals—size, speed, or balanced. Most 
optimizations will make the application both smaller and faster. However, when this is 
not the case, the compiler uses the selected optimization goal to decide how to perform 
the optimization.

The optimization level and goal can be specified for the entire application, for individual 
files, and for individual functions. In addition, some individual optimizations, such as 
function inlining, can be disabled.

For details about compiler optimizations and for more information about efficient 
coding techniques, see the chapter Efficient coding for embedded applications.

RUNTIME ENVIRONMENT

To create the required runtime environment you should choose a runtime library and set 
library options. You may also need to override certain library modules with your own 
customized versions.

There are two different sets of runtime libraries provided:

● The IAR DLIB Library, which supports ISO/ANSI C and C++. This library also 
supports floating-point numbers in IEEE 754 format and it can be configured to 
include different levels of support for locale, file descriptors, multibyte characters, 
et cetera.

● The IAR CLIB Library is a light-weight library, which is not fully compliant with 
ISO/ANSI C. Neither does it fully support floating-point numbers in IEEE 754 
format or does it support Embedded C++. Note that the legacy IAR CLIB Library is 
provided for backward compatibility and should not be used for new application 
projects.

The runtime library you choose can be one of the prebuilt libraries, or a library that you 
have customized and built yourself. The IAR Embedded Workbench IDE provides a 
library project template for both libraries, that you can use for building your own library 
version. This gives you full control of the runtime environment. If your project only 
contains assembler source code, there is no need to choose a runtime library.

For detailed information about the runtime environments, see the chapters The DLIB 
runtime environment and The CLIB runtime environment, respectively.
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The way you set up a runtime environment and locate all the related files differs 
depending on which build interface you are using—the IAR Embedded Workbench IDE 
or the command line.

Choosing a runtime library in the IAR Embedded Workbench IDE

To choose a library, choose Project>Options, and click the Library Configuration tab 
in the General Options category. Choose the appropriate library from the Library 
drop-down menu.

Note that for the DLIB library there are different configurations—Normal, and 
Full—which include different levels of support for locale, file descriptors, multibyte 
characters, et cetera. See Library configurations, page 47, for more information.

Based on which library configuration you choose and your other project settings, the 
correct library file is used automatically. For the device-specific include files, a correct 
include path is set up.

Choosing runtime environment from the command line

Use the following command line options to specify the library and the dependency files:

For a list of all prebuilt library object files for the IAR DLIB Library, see Table 11, 
Prebuilt libraries, page 49. The table also shows how the object files correspond to the 
dependent project options, and the corresponding configuration files. Make sure to use 
the object file that matches your other project options.

For a list of all prebuilt object files for the IAR CLIB Library, see Table 22, Runtime 
libraries, page 76. The table also shows how the object files correspond to the dependent 
project options. Make sure to use the object file that matches your other project options.

Command line Description

-I msp430\inc Specifies the include paths

-I msp430\inc\{clib|dlib} Specifies the library-specific include path. Use clib or 
dlib depending on which library you are using.

libraryfile.r43 Specifies the library object file

--dlib_config 

C:\...\configfile.h

Specifies the library configuration file (for the IAR DLIB 
Library only)

Table 2: Command line options for specifying library and dependency files 
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Special support for embedded systems
Setting library and runtime environment options

You can set certain options to reduce the library and runtime environment size:

● The formatters used by the functions printf, scanf, and their variants, see 
Choosing formatters for printf and scanf, page 51 (DLIB) and Input and output, 
page 77 (CLIB).

● The size of the stack and the heap, see The stack, page 37, and The heap, page 39, 
respectively.

Special support for embedded systems
This section briefly describes the extensions provided by the MSP430 IAR C/C++ 
Compiler to support specific features of the MSP430 microcontroller.

EXTENDED KEYWORDS

The MSP430 IAR C/C++ Compiler provides a set of keywords that can be used for 
configuring how the code is generated. For example, there are keywords for controlling 
the memory type for individual variables as well as for declaring special function types.

By default, language extensions are enabled in the IAR Embedded Workbench IDE.

The command line option -e makes the extended keywords available, and reserves them 
so that they cannot be used as variable names. See, -e, page 150 for additional 
information. 

For detailed descriptions of the extended keywords, see the chapter Extended keywords.

PRAGMA DIRECTIVES

The pragma directives control the behavior of the compiler, for example how it allocates 
memory, whether it allows extended keywords, and whether it issues warning messages. 

The pragma directives are always enabled in the MSP430 IAR C/C++ Compiler. They 
are consistent with ISO/ANSI C, and are very useful when you want to make sure that 
the source code is portable.

For detailed descriptions of the pragma directives, see the chapter Pragma directives.

PREDEFINED SYMBOLS

With the predefined preprocessor symbols, you can inspect your compile-time 
environment, for example time of compilation and the data models.

For detailed descriptions of the predefined symbols, see the chapter The preprocessor.
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SPECIAL FUNCTION TYPES

The special hardware features of the MSP430 microcontroller are supported by the 
compiler’s special function types: interrupt, monitor, task, and raw. You can write a 
complete application without having to write any of these functions in assembler 
language.

For detailed information, see Primitives for interrupts, concurrency, and OS-related 
programming, page 23.

HEADER FILES FOR I/O

Standard peripheral units are defined in device-specific I/O header files called 
iodevice.h. The product package supplies I/O files for all devices that are available at 
the time of the product release. You can find these files in the 430\inc directory. Make 
sure to include the appropriate include file in your application source files. If you need 
additional I/O header files, they can easily be created using one of the provided ones as 
a template.

Note that header files named like msp430device.h are available for backwards 
compatibility.

For an example, see Accessing special function registers, page 127.

ACCESSING LOW-LEVEL FEATURES

For hardware-related parts of your application, accessing low-level features is essential. 
The MSP430 IAR C/C++ Compiler supports several ways of doing this: intrinsic 
functions, mixing C and assembler modules, and inline assembler. For information 
about the different methods, see Mixing C and assembler, page 83.
C430-7
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Data storage 
This chapter gives a brief introduction to the memory layout of the MSP430 
microcontroller and the fundamental ways data can be stored in memory: on 
the stack, in static (global) memory, or in heap memory. For efficient memory 
usage, MSP430 IAR C/C++ Compiler provides a set of data models and data 
memory attributes, allowing you to fine-tune the access methods, resulting in 
smaller code size. The concepts of data models and memory types are 
described in relation to pointers, structures, Embedded C++ class objects, and 
non-initialized memory. Finally, detailed information about data storage on the 
stack and the heap is provided.

Introduction 
The MSP430 IAR C/C++ Compiler supports MSP430 devices with both the MSP430 
instruction set and the MSP430X extended instruction set, which means that 64 Kbytes 
and 1 Mbyte of continuous memory can be used. However, the extended instruction set 
requires that data—including constant data—interrupt functions, and interrupt vectors 
must be located in the lower 64 Kbytes of memory. 

Different types of physical memory can be placed in the memory range. A typical 
application will have both read-only memory (ROM or flash) and read/write memory 
(RAM). In addition, some parts of the memory range contain processor control registers 
and memory-mapped registers for peripheral units.

The MSP430X architecture can access the lower 64 Kbyte using normal instructions and 
the entire memory range using more expensive extended instructions. The compiler 
supports this by means of memory types, where data16 memory corresponds to the lower 
64 Kbytes and the data20 memory the entire 1 Mbyte memory range. To read more about 
this, see Memory types (MSP430X only), page 15. The data model specifies which 
memory that is used by default, see Data models (MSP430X only), page 14.

In a typical application, data can be stored in memory in three different ways:

● On the stack. This is memory space that can be used by a function as long as it is 
executing. When the function returns to its caller, the memory space is no longer 
valid.

● Static memory. This kind of memory is allocated once and for all; it remains valid 
through the entire execution of the application. Variables that are either global or 
declared static are placed in this type of memory. The word static in this context 
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Data models (MSP430X only)
means that the amount of memory allocated for this type of variable does not 
change while the application is running.

● On the heap. Once memory has been allocated on the heap, it remains valid until it 
is explicitly released back to the system by the application. This type of memory is 
useful when the number of objects is not known until the application executes. Note 
that there are potential risks connected with using the heap in systems with a limited 
amount of memory, or systems that are expected to run for a long time.

Data models (MSP430X only)
For the MSP430X architecture, the compiler supports three data models for applications 
with different data requirements.

Technically, one property that the data model specifies is the default memory type, 
which controls the following:

● The default placement of static and global variables, as well as constant literals

● Dynamically allocated data, for example data allocated with malloc, or, in C++, 
the operator new

● The default pointer type

● The placement of the runtime stack.

In the Small data model, only the data16 memory type is available. In the Medium and 
Large data models, you can be explicitly override the default memory type by using 
memory attributes. For information about how to specify a memory type for individual 
objects, see Using data memory attributes, page 16.

SPECIFYING A DATA MODEL

Three data models are implemented: Small, Medium, and Large. These models are 
controlled by the --data_model option. Each model has a default memory type and a 
default pointer size. If you do not specify a data model option, the compiler will use the 
Small data model.

Your project can only use one data model at a time, and the same model must be used 
by all user modules and all library modules. However, you can override the default 
memory type for individual data objects by explicitly specifying a memory attribute, 
using either keywords or the #pragma type_attribute directive.
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The following table summarizes the different data models:

See the MSP430 IAR Embedded Workbench® IDE User Guide for information about 
setting options in the IAR Embedded Workbench IDE.

Use the --data_model option to specify the data model for your project; see 
--data_model, page 145. 

The Small data model

The Small data model can only use data16 memory, which means that all data must be 
placed in the lower 64 Kbytes of memory. The advantage is that the generated code can 
rely on the upper four bits of the processor registers never being used. Among else, this 
reduces the stack space needed to store preserved registers, see Preserved registers, page 
92.

The Medium data model

The Medium data model uses data16 memory by default. Unlike the Small data model, 
the Medium data model can also use data20 memory. This data model is useful if most 
of the data can fit into the lower 64 Kbytes of memory, but a small number of large data 
structures do not.

The Large data model

In the Large data model, the data20 memory is default. This model is mainly useful for 
large applications with large amounts of data. Note that if you need to use the data20 
memory, it is for most applications better to use the Medium data model and place 
individual objects in data20 memory using the __data20 memory attribute. To read 
more about the reasons for this, see Data20, page 16.

Memory types (MSP430X only)
This section describes the concept of memory types used for accessing data by the 
MSP430 IAR C/C++ Compiler. It also discusses pointers in the presence of multiple 
memory types. For each memory type, the capabilities and limitations are discussed.

Data model name
Default memory 

attribute
Data20 available Placement of data

Small __data16 No 0–0xFFFF

Medium __data16 Yes 0–0xFFFF

Large __data20 Yes 0–0xFFFFF

Table 3: Data model characteristics 
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Memory types (MSP430X only)
The MSP430 IAR C/C++ Compiler uses different memory types to access data that is 
placed in different areas of the memory. There are different methods for reaching 
memory areas, and they have different costs when it comes to code space, execution 
speed, and register usage. The access methods range from generic but expensive 
methods that can access the full memory space, to cheap methods that can access limited 
memory areas. Each memory type corresponds to one memory access method. By 
mapping different memories—or part of memories—to memory types, the compiler can 
generate code that can access data efficiently.

For example, the memory accessible using the data16 memory access method is called 
memory of data16 type, or simply data16 memory. 

By selecting a data model, you have selected a default memory type that your 
application will use. However, it is possible to specify—for individual variables or 
pointers—different memory types. This makes it possible to create an application that 
can contain a large amount of data, and at the same time make sure that variables that 
are used often are placed in memory that can be efficiently accessed.

DATA16 

The data16 memory consists of the low 64 Kbytes of data memory. In hexadecimal 
notation, this is the address range 0x0000-0xFFFF.

A data16 object can only be placed in data16 memory, and the size of such an object is 
limited to 64 Kbytes-1. By using objects of this type, the code generated by the compiler 
to access them is minimized. This means a smaller footprint for the application, and 
faster execution at run-time.

DATA20 

Using this memory type, you can place the data objects anywhere in the entire memory 
range 0x00000–0xFFFFF. This requires the extended instructions of the MSP430X 
architecture, which are more expensive. Note that a pointer to data20 memory will 
occupy four bytes of memory, which is twice the amount needed for data16 memory.

USING DATA MEMORY ATTRIBUTES

The MSP430 IAR C/C++ Compiler provides a set of extended keywords, which can be 
used as data memory attributes. These keywords let you override the default memory 
type for individual data objects, which means that you can place data objects in other 
memory areas than the default memory. This also means that you can fine-tune the 
access method for each individual data object, which results in smaller code size.
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The following table summarizes the available memory types and their corresponding 
keywords:

The keywords are only available if language extensions are enabled in the MSP430 IAR 
C/C++ Compiler.

In the IAR Embedded Workbench IDE, language extensions are enabled by default.

Use the -e compiler option to enable language extensions. See -e, page 150 for 
additional information.

For reference information about each keyword, see Descriptions of extended keywords, 
page 193.

Syntax

The keywords follow the same syntax as the type qualifiers const and volatile. The 
memory attributes are type attributes and therefore they must be specified both when 
variables are defined and in the declaration, see General syntax rules for extended 
keywords, page 189.

The following declarations place the variable i and j in data20 memory. The variables 
k and l will also be placed in data20 memory. The position of the keyword does not have 
any sffect in this case:

__data20 int i, j;
int __data20 k, l;

Note that the keyword affects both identifiers. If no memory type is specified, the default 
memory type is used.

In addition to the rules presented here—to place the keyword directly in the code—the 
directive #pragma type_attribute can be used for specifying the memory attributes. 
The advantage of using pragma directives for specifying keywords is that it offers you a 
method to make sure that the source code is portable. Refer to the chapter Pragma 
directives for details about how to use the extended keywords together with pragma 
directives.

Memory type Keyword Address range Pointer size
Default in data 

model

Data16 __data16 0x0-0xFFFF 16 bits Small and Medium

Data20 __data20 0x0-0xFFFFF 32 bits Large

Table 4: Memory types and their corresponding memory attributes 
C430-7
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Memory types (MSP430X only)
Type definitions

Storage can also be specified using type definitions. The following two declarations are 
equivalent:

typedef char __data20 Byte;
typedef Byte *BytePtr;
Byte b;
BytePtr bp; 

and

__data20 char b;
char __data20 *bp;

POINTERS AND MEMORY TYPES

Pointers are used for referring to the location of data. In general, a pointer has a type. 
For example, a pointer that has the type int * points to an integer. 

In the MSP430 IAR C/C++ Compiler, a pointer also points to some type of memory. The 
memory type is specified using a keyword before the asterisk. For example, a pointer 
that points to an integer stored in data20 memory is declared by: 

int __data20 * p;

Note that the location of the pointer variable p is not affected by the keyword. In the 
following example, however, the pointer variable p2 is placed in data20 memory. In this 
case, p2 points to a character in data16 memory.

char __data16 * __data20 p2; 

For example, the functions in the standard library are all declared without explicit 
memory types.

Differences between pointer types 

A pointer must contain information needed to specify a memory location of a certain 
memory type. This means that the pointer sizes are different for different memory types. 
For the MSP430 IAR C/C++ Compiler, the size of the data16 and data20 pointers are 16 
and 32 bits, respectively.

In the MSP430 IAR C/C++ Compiler, it is illegal to convert a data20 pointer to a data16 
pointer without an explicit cast.

STRUCTURES AND MEMORY TYPES 

For structures, the entire object is placed in the same memory type. It is not possible to 
place individual structure members in different memory types.
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In the example below, the variable gamma is a structure placed in data20 memory.

struct MyStruct
{
  int alpha;
  int beta;
};
__data20 struct MyStruct gamma;

The following declaration is incorrect:

struct MySecondStruct
{
  int blue;
  __data20 int green;   /* Error! */
};

MORE EXAMPLES

The following is a series of examples with descriptions. First, some integer variables are 
defined and then pointer variables are introduced. Finally, a function accepting a pointer 
to an integer in data16 memory is declared. The function returns a pointer to an integer 
in data20 memory. It makes no difference whether the memory attribute is placed before 
or after the data type. In order to read the following examples, start from the left and add 
one qualifier at each step 

int a; A variable defined in default memory 
determined by the data model in use.

int __data16 b; A variable in data16 memory.

__data20 int c; A variable in data20 memory.

int * d; A pointer stored in default memory. The pointer 
points to an integer in default memory.

int __data16 * e; A pointer stored in default memory. The pointer 
points to an integer in data16 memory.

int __data16 * __data20 f; A pointer stored in data20 memory pointing to 
an integer stored in data16 memory.

int __data20 * myFunction(

   int __data16 *);
A declaration of a function that takes a 
parameter which is a pointer to an integer stored 
in data16 memory. The function returns a 
pointer to an integer stored in data20 memory.
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C++ and memory types (MSP430X only)
C++ and memory types (MSP430X only)
A C++ class object is placed in one memory type, in the same way as for normal C 
structures. However, the class members that are considered to be part of the object are 
the non-static member variables. The static member variables can be placed individually 
in any kind of memory.

Remember, in C++ there is only one instance of each static member variable, regardless 
of the number of class objects.

All restrictions that apply to the default pointer type also apply to the this pointer. This 
means that it must be possible to convert a pointer to the object to the default pointer 
type. Also note that for non-static member functions—unless class memory is used, see 
Classes, page 103—the this pointer will be of the default data pointer type.

In the Small and Medium data models, this means that objects of classes with a member 
function can only be placed in the default memory type (__data16).

Example

In the example below, an object, named delta, of the type MyClass is defined in data16 
memory. The class contains a static member variable that is stored in data20 memory.

// The class declaration (placed in a header file):
class MyClass
{
public:
  int alpha;
  int beta;

  __data20 static int gamma;
};

// Definitions needed (should be placed in a source file):
__data20 int MyClass::gamma;

// A variable definition:
__data16 MyClass delta;

The stack and auto variables
Variables that are defined inside a function—not declared static—are named auto 
variables by the C standard. A small number of these variables are placed in processor 
registers; the rest are placed on the stack. From a semantic point of view, this is 
equivalent. The main differences are that accessing registers is faster, and that less 
memory is required compared to when variables are located on the stack. 
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Auto variables can only live as long as the function executes; when the function returns, 
the memory allocated on the stack is released.

The stack can contain:

● Local variables and parameters not stored in registers

● Temporary results of expressions

● The return value of a function (unless it is passed in registers)

● Processor state during interrupts

● Processor registers that should be restored before the function returns (callee-save 
registers).

The stack is a fixed block of memory, divided into two parts. The first part contains 
allocated memory used by the function that called the current function, and the function 
that called it, etc. The second part contains free memory that can be allocated. The 
borderline between the two areas is called the top of stack and is represented by the stack 
pointer, which is a dedicated processor register. Memory is allocated on the stack by 
moving the stack pointer.

A function should never refer to the memory in the area of the stack that contains free 
memory. The reason is that if an interrupt occurs, the called interrupt function can 
allocate, modify, and—of course—deallocate memory on the stack.

Advantages

The main advantage of the stack is that functions in different parts of the program can 
use the same memory space to store their data. Unlike a heap, a stack will never become 
fragmented or suffer from memory leaks.

It is possible for a function to call itself—a so-called recursive function—and each 
invocation can store its own data on the stack.

Potential problems

The way the stack works makes it impossible to store data that is supposed to live after 
the function has returned. The following function demonstrates a common 
programming mistake. It returns a pointer to the variable x, a variable that ceases to exist 
when the function returns.

int * MyFunction()
{
  int x;
  ... do something ...
  return &x;
}
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Dynamic memory on the heap
Another problem is the risk of running out of stack. This will happen when one function 
calls another, which in turn calls a third, etc., and the sum of the stack usage of each 
function is larger than the size of the stack. The risk is higher if large data objects are 
stored on the stack, or when recursive functions—functions that call themselves either 
directly or indirectly—are used.

Dynamic memory on the heap 
Memory for objects allocated on the heap will live until the objects are explicitly 
released. This type of memory storage is very useful for applications where the amount 
of data is not known until runtime.

In C, memory is allocated using the standard library function malloc, or one of the 
related functions calloc and realloc. The memory is released again using free.

In C++, there is a special keyword, new, designed to allocate memory and run 
constructors. Memory allocated with new must be released using the keyword delete.

For MSP430X, the compiler supports heaps in both data16 memory and data20 memory. 
For more information about this, see The heap, page 39.

Potential problems

Applications that are using heap-allocated objects must be designed very carefully, 
because it is easy to end up in a situation where it is not possible to allocate objects on 
the heap.

The heap can become exhausted if your application uses too much memory. It can also 
become full if memory that no longer is in use has not been released.

For each allocated memory block, a few bytes of data for administrative purposes is 
required. For applications that allocate a large number of small blocks, this 
administrative overhead can be substantial.

There is also the matter of fragmentation; this means a heap where small sections of free 
memory is separated by memory used by allocated objects. It is not possible to allocate 
a new object if there is no piece of free memory that is large enough for the object, even 
though the sum of the sizes of the free memory exceeds the size of the object.

Unfortunately, fragmentation tends to increase as memory is allocated and released. For 
this reason, applications that are designed to run for a long time should try to avoid using 
memory allocated on the heap.
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This chapter contains information about functions. It gives a brief overview of 
function-related extensions—mechanisms for controlling functions—and 
describes some of these mechanisms in more detail.

Function-related extensions
In addition to the ISO/ANSI C standard, the MSP430 IAR C/C++ Compiler provides 
several extensions for writing functions in C. Using these, you can:

● Use primitives for interrupts, concurrency, and OS-related programming

● Facilitate function optimization

● Access hardware features.

The compiler supports this by means of compiler options, extended keywords, pragma 
directives, and intrinsic functions.

For more information about optimizations, see Writing efficient code, page 124. For 
information about the available intrinsic functions for accessing hardware operations, 
see the chapter Intrinsic functions.

Primitives for interrupts, concurrency, and OS-related programming
The MSP430 IAR C/C++ Compiler provides the following primitives related to writing 
interrupt functions, concurrent functions, and OS-related functions: 

● The extended keywords __interrupt, __task, __monitor, __raw, and 
__save_reg20

● The pragma directives #pragma vector and #pragma no_epilogue

● The intrinsic functions __enable_interrupt, __disable_interrupt, as well 
as many others

● The compiler option --save_reg20.

INTERRUPT FUNCTIONS 

In embedded systems, using interrupts is a method for handling external events 
immediately; for example, detecting that a button has been pressed.

In general, when an interrupt occurs in the code, the microcontroller simply stops 
executing the code it runs, and starts executing an interrupt routine instead. It is 
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Primitives for interrupts, concurrency, and OS-related programming
extremely important that the environment of the interrupted function is restored after the 
interrupt has been handled; this includes the values of processor registers and the 
processor status register. This makes it possible to continue the execution of the original 
code when the code that handled the interrupt has been executed.

The MSP430 microcontroller supports many interrupt sources. For each interrupt 
source, an interrupt routine can be written. Each interrupt routine is associated with a 
vector number, which is specified in the MSP430 microcontroller documentation from 
the chip manufacturer. The interrupt vector is the offset into the interrupt vector table. If 
you want to handle several different interrupts using the same interrupt function, you can 
specify several interrupt vectors. For the MSP430 microcontroller, the interrupt vector 
table typically contains 16 vectors and the table starts at the address 0xFFE0. However, 
some devices contain more than 16 vectors, in which case the vectors start at a lower 
address. For example, if the device has 32 vectors, the table starts at address 0xFFC0. 
The interrupt vectors are placed in the segment INTVEC. The last entry in the table 
contains the reset vector, which is placed in a separate linker segment—RESET.

The header file iodevice.h, where device corresponds to the selected device, 
contains predefined names for the existing exception vectors.

To define an interrupt function, the __interrupt keyword and the #pragma vector 
directive can be used. For example:

#pragma vector=0x14
__interrupt void my_interrupt_routine(void)
{
  /* Do something */
}

Note: An interrupt function must have the return type void, and it cannot specify any 
parameters.

If a vector is specified in the definition of an interrupt function, the processor interrupt 
vector table is populated. It is also possible to define an interrupt function without a 
vector. This is useful if an application is capable of populating or changing the interrupt 
vector table at runtime. See the chip manufacturer’s MSP430 microcontroller 
documentation for more information about the interrupt vector table. 

Preventing registers from being saved at function entrance

As noted, the interrupt function preserves the content of all used processor register at the 
entrance and restores them at exit. However, for some very special applications, it can 
be desirable to prevent the registers from being saved at function entrance.

This can be accomplished by the use of the extended keyword __raw, for example:

__raw __interrupt void my_interrupt_function()
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This creates an interrupt service routine where you must make sure that the code within 
the routine does not affect any of the registers used by the interrupted environment. 
Typically, this is useful for applications that have an empty foreground loop and use 
interrupt routines to perform all work.

Note: The same effect can be achieved for normal functions by using the __task 
keyword.

Interrupt Vector Generator interrupt functions

The MSP430 IAR C/C++ Compiler provides a way to write very efficient interrupt 
service routines for the modules that has Interrupt Vector Generators, this includes 
Timer A (TAIV), Timer B (TBIV), the I2C module (I2CIV), and the ADC12 module.

The interrupt vector register contains information about the interrupt source, and the 
interrupt service routine normally uses a switch statement to find out which interrupt 
source issued the interrupt. To help the compiler generate optimal code for the switch 
statement, the intrinsic function __even_in_range can be used. The following 
example defines a Timer A interrupt routine:

#pragma vector=TIMERA1_VECTOR
__interrupt void Timer_A1_ISR(void)
{
  switch (__even_in_range(TAIV, 10))
  {
   case 2: P1POUT ˆ= 0x04;

break;
   case 4: P1POUT ˆ= 0x02;

break;
   case 10: P1POUT ˆ= 0x01;

break;
  }
}

The intrinsic function __even_in_range requires two parameters, the interrupt vector 
register and the last value in the allowed range, which in this example is 10. The effect 
of the intrinsic function is that the generated code can only handle even values within 
the given range, which is exactly what is required in this case as the interrupt vector 
register for Timer A can only be 0, 2, 4, 6, 8, or 10. If the __even_in_range intrinsic 
function is used in a case where an odd value or a value outside the given range could 
occur, the program will fail.

For more information about the intrinsic keyword, see __even_in_range, page 221.
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Interrupt functions for the MSP430X architecture

When compiling for the MSP430X architecture, all interrupt functions are automatically 
placed in the segment ISR_CODE, which must be located in the lower 64 Kbytes of 
memory. If you are using a ready-made linker command file for an MSP430X device, 
the segment will be correctly located.

In the Small data model, all functions save only 16 bits of the 20-bit registers on entry 
and exit. If you have assembler routines that use the upper 4 bits of the registers, you 
must use either the __save_reg20 keyword on all your interrupt functions, 
alternatively the --save_reg20 compiler option.

This will ensure that the interrupt functions will save and restore all 20 bits of any 20-bit 
registers that are used. The drawback is that the entry and leave sequences will become 
slower and consume more stack space.

Note: If a __save_reg20 function, compiled using either the --lock_R4 or the 
--lock_R5 option, calls another function that is not __save_reg20 declared and does 
not lock R4/R5, the upper four bits of R4/R5 might be destroyed. For this reason, it is not 
recommended to use different settings of the --lock_R4/R5 option for different 
modules.

MONITOR FUNCTIONS

A monitor function causes interrupts to be disabled during execution of the function. At 
function entry, the status register is saved and interrupts are disabled. At function exit, 
the original status register is restored, and thereby the interrupt status that existed before 
the function call is also restored.

To define a monitor function, you can use the __monitor keyword. For reference 
information, see __monitor, page 195.

Avoid using the __monitor keyword on large functions, since the interrupt will 
otherwise be turned off for a significant period of time. 

Example of implementing a semaphore in C 

In the following example, a semaphore is implemented using one static variable and two 
monitor functions. A semaphore can be locked by one process, and is used for 
preventing processes from simultaneously using resources that can only be used by one 
process at a time, for example a USART. The __monitor keyword assures that the lock 
operation is atomic; in other words it cannot be interrupted.

/* When the_lock is non-zero, someone owns the lock. */
static volatile unsigned int the_lock = 0;

/* get_lock -- Try to lock the lock.
 * Return 1 on success and 0 on failure. */
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__monitor int get_lock(void)
{
  if (the_lock == 0)
  {
    /* Success, we managed to lock the lock. */
    the_lock = 1;
    return 1;
  }
  else
  {
    /* Failure, someone else has locked the lock. */
    return 0;
  }
}

/* release_lock -- Unlock the lock. */

__monitor void release_lock(void)
{
  the_lock = 0;
}

The following is an example of a program fragment that uses the semaphore:

void my_program(void)
{
  if (get_lock())
  {
    /* ... Do something ... */

    /* When done, release the lock. */
    release_lock();
  }
}

Example of implementing a semaphore in C++ 

In C++, it is common to implement small methods with the intention that they should be 
inlined. However, the MSP430 IAR C/C++ Compiler does not support inlining of 
functions and methods that are declared using the __monitor keyword.

In the following example in C++, an auto object is used for controlling the monitor 
block, which uses intrinsic functions instead of the __monitor keyword. 

#include <intrinsics.h>

volatile long tick_count = 0;
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/* Class for controlling critical blocks */
class Mutex
{
public:
  Mutex ()
  {
    _state = __get_interrupt_state();
    __disable_interrupt();
  }

  ~Mutex ()
  {
    __set_interrupt_state(_state);
  }

private:
  __istate_t _state;
};

void f()
{
  static long next_stop = 100;
  extern void do_stuff();
  long tick;
  
  /* A critical block */
  {
    Mutex m;
    /* Read volatile variable 'tick_count' in a safe way 
       and put the value in a local variable */
    
    tick = tick_count;
  }
  
  if (tick >= next_stop)
  {
    next_stop += 100;
    do_stuff();
  }
}

C++ AND SPECIAL FUNCTION TYPES 

C++ member functions can be declared using special function types. However, interrupt 
member functions must be static. When calling a non-static member function, it must be 
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applied to an object. When an interrupt occurs and the interrupt function is called, there 
is no such object available.
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Placing code and data 
This chapter describes how the linker handles memory and introduces the 
concept of segments. It also describes how they correspond to the memory 
and function types, and how they interact with the runtime environment. The 
methods for placing segments in memory, which means customizing a linker 
command file, are described.

The intended readers of this chapter are the system designers that are 
responsible for mapping the segments of the application to appropriate 
memory areas of the hardware system.

Segments and memory
In an embedded system, there are many different types of physical memory. Also, it is 
often critical where parts of your code and data are located in the physical memory. For 
this reason it is important that the development tools meet these requirements.

WHAT IS A SEGMENT?

A segment is a logical entity containing a piece of data or code that should be mapped 
to a physical location in memory. Each segment consists of many segment parts. 
Normally, each function or variable with static storage duration is placed in a segment 
part. A segment part is the smallest linkable unit, which allows the linker to include only 
those units that are referred to. The segment could be placed either in RAM or in ROM. 
Segments that are placed in RAM do not have any content, they only occupy space.

Note: Here, ROM memory means all types of read-only memory including flash 
memory.

The MSP430 IAR C/C++ Compiler has a number of predefined segments for different 
purposes. Each segment has a name that describes the contents of the segment, and a 
segment memory type that denotes the type of content. In addition to the predefined 
segments, you can define your own segments.

At compile time, the compiler assigns each segment its contents. The IAR XLINK 
Linker is responsible for placing the segments in the physical memory range, in 
accordance with the rules specified in the linker command file. There are ready-made 
linker command files, but, if necessary, they can be easily modified according to the 
requirements of your target system and application. It is important to remember that, 
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from the linker's point of view, all segments are equal; they are simply named parts of 
memory.

For detailed information about individual segments, see the chapter Segment reference. 

Segment memory type 

XLINK assigns a segment memory type to each of the segments. In some cases, the 
individual segments may have the same name as the segment memory type they belong 
to, for example CODE. Make sure not to confuse the individual segment names with the 
segment memory types in those cases.

By default, the MSP430 IAR C/C++ Compiler uses only the following XLINK segment 
memory types:

XLINK supports a number of other segment memory types than the ones described 
above. However, they exist to support other types of microcontrollers. 

For more details about segments, see the chapter Segment reference.

Placing segments in memory
The placement of segments in memory is performed by the IAR XLINK Linker. It uses 
a linker command file that contains command line options which specify the locations 
where the segments can be placed, thereby assuring that your application fits on the 
target chip. You can use the same source code with different derivatives just by 
rebuilding the code with the appropriate linker command file.

In particular, the linker command file specifies:

● The placement of segments in memory

● The maximum stack size

● The maximum heap size.

This section describes the methods for placing the segments in memory, which means 
that you have to customize the linker command file to suit the memory layout of your 
target system. For showing the methods, fictitious examples are used.

Segment memory type Description

CODE For executable code

CONST For data placed in ROM

DATA For data placed in RAM

Table 5: XLINK segment memory types 
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CUSTOMIZING THE LINKER COMMAND FILE

The config directory contains one ready-made linker command file for each MSP430 
device. The file contains the information required by the linker, and is ready to be used. 
The only change you will normally have to make to the supplied linker command file is 
to customize it so it fits the target system memory map. If, for example, your application 
uses additional external RAM, you need to add details about the external RAM memory 
area. 

As an example, we can assume that the target system has the following memory layout:

The ROM can be used for storing CONST and CODE segment memory types. The RAM 
memory can contain segments of DATA type. The main purpose of customizing the linker 
command file is to verify that your application code and data do not cross the memory 
range boundaries, which would lead to application failure.

Remember not to change the original file. We recommend that you make a copy in the 
working directory, and modify the copy instead.

The contents of the linker command file

Among other things, the linker command file contains three different types of XLINK 
command line options:

● The CPU used:

-cmsp430

This specifies your target microcontroller. 

● Definitions of constants used later in the file. These are defined using the XLINK 
option -D.

● The placement directives (the largest part of the linker command file). Segments can 
be placed using the -Z and -P options. The former will place the segment parts in 
the order they are found, while the latter will try to rearrange them to make better 
use of the memory. The -P option is useful when the memory where the segment 
should be placed is not continuous. 

In the linker command file, all numbers are specified in hexadecimal format. However, 
neither the prefix 0x nor the suffix h is used.

Note: The supplied linker command file includes comments explaining the contents.

Range Type

0x0200–0x09FF RAM

0x1000–0x10FF ROM

0x1100–0xFFFF RAM

Table 6: Memory layout of a target system (example) 
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See the IAR Linker and Library Tools Reference Guide for more details.

Using the -Z command for sequential placement 

Use the -Z command when you need to keep a segment in one consecutive chunk, when 
you need to preserve the order of segment parts in a segment, or, more unlikely, when 
you need to put segments in a specific order.

The following illustrates how to use the -Z command to place the segment MYSEGMENTA 
followed by the segment MYSEGMENTB in CONST memory (that is, ROM) in the memory 
range 0x2000-0xCFFF.

-Z(CONST)MYSEGMENTA,MYSEGMENTB=2000-CFFF

Two segments of different types can be placed in the same memory area by not 
specifying a range for the second segment. In the following example, the MYSEGMENTA 
segment is first located in memory. Then, the rest of the memory range could be used by 
MYCODE.

-Z(CONST)MYSEGMENTA=2000-CFFF
-Z(CODE)MYCODE

Two memory ranges may overlap. This allows segments with different placement 
requirements to share parts of the memory space; for example:

-Z(CONST)MYSMALLSEGMENT=2000-20FF
-Z(CONST)MYLARGESEGMENT=2000-CFFF

Even though it is not strictly required, make sure to always specify the end of each 
memory range. If you do this, the IAR XLINK Linker will alert you if your segments do 
not fit.

Using the -P command for packed placement 

The -P command differs from -Z in that it does not necessarily place the segments (or 
segment parts) sequentially. With -P it is possible to put segment parts into holes left by 
earlier placements.

The following example illustrates how the XLINK -P option can be used for making 
efficient use of the memory area. The command will place the data segment MYDATA in 
DATA memory (that is, in RAM) in a fictitious memory range:

-P(DATA)MYDATA=0-1FFF,10000-11FFF

If your application has an additional RAM area in the memory range 0xF000-0xF7FF, 
you just add that to the original definition:

-P(DATA)MYDATA=0-1FFF,F000–F7FF,10000-11FFF
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Note: Copy initialization segments—BASENAME_I and BASENAME_ID—must be 
placed using -Z.

Data segments 
This section contains descriptions of the segments used for storing the different types of 
data: static, stack, heap, and located.

To get a clear understanding about how the data segments work, you must be familiar 
with the different memory types and the different data models available in the MSP430 
IAR C/C++ Compiler. If you need to refresh these details, see the chapter Data storage.

STATIC MEMORY SEGMENTS 

Static memory is memory that contains variables that are global or declared static, as 
described in the chapter Data storage. Declared static variables can be divided into the 
following categories:

● Variables that are initialized to a non-zero value

● Variables that are initialized to zero

● Variables that are located by use of the @ operator or the #pragma location 
directive

● Variables that are declared as const and therefore can be stored in ROM

● Variables defined with the __no_init keyword, meaning that they should not be 
initialized at all.

For the static memory segments it is important to be familiar with:

● The segment naming

● How the memory types correspond to segment groups and the segments that are part 
of the segment groups

● Restrictions for segments holding initialized data

● The placement and size limitation of the segments of each group of static memory 
segments. 

Segment naming

The names of the segments consist of two parts—the segment group name and a 
suffix—for instance, DATA16_Z. There is a segment group for each memory type, where 
each segment in the group holds different categories of declared data. The names of the 
segment groups are derived from the memory type and the corresponding keyword, for 
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example DATA16 and __data16. The following table summarizes the memory types 
and the corresponding segment groups:

Some of the declared data is placed in non-volatile memory, for example ROM, and 
some of the data is placed in RAM. For this reason, it is also important to know the 
XLINK segment memory type of each segment. For more details about segment 
memory types, see Segment memory type, page 32.

The following table summarizes the different suffixes, which XLINK segment memory 
type they are, and which category of declared data they denote: 

For a summary of all supported segments, see Summary of segments, page 241.

Examples

Assume the following examples:

Memory type Segment group Memory range

Data16 DATA16 0x0000-0xFFFF

Data20 DATA20 0x00000-0xFFFFF

Table 7: Memory types with corresponding segment groups 

Categories of declared data Segment memory type Suffix

Non-initialized data DATA N

Zero-initialized data DATA Z

Non-zero initialized data DATA I

Initializers for the above CONST ID

Constants CONST C

Non-initialized absolute addressed data AN

Constant absolute addressed data AC

Table 8: Segment name suffixes 

__data16 int j;
__data16 int i = 0;

The data16 variables that are to be initialized to zero 
when the system starts will be placed in the segment 
DATA16_Z.

__no_init __data16 int j;The data16 non-initialized variables will be placed in 
the segment DATA16_N.

__data16 int j = 4; The data16 non-zero initialized variables will be 
placed in the segment DATA16_I in RAM, and 
initializer data in segment DATA16_ID in ROM.
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Initialized data 

When an application is started, the system startup code initializes static and global 
variables in two steps:

1 It clears the memory of the variables that should be initialized to zero.

2 It initializes the non-zero variables by copying a block of ROM to the location of the 
variables in RAM. This means that the data in the ROM segment with the suffix ID is 
copied to the corresponding I segment.

This works when both segments are placed in continuous memory. However, if one of 
the segments is divided into smaller pieces, it is important that:

● The other segment is divided in exactly the same way

● It is legal to read and write the memory that represents the gaps in the sequence.

For example, if the segments are assigned the following ranges, the copy will fail:

However, in the following example, the linker will place the content of the segments in 
identical order, which means that the copy will work appropriately:

Note that the gap between the ranges will also be copied.

3 Finally, global C++ objects are constructed, if any.

Data segments for static memory in the default linker command file

In this example, the directives for placing the segments in the linker command file would 
be:

// The RAM segments
-Z(DATA)DATA16_I,DATA16_Z,DATA16_N=200-9FF

// The ROM segments
-Z(CONST)DATA16_C=1100-FFDF,DATA16_ID

THE STACK

The stack is used by functions to store variables and other information that is used 
locally by functions, as described in the chapter Data storage. It is a continuous block 
of memory pointed to by the processor stack pointer register SP. 

DATA16_I 0x200-0x2FF and 0x400-0x4FF

DATA16_ID 0x600-0x7FF

DATA16_I 0x200-0x2FF and 0x400-0x4FF

DATA16_ID 0x600-0x6FF and 0x800-0x8FF
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The data segment used for holding the stack is called CSTACK. The system startup code 
initializes the stack pointer to the end of the stack segment.

Allocating a memory area for the stack is done differently when you use the command 
line interface compared to when you use the IAR Embedded Workbench IDE.

Stack size allocation in the IAR Embedded Workbench IDE

Select Project>Options. In the General Options category, click the Stack/Heap tab.

Add the required stack size in the Stack size text box.

Stack size allocation from the command line

The size of the CSTACK segment is defined in the linker command file. 

The default linker file sets up a constant representing the size of the stack, at the 
beginning of the linker file:

-D_CSTACK_SIZE=size

Note: Normally, this line is prefixed with the comment character //. To make the 
directive take effect, remove the comment character.

Specify an appropriate size for your application. Note that the size is written 
hexadecimally without the 0x notation. 

Placement of stack segment

Further down in the linker file, the actual stack segment is defined in the memory area 
available for the stack:

-Z(DATA)CSTACK+_CSTACK_SIZE#0200-09FF

Note:

● This range does not specify the size of the stack; it specifies the range of the 
available memory

● The # allocates the CSTACK segment at the end of the memory area. In practice, 
this means that the stack will get all remaining memory at the same time as it is 
guaranteed that it will be at least _CSTACK_SIZE bytes. See the IAR Linker and 
Library Tools Reference Guide for more information.

Stack size considerations

The compiler uses the internal data stack, CSTACK, for a variety of user program 
operations, and the required stack size depends heavily on the details of these 
operations. If the given stack size is too large, RAM will be wasted. If the given stack 
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size is too small memory might be overwritten leading to undefined behavior. Because 
of this, you should consider placing the stack at the end of the RAM memory.

THE HEAP

The heap contains dynamic data allocated by use of the C function malloc (or one of 
its relatives) or the C++ operator new. 

If your application uses dynamic memory allocation, you should be familiar with the 
following:

● Linker segments used for the heap

● Allocating the heap size, which differs depending on which build interface you are 
using

● Placing the heap segments in memory.

Heap segments in DLIB

For MSP430 devices and MSP430X devices in the Small data model, one heap is 
available. It is placed in default memory; data16 in the Small and Medium data model 
(the DATA16_HEAP segment), and data20 in the Large data model (the DATA20_HEAP 
segment).

For MSP430X devices, the DLIB runtime environment supports heaps in both data16 
and data20 memory. The heaps are placed in segments named DATA16_HEAP and 
DATA20_HEAP.

To use a heap in a specific memory, use the appropriate memory attribute as a prefix to 
the standard functions malloc, free, calloc, and realloc, for example:

__data16_malloc

If you use any of the standard functions without a prefix, memory is allocated on the 
heap that corresponds to the default memory type. That is, data16 in the Small and 
Medium data model, and data20 in the Large data model.

For more information about heaps, see Heaps, page 68.

Heap segments in the CLIB runtime environment 

In the CLIB runtime environment one heap is available. It is placed in default memory; 
data16 in the Small and Medium data model (the DATA16_HEAP segment), and data20 
in the Large data model (the DATA20_HEAP segment).

Heap size allocation in the IAR Embedded Workbench IDE

Select Project>Options. In the General Options category, click the Stack/Heap tab. 
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Add the required heap size in the Heap size text box.

Heap size allocation from the command line

The size of the heap segment is defined in the linker command file. 

The default linker file sets up a constant, representing the size of the heap, at the 
beginning of the linker file:

-D_DATA16_HEAP_SIZE=size
-D_DATA20_HEAP_SIZE=size

Note: Normally, these lines are prefixed with the comment character //. To make the 
directive take effect, remove the comment character.

Specify the appropriate size for your application.

Placement of heap segment

The actual heap segment is allocated in the memory area available for the heap:

-Z(DATA)DATA16_HEAP+_DATA16_HEAP_SIZE=08000-08FFF

Note: This range does not specify the size of the heap; it specifies the range of the 
available memory.

Heap size and standard I/O

When you are using the Full DLIB configuration, be aware that the size of the input and 
output buffers is set to 512 bytes in the stdio library header file. If the heap is too small, 
I/O will not be buffered, which is considerably slower than buffered I/O. If you execute 
the application using the simulator driver of the IAR C-SPY Debugger, you are not 
likely to notice the speed penalty, but it is quite noticeable when the application runs on 
an MSP430 microcontroller. If you use the standard I/O library, you should set the heap 
size to a value which accommodates the needs of the standard I/O buffer, for example 1 
Kbyte.

If you have excluded FILE descriptors from the DLIB runtime environment, as in the 
normal DLIB configuration, there are no input and output buffers at all.

LOCATED DATA 

A variable that has been explicitly placed at an address, for example by using the 
compiler @ syntax, will be placed in either the DATA16_AC or the DATA16_AN segment. 
The former is used for constant-initialized data, and the latter for items declared as 
__no_init. The individual segment part of the segment knows its location in the 
memory space, and it does not have to be specified in the linker command file.
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If you create your own segments, these must also be defined in the linker command file 
using the -Z or -P segment control directives.

Code segments 
This section contains descriptions of the segments used for storing code, and the 
interrupt vector table. For a complete list of all segments, see Summary of segments, 
page 241.

STARTUP CODE 

The segment CSTART contains code used during system setup (cstartup). The system 
setup code should be placed at the location where the chip starts executing code after a 
reset. For the MSP430 microcontroller, this is at the reset vector address. In addition, the 
segments must be placed into one continuous memory space, which means the -P 
segment directive cannot be used.

In the default linker command file, the following line will place the CSTART segment at 
the address 0x1100:

-Z(CODE)CSTART=1100-FFBF

NORMAL CODE

Code for normal functions and interrupt functions is placed in the CODE segment. Again, 
this is a simple operation in the linker command file:

/* For MSP430 devices */
-Z(CODE)CODE=1100-FFDF

/* For MSP430X devices */
-Z(CODE)CODE=1100-FFBF,10000-FFFFF

INTERRUPT FUNCTIONS FOR MSP430X

When you compile for the MSP430X architecture, the interrupt functions are placed in 
the ISR_CODE segment. Again, this is a simple operation in the linker command file:

-Z(CODE)ISR_CODE=1100-FFDF
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INTERRUPT VECTORS 

The interrupt vector table contains pointers to interrupt routines, including the reset 
routine. The table is placed in the segment INTVEC. For the MSP430 microcontroller, it 
should end at address 0xFFFF. For a device with 16 interrupt vectors, this means that the 
segment should start at the address 0xFFE0, for example:

-Z(CONST)INTVEC=FFE0-FFFF

The system startup code places the reset vector in the RESET segment; the INTVEC 
segment cannot be used by the system startup code because the size of the interrupt 
vector table varies between different devices. In the linker command file it can look like 
this:

-Z(CONST)RESET=FFFE-FFFF

An application that does not use the standard startup code can either use the RESET 
segment, or define an interrupt function on the reset vector, in which case the INTVEC 
segment is used.

C++ dynamic initialization 
In C++, all global objects will be created before the main function is called. The creation 
of objects can involve the execution of a constructor.

The DIFUNCT segment contains a vector of addresses that point to initialization code. 
All entries in the vector will be called when the system is initialized.

For example:

-Z(CONST)DIFUNCT=1100-FFFE

For additional information, see DIFUNCT, page 248.

Verifying the linked result of code and data placement
The linker has several features that help you to manage code and data placement, for 
example, messages at link time and the linker map file.

SEGMENT TOO LONG ERRORS AND RANGE ERRORS

All code or data that is placed in relocatable segments will have its absolute addresses 
resolved at link time. It is also at link time it is known whether all segments will fit in 
the reserved memory ranges. If the contents of a segment do not fit in the address range 
defined in the linker command file, XLINK will issue a segment too long error.
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Some instructions do not work unless a certain condition holds after linking, for 
example that a branch must be within a certain distance or that an address must be even. 
XLINK verifies that the conditions hold when the files are linked. If a condition is not 
satisfied, XLINK generates a range error or warning and prints a description of the 
error.

For further information about these types of errors, see the IAR Linker and Library Tools 
Reference Guide.

LINKER MAP FILE

XLINK can produce an extensive cross-reference listing, which can optionally contain 
the following information:

● A segment map which lists all segments in dump order

● A module map which lists all segments, local symbols, and entries (public symbols) 
for every module in the program. All symbols not included in the output can also be 
listed

● Module summary which lists the contribution (in bytes) from each module

● A symbol list which contains every entry (global symbol) in every module.

Use the option Generate linker listing in the IAR Embedded Workbench IDE, or the 
option -X on the command line, and one of their suboptions to generate a linker listing.

Normally, XLINK will not generate an output file if there are any errors, such as range 
errors, during the linking process. Use the option Range checks disabled in the IAR 
Embedded Workbench IDE, or the option -R on the command line, to generate an output 
file even if a range error was encountered.

For further information about the listing options and the linker listing, see the IAR Linker 
and Library Tools Reference Guide, and the MSP430 IAR Embedded Workbench® IDE 
User Guide.
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The DLIB runtime 
environment 
This chapter describes the runtime environment in which an application 
executes. In particular, the chapter covers the DLIB runtime library and how 
you can modify it—setting options, overriding default library modules, or 
building your own library—to optimize it for your application.

The chapter also covers system initialization and termination; how an 
application can control what happens before the function main is called, and 
how you can customize the initialization.

The chapter then describes how to configure functionality like locale and file 
I/O, how to get C-SPY® runtime support, and how to prevent incompatible 
modules from being linked together.

For information about the CLIB runtime environment, see the chapter The 
CLIB runtime environment.

Introduction to the runtime environment
The runtime environment is the environment in which your application executes. The 
runtime environment depends on the target hardware, the software environment, and the 
application code. The IAR DLIB runtime environment can be used as is together with 
the IAR C-SPY Debugger. However, to be able to run the application on hardware, you 
must adapt the runtime environment.

This section gives an overview of:

● The runtime environment and its components

● Library selection.

RUNTIME ENVIRONMENT FUNCTIONALITY

The runtime environment supports ISO/ANSI C and C++ including the standard 
template library. The runtime environment consists of the runtime library, which 
contains the functions defined by these standards, and include files that define the library 
interface.
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The runtime library is delivered both as prebuilt libraries and as source files, and you 
can find them in the product subdirectories 430\lib and 430\src\lib, respectively.

The runtime environment also consists of a part with specific support for the target 
system, which includes:

● Support for hardware features:

● Direct access to low-level processor operations by means of intrinsic functions, 
such as functions for register handling

● Peripheral unit registers and interrupt definitions in include files

● The MSP430 hardware multiplier peripheral unit.

● Runtime environment support, that is, startup and exit code and low-level interface 
to some library functions.

● Special compiler support for some functions, for instance functions for 
floating-point arithmetics.

The runtime environment support as well as the size of the heaps must be tailored for 
the specific hardware and application requirements.

For further information about the library, see the chapter Library functions.

LIBRARY SELECTION

To configure the most code-efficient runtime environment, you must determine your 
application and hardware requirements. The more functionality you need, the larger 
your code will become.

IAR Embedded Workbench comes with a set of prebuilt runtime libraries. To get the 
required runtime environment, you can customize it by:

● Setting library options, for example, for choosing scanf input and printf output 
formatters, and for specifying the size of the stack and the heap

● Overriding certain library functions, for example cstartup.s43, with your own 
customized versions

● Choosing the level of support for certain standard library functionality, for example, 
locale, file descriptors, and multibyte characters, by choosing a library 
configuration: normal or full.

In addition, you can also make your own library configuration, but that requires that you 
rebuild the library. This allows you to get full control of the runtime environment.

Note: Your application project must be able to locate the library, include files, and the 
library configuration file.
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SITUATIONS THAT REQUIRE LIBRARY BUILDING

Building a customized library is complex. You should therefore carefully consider 
whether it is really necessary.

You must build your own library when:

● There is no prebuilt library for the required combination of compiler options or 
hardware support

● You want to define your own library configuration with support for locale, file 
descriptors, multibyte characters, et cetera.

For information about how to build a customized library, see Building and using a 
customized library, page 55.

LIBRARY CONFIGURATIONS 

It is possible to configure the level of support for, for example, locale, file descriptors, 
multibyte characters. The runtime library configuration is defined in the library 
configuration file. It contains information about what functionality is part of the runtime 
environment. The configuration file is used for tailoring a build of a runtime library, as 
well as tailoring the system header files used when compiling your application. The less 
functionality you need in the runtime environment, the smaller it is.

The following DLIB library configurations are available:

In addition to these configurations, you can define your own configurations, which 
means that you must modify the configuration file. Note that the library configuration 
file describes how a library was built and thus cannot be changed unless you rebuild the 
library. For further information, see Building and using a customized library, page 55.

The prebuilt libraries are based on the default configurations, see Table 11, Prebuilt 
libraries, page 49. There is also a ready-made library project template that you can use 
if you want to rebuild the runtime library.

DEBUG SUPPORT IN THE RUNTIME LIBRARY 

You can make the library provide different levels of debugging support—basic, runtime, 
and I/O debugging.

Library configuration Description

Normal DLIB No locale interface, C locale, no file descriptor support, no multibyte 
characters in printf and scanf, and no hex floats in strtod.

Full DLIB Full locale interface, C locale, file descriptor support, multibyte 
characters in printf and scanf, and hex floats in strtod.

Table 9: Library configurations 
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Using a prebuilt library
The following table describes the different levels of debugging support:

If you build your application project with the XLINK options With runtime control 
modules or With I/O emulation modules, certain functions in the library will be 
replaced by functions that communicate with the IAR C-SPY Debugger. For further 
information, see C-SPY Debugger runtime interface, page 69. 

To set linker options for debug support in the IAR Embedded Workbench IDE, choose 
Project>Options and select the Linker category. On the Output page, select the 
appropriate Format option.

Using a prebuilt library
The prebuilt runtime libraries are configured for different combinations of the following 
features:

● Core

● Data model

● Size of the double floating-point type

● Library configuration—Normal or Full

● Position-independent code.

Debugging 

support

Linker option in 

IDE

Linker command 

line option
Description

Basic debugging Debug information 
for C-SPY

-Fubrof Debug support for C-SPY without any 
runtime support

Runtime debugging With runtime 
control modules

-r The same as -Fubrof, but also 
includes debugger support for 
handling program abort, exit, and 
assertions.

I/O debugging With I/O emulation 
modules

-rt The same as -r, but also includes 
debugger support for I/O handling, 
which means that stdin and 
stdout are redirected to the C-SPY 
Terminal I/O window, and that it is 
possible to access files on the host 
computer during debugging.

Table 10: Levels of debugging support in runtime libraries 
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For the MSP430 IAR C/C++ Compiler, the following prebuilt runtime libraries are 
available:

The names of the libraries are constructed in the following way:

<type><target><data_model><processor_variant><size_of_double>
<lib_config><pic>.r43

where

● <type> is dl for the IAR DLIB runtime environment

● <core> is either 430 or 430x

● <data_model> is for MSP430X devices one of s, m, or l for Small, Medium, and 
Large data model, respectively

● <size_of_double> is either f for 32 bits or d for 64 bits

Library Core Data model
Size of 

double

Library 

configuration
PIC

dl430fn.r43 430 -- 32 Normal No

dl430fnp.r43 430 -- 32 Normal Yes

dl430ff.r43 430 -- 32 Full No

dl430ffp.r43 430 -- 32 Full Yes

dl430dn.r43 430 -- 64 Normal No

dl430dnp.r43 430 -- 64 Normal Yes

dl430df.r43 430 -- 64 Full No

dl430dfp.r43 430 -- 64 Full Yes

dl430xsfn.r43 430X Small 32 Normal No

dl430xsff.r43 430X Small 32 Full No

dl430xsdn.r43 430X Small 64 Normal No

dl430xsdf.r43 430X Small 64 Full No

dl430xmfn.r43 430X Medium 32 Normal No

dl430xmff.r43 430X Medium 32 Full No

dl430xmdn.r43 430X Medium 64 Normal No

dl430xmdf.r43 430X Medium 64 Full No

dl430xlfn.r43 430X Large 32 Normal No

dl430xlff.r43 430X Large 32 Full No

dl430xldn.r43 430X Large 64 Normal No

dl430xldf.r43 430X Large 64 Full No

Table 11: Prebuilt libraries 
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● <library_configuraton> is one of n or f for normal and full, respectively

● <PIC> is either empty for no support for position-independent code or p for 
position-independent code.

Note: The library configuration file has the same base name as the library.

The IAR Embedded Workbench IDE will include the correct library object file and 
library configuration file based on the options you select. See the MSP430 IAR 
Embedded Workbench® IDE User Guide for additional information.

If you build your application from the command line, you must specify the following 
items to get the required runtime library:

● Specify which library object file to use on the XLINK command line, for instance:

dl430fn.r43

● Specify the include paths for the compiler and assembler:

-I msp430\inc

● Specify the library configuration file for the compiler:

--dlib_config C:\...\dl430fn.h

Note: All modules in the library have a name that starts with the character ? (question 
mark).

You can find the library object files and the library configuration files in the subdirectory 
430\lib.

CUSTOMIZING A PREBUILT LIBRARY WITHOUT REBUILDING 

The prebuilt libraries delivered with the MSP430 IAR C/C++ Compiler can be used as 
is. However, it is possible to customize parts of a library without rebuilding it. There are 
two different methods:

● Setting options for:

● Formatters used by printf and scanf

● The sizes of the heap and the stack

● Overriding library modules with your own customized versions.

The following items can be customized: 

Items that can be customized Described in

Formatters for printf and scanf Choosing formatters for printf and scanf, page 51

Startup and termination code System startup and termination, page 56

Low-level input and output Standard streams for input and output, page 60

Table 12: Customizable items 
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For a description about how to override library modules, see Overriding library 
modules, page 53.

Choosing formatters for printf and scanf
To override the default formatter for all the printf- and scanf-related functions, 
except for wprintf and wscanf variants, you simply set the appropriate library 
options. This section describes the different options available.

Note: If you rebuild the library, it is possible to optimize these functions even further, 
see Configuration symbols for printf and scanf, page 62.

CHOOSING PRINTF FORMATTER

The printf function uses a formatter called _Printf. The default version is quite 
large, and provides facilities not required in many embedded applications. To reduce the 
memory consumption, three smaller, alternative versions are also provided in the 
standard C/EC++ library.

File input and output File input and output, page 63

Low-level environment functions Environment interaction, page 66

Low-level signal functions Signal and raise, page 67

Low-level time functions Time, page 67

Size of heaps, stacks, and segments Placing code and data, page 31

Items that can be customized Described in

Table 12: Customizable items  (Continued)
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Choosing formatters for printf and scanf
The following table summarizes the capabilities of the different formatters:

† Depends on the library configuration that is used.

For information about how to fine-tune the formatting capabilities even further, see 
Configuration symbols for printf and scanf, page 62.

Specifying the print formatter in the IAR Embedded Workbench 
IDE

To use any other formatter than the default (Large), choose Project>Options and select 
the General Options category. Select the appropriate option on the Library options 
page.

Specifying printf formatter from the command line

To use any other formatter than the default (_PrintfFull), add one of the following 
lines in the linker command file you are using:

-e_PrintfLarge=_Printf
-e_PrintfSmall=_Printf
-e_PrintfTiny=_Printf

CHOOSING SCANF FORMATTER 

In a similar way to the printf function, scanf uses a common formatter, called 
_Scanf. The default version is very large, and provides facilities that are not required 
in many embedded applications. To reduce the memory consumption, two smaller, 
alternative versions are also provided in the standard C/C++ library.

Formatting capabilities _PrintfFull _PrintfLarge _PrintfSmall _PrintfTiny

Basic specifiers c, d, i, o, p, s, u, X, 
x, and %

Yes Yes Yes Yes

Multibyte support † † † No

Floating-point specifiers a, and A Yes No No No

Floating-point specifiers e, E, f, F, g, 
and G

Yes Yes No No

Conversion specifier n Yes Yes No No

Format flag space, +, -, #, and 0 Yes Yes Yes No

Length modifiers h, l, L, s, t, and Z Yes Yes Yes No

Field width and precision, including * Yes Yes Yes No

long long support Yes Yes No No

Table 13: Formatters for printf 
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The following table summarizes the capabilities of the different formatters:

† Depends on the library configuration that is used.

For information about how to fine-tune the formatting capabilities even further, see 
Configuration symbols for printf and scanf, page 62.

Specifying scanf formatter in the IAR Embedded Workbench IDE

To use any other formatter than the default (Large), choose Project>Options and select 
the General Options category. Select the appropriate option on the Library options 
page.

Specifying scanf formatter from the command line

To use any other variant than the default (_ScanfFull), add one of the following lines 
in the linker command file you are using:

-e_ScanfLarge=_Scanf
-e_ScanfSmall=_Scanf

Overriding library modules 
The library contains modules which you probably need to override with your own 
customized modules, for example functions for character-based I/O and cstartup. 
This can be done without rebuilding the entire library. This section describes the 
procedure for including your version of the module in the application project build 
process. The library files that you can override with your own versions are located in the 
430\src\lib directory.

Formatting capabilities _ScanfFull _ScanfLarge _ScanfSmall

Basic specifiers c, d, i, o, p, s, u, X, 
x, and %

Yes Yes Yes

Multibyte support † † †

Floating-point specifiers a, and A Yes No No

Floating-point specifiers e, E, f, F, g, 
and G

Yes No No

Conversion specifier n Yes No No

Scan set [ and ] Yes Yes No

Assignment suppressing * Yes Yes No

long long support Yes No No

Table 14: Formatters for scanf 
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Overriding library modules
Note: If you override a default I/O library module with your own module, C-SPY 
support for the module is turned off. For example, if you replace the module __write 
with your own version, the C-SPY Terminal I/O window will not be supported.

Overriding library modules using the IAR Embedded Workbench 
IDE

This procedure is applicable to any source file in the library, which means that 
library_module.c in this example can be any module in the library.

1 Copy the appropriate library_module.c file to your project directory.

2 Make the required additions to the file (or create your own routine, using the default 
file as a model), and make sure that it has the same module name as the original 
module. The easiest way to achieve this is to save the new file under the same name as 
the original file.

3 Add the customized file to your project.

4 Rebuild your project.

Overriding library modules from the command line

This procedure is applicable to any source file in the library, which means that 
library_module.c in this example can be any module in the library.

1 Copy the appropriate library_module.c to your project directory.

2 Make the required additions to the file (or create your own routine, using the default 
file as a model), and make sure that it has the same module name as the original 
module. The easiest way to achieve this is to save the new file under the same name as 
the original file.

3 Compile the modified file using the same options as for the rest of the project:

icc430 library_module

This creates a replacement object module file named library_module.r43.

Note: Make sure to use a library that matches the settings of the rest of your application.

4 Add library_module.r43 to the XLINK command line, either directly or by using 
an extended linker command file, for example:

xlink library_module dl430fn.r43

Make sure that library_module is placed before the library on the command line. 
This ensures that your module is used instead of the one in the library.

Run XLINK to rebuild your application.
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This will use your version of library_module.r43, instead of the one in the library. 
For information about the XLINK options, see the IAR Linker and Library Tools 
Reference Guide.

Building and using a customized library
In some situations, see Situations that require library building, page 47, it is necessary 
to rebuild the library. In those cases you need to:

● Set up a library project

● Make the required library modifications

● Build your customized library

● Finally, make sure your application project will use the customized library.

Information about the build process is described in the MSP430 IAR Embedded 
Workbench® IDE User Guide. 

Note: It is possible to build IAR Embedded Workbench projects from the command 
line by using the IAR Command Line Build Utility (iarbuild.exe). However, no 
make or batch files for building the library from the command line are provided.

SETTING UP A LIBRARY PROJECT

The IAR Embedded Workbench IDE provides a library project template which can be 
used for customizing the runtime environment configuration. This library template has 
full library configuration, see Table 9, Library configurations, page 47.

In the IAR Embedded Workbench IDE, modify the generic options in the created library 
project to suit your application, see Basic settings for project configuration, page 5.

Note: There is one important restriction on setting options. If you set an option on file 
level (file level override), no options on higher levels that operate on files will affect that 
file.

MODIFYING THE LIBRARY FUNCTIONALITY

You must modify the library configuration file and build your own library if you want 
to modify support for, for example, locale, file descriptors, and multibyte characters. 
This will include or exclude certain parts of the runtime environment.

The library functionality is determined by a set of configuration symbols. The default 
values of these symbols are defined in the file Dlib_defaults.h. This read-only file 
describes the configuration possibilities. In addition, your library has its own library 
configuration file dl430libraryname.h, which sets up that specific library with full 
library configuration. For more information, see Table 12, Customizable items, page 50.
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System startup and termination
The library configuration file is used for tailoring a build of the runtime library, as well 
as tailoring the system header files.

Modifying the library configuration file

In your library project, open the file dl430libraryname.h and customize it by setting 
the values of the configuration symbols according to the application requirements.

When you are finished, build your library project with the appropriate project options.

USING A CUSTOMIZED LIBRARY

After you have built your library, you must make sure to use it in your application 
project. 

In the IAR Embedded Workbench IDE you must perform the following steps:

1 Choose Project>Options and click the Library Configuration tab in the General 
Options category. 

2 Choose Custom DLIB from the Library drop-down menu. 

3 In the Library file text box, locate your library file.

4 In the Configuration file text box, locate your library configuration file.

System startup and termination
This section describes the runtime environment actions performed during startup and 
termination of applications. The code for handling startup and termination is located in 
the source files cstartup.s43 and low_level_init.c. You will find these in the 
430\src\lib directory.

SYSTEM STARTUP

During system startup, an initialization sequence is executed before the main function 
is entered. This sequence performs initializations required for the target hardware and 
the C/C++ environment.
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For the hardware initialization, it looks like this:

Figure 1: Target hardware initialization phase

● When the CPU is reset it will jump to the program entry label __program_start 
in the system startup code

● The watchdog timer is disabled

● The stack pointer (SP) is initialized

● The function __low_level_init is called if you have defined it, giving the 
application a chance to perform early initializations.

For the C/C++ initialization, it looks like this:

Figure 2: C/C++ initialization phase

● Static variables are initialized; this includes clearing zero-initialized memory and 
copying the ROM image of the RAM memory of the rest of the initialized variables 
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System startup and termination
depending on the return value of __low_level_init. For more details, see 
Initialized data, page 37

● Static C++ objects are constructed

● The main function is called, which starts the application.

SYSTEM TERMINATION

There are four ways your embedded application can terminate in a controlled way:

Figure 3: System termination phase

An application can terminate normally in two different ways:

● Return from the main function

● Call the exit function.

As the ISO/ANSI C standard states that the two methods should be equivalent, the 
system startup code calls the exit function if main returns. The parameter passed to the 
exit function is the return value of main.

The default exit function is written in C. It calls a small assembler function _exit that 
will perform the following operations:

● Call functions registered to be executed when the application ends. This includes 
C++ destructors for static and global variables, and functions registered with the 
standard C function atexit

● Close all open files

● Call __exit

● When __exit is reached, stop the system.
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An application can also exit by calling the abort or the _Exit function. The abort 
function just calls __exit to halt the system, and does not perform any type of cleanup. 
The _Exit function is equivalent to the abort function, except for the fact that _Exit 
takes an argument for passing exit status information.

If you want your application to perform anything extra at exit, for example resetting the 
system, you can write your own implementation of the __exit(int) function.

C-SPY interface to system termination

If your project is linked with the XLINK options With runtime control modules or 
With I/O emulation modules, the normal __exit and abort functions are replaced 
with special ones. C-SPY will then recognize when those functions are called and can 
take appropriate actions to simulate program termination. For more information, see 
C-SPY Debugger runtime interface, page 69.

Customizing system initialization
It is likely that you need to customize the code for system initialization. For example, 
your application might need to initialize memory-mapped special function registers 
(SFRs), or omit the default initialization of data segments performed by cstartup.

You can do this by providing a customized version of the routine __low_level_init, 
which is called from cstartup.s43 before the data segments are initialized. 
Modifying the file cstartup directly should be avoided.

The code for handling system startup is located in the source files cstartup.s43 and 
low_level_init.c, located in the 430\src\lib directory. 

Note: Normally, there is no need for customizing the file cstartup.s43.

If you intend to rebuild the library, the source files are available in the template library 
project, see Building and using a customized library, page 55. 

Note: Regardless of whether you modify the routine __low_level_init or the file 
cstartup.s43, you do not have to rebuild the library.

__LOW_LEVEL_INIT 

Two skeleton low-level initialization files are supplied with the product: a C source file, 
low_level_init.c and an alternative assembler source file, low_level_init.s43. 
The latter is part of the prebuilt runtime environment. The only limitation using the C 
source version is that static initialized variables cannot be used within the file, as 
variable initialization has not been performed at this point.
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Standard streams for input and output
The value returned by __low_level_init determines whether or not data segments 
should be initialized by the system startup code. If the function returns 0, the data 
segments will not be initialized.

Note: The file intrinsics.h must be included by low_level_init.c to assure 
correct behavior of the __low_level_init routine.

MODIFYING THE FILE CSTARTUP.S43 

As noted earlier, you should not modify the file cstartup.s43 if a customized version 
of __low_level_init is enough for your needs. However, if you do need to modify 
the file cstartup.s43, we recommend that you follow the general procedure for 
creating a modified copy of the file and adding it to your project, see Overriding library 
modules, page 53.

Standard streams for input and output
There are three standard communication channels (streams)—stdin, stdout, and 
stderr—which are defined in stdio.h. If any of these streams are used by your 
application, for example by the functions printf and scanf, you need to customize the 
low-level functionality to suit your hardware.

There are primitive I/O functions, which are the fundamental functions through which 
C and C++ performs all character-based I/O. For any character-based I/O to be available, 
you must provide definitions for these functions using whatever facilities the hardware 
environment provides.

IMPLEMENTING LOW-LEVEL CHARACTER INPUT AND 
OUTPUT

To implement low-level functionality of the stdin and stdout streams, you must write 
the functions __read and __write, respectively. You can find template source code for 
these functions in the 430\src\lib directory. 

If you intend to rebuild the library, the source files are available in the template library 
project, see Building and using a customized library, page 55. Note that customizing the 
low-level routines for input and output does not require you to rebuild the library.

Note: If you write your own variants of __read or __write, special considerations 
for the C-SPY runtime interface are needed, see C-SPY Debugger runtime interface, 
page 69.
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Example of using __write and __read

The code in the following examples use memory-mapped I/O to write to an LCD 
display:

__no_init volatile unsigned char LCD_IO @ address;

size_t __write(int Handle, const unsigned char * Buf,
               size_t Bufsize)
{
  size_t nChars = 0;
  /* Check for stdout and stderr 
     (only necessary if file descriptors are enabled.) */
  if (Handle != 1 && Handle != 2)
  {
    return -1;
  }
  for (/*Empty */; Bufsize > 0; --Bufsize)
  {
    LCD_IO = * Buf++;
    ++nChars;
  }
  return nChars;
}

The code in the following example uses memory-mapped I/O to read from a keyboard:

__no_init volatile unsigned char KB_IO @ 0xD2;

size_t __read(int Handle, unsigned char *Buf, size_t BufSize)
{
  size_t nChars = 0;
  /* Check for stdin 
     (only necessary if FILE descriptors are enabled) */
  if (Handle != 0)
  {
    return -1;
  }
  for (/*Empty*/; BufSize > 0; --BufSize)
  {
    unsigned char c = KB_IO;
    if (c == 0)
      break;
    *Buf++ = c;
    ++nChars;
  }
  return nChars;
}
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Configuration symbols for printf and scanf
For information about the @ operator, see Controlling data and function placement in 
memory, page 116.

Configuration symbols for printf and scanf
When you set up your application project, you typically need to consider what printf 
and scanf formatting capabilities your application requires, see Choosing formatters 
for printf and scanf, page 51.

If the provided formatters do not meet your requirements, you can customize the full 
formatters. However, that means you need to rebuild the runtime library.

The default behavior of the printf and scanf formatters are defined by configuration 
symbols in the file DLIB_Defaults.h.

The following configuration symbols determine what capabilities the function printf 
should have:

When you build a library, the following configurations determine what capabilities the 
function scanf should have:

Printf configuration symbols Includes support for

_DLIB_PRINTF_MULTIBYTE Multibyte characters

_DLIB_PRINTF_LONG_LONG Long long (ll qualifier)

_DLIB_PRINTF_SPECIFIER_FLOAT Floating-point numbers

_DLIB_PRINTF_SPECIFIER_A Hexadecimal floats

_DLIB_PRINTF_SPECIFIER_N Output count (%n)

_DLIB_PRINTF_QUALIFIERS Qualifiers h, l, L, v, t, and z

_DLIB_PRINTF_FLAGS Flags -, +, #, and 0

_DLIB_PRINTF_WIDTH_AND_PRECISION Width and precision

_DLIB_PRINTF_CHAR_BY_CHAR Output char by char or buffered

Table 15: Descriptions of printf configuration symbols 

Scanf configuration symbols Includes support for

_DLIB_SCANF_MULTIBYTE Multibyte characters

_DLIB_SCANF_LONG_LONG Long long (ll qualifier)

_DLIB_SCANF_SPECIFIER_FLOAT Floating-point numbers

_DLIB_SCANF_SPECIFIER_N Output count (%n)

_DLIB_SCANF_QUALIFIERS Qualifiers h, j, l, t, z, and L

Table 16: Descriptions of scanf configuration symbols 
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CUSTOMIZING FORMATTING CAPABILITIES

To customize the formatting capabilities, you need to set up a library project, see 
Building and using a customized library, page 55. Define the configuration symbols 
according to your application requirements.

File input and output
The library contains a large number of powerful functions for file I/O operations. If you 
use any of these functions you need to customize them to suit your hardware. In order 
to simplify adaptation to specific hardware, all I/O functions call a small set of primitive 
functions, each designed to accomplish one particular task; for example, __open opens 
a file, and __write outputs a number of characters.

Note that file I/O capability in the library is only supported by libraries with full library 
configuration, see Library configurations, page 47. In other words, file I/O is supported 
when the configuration symbol __DLIB_FILE_DESCRIPTOR is enabled. If not enabled, 
functions taking a FILE * argument cannot be used. 

Template code for the following I/O files are included in the product: 

The primitive functions identify I/O streams, such as an open file, with a file descriptor 
that is a unique integer. The I/O streams normally associated with stdin, stdout, and 
stderr have the file descriptors 0, 1, and 2, respectively.

_DLIB_SCANF_SCANSET Scanset ([*])

_DLIB_SCANF_WIDTH Width

_DLIB_SCANF_ASSIGNMENT_SUPPRESSING Assignment suppressing ([*])

Scanf configuration symbols Includes support for

Table 16: Descriptions of scanf configuration symbols  (Continued)

I/O function File Description

__close close.c Closes a file.

__lseek lseek.c Sets the file position indicator.

__open open.c Opens a file.

__read read.c Reads a character buffer.

__write write.c Writes a character buffer.

remove remove.c Removes a file.

rename rename.c Renames a file.

Table 17: Low-level I/O files 
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Locale
Note: If you link your library with I/O debugging support, C-SPY variants of the 
low-level I/O functions will be linked for interaction with C-SPY. For more 
information, see Debug support in the runtime library, page 47.

Heap size and standard I/O

When you are using the full DLIB configuration, be aware that the size of the input and 
output buffers is set to 512 bytes in the stdio library header file. If the heap is too small, 
I/O will not be buffered, which is considerably slower than buffered I/O. If you execute 
the application using the simulator driver of the IAR C-SPY Debugger, you are not 
likely to notice the speed penalty, but it is quite noticeable when the application runs on 
an MSP430 microcontroller. If you use the standard I/O library, you should set the heap 
size to a value which accommodates the needs of the standard I/O buffer, for example 
1 Kbyte.

If you have excluded FILE descriptors from the DLIB runtime environment, as in the 
normal DLIB configuration, there are no input and output buffers at all.

Locale
Locale is a part of the C language that allows language- and country-specific settings for 
a number of areas, such as currency symbols, date and time, and multibyte character 
encoding.

Depending on what runtime library you are using you get different level of locale 
support. However, the more locale support, the larger your code will get. It is therefore 
necessary to consider what level of support your application needs.

The DLIB library can be used in two main modes:

● With locale interface, which makes it possible to switch between different locales 
during runtime

● Without locale interface, where one selected locale is hardwired into the 
application.

LOCALE SUPPORT IN PREBUILT LIBRARIES

The level of locale support in the prebuilt libraries depends on the library configuration. 

● All prebuilt libraries support the C locale only

● All libraries with full library configuration have support for the locale interface. For 
prebuilt libraries with locale interface, it is by default only supported to switch 
multibyte character encoding during runtime.

● Libraries with normal library configuration do not have support for the locale 
interface.
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If your application requires a different locale support, you need to rebuild the library.

CUSTOMIZING THE LOCALE SUPPORT

If you decide to rebuild the library, you can choose between the following locales:

● The standard C locale

● The POSIX locale

● A wide range of European locales.

Locale configuration symbols

The configuration symbol _DLIB_FULL_LOCALE_SUPPORT, which is defined in the 
library configuration file, determines whether a library has support for a locale interface 
or not. The locale configuration symbols _LOCALE_USE_LANG_REGION and 
_ENCODING_USE_ENCODING define all the supported locales and encodings.

If you want to customize the locale support, you simply define the locale configuration 
symbols required by your application. For more information, see Building and using a 
customized library, page 55.

Note: If you use multibyte characters in your C or assembler source code, make sure 
that you select the correct locale symbol (the local host locale).

Building a library without support for locale interface

The locale interface is not included if the configuration symbol 
_DLIB_FULL_LOCALE_SUPPORT is set to 0 (zero). This means that a hardwired locale 
is used—by default the standard C locale—but you can choose one of the supported 
locale configuration symbols. The setlocale function is not available and can 
therefore not be used for changing locales at runtime.

Building a library with support for locale interface 

Support for the locale interface is obtained if the configuration symbol 
_DLIB_FULL_LOCALE_SUPPORT is set to 1. By default, the standard C locale is used, 
but you can define as many configuration symbols as required. Because the setlocale 
function will be available in your application, it will be possible to switch locales at 
runtime.

CHANGING LOCALES AT RUNTIME 

The standard library function setlocale is used for selecting the appropriate portion 
of the application’s locale when the application is running.

The setlocale function takes two arguments. The first one is a locale category that is 
constructed after the pattern LC_CATEGORY. The second argument is a string that 
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Environment interaction
describes the locale. It can either be a string previously returned by setlocale, or it 
can be a string constructed after the pattern:

lang_REGION

or

lang_REGION.encoding

The lang part specifies the language code, and the REGION part specifies a region 
qualifier, and encoding specifies the multibyte character encoding that should be used.

The lang_REGION part matches the _LOCALE_USE_LANG_REGION preprocessor 
symbols that can be specified in the library configuration file.

Example

This example sets the locale configuration symbols to Swedish to be used in Finland and 
UTF8 multibyte character encoding:

setlocale (LC_ALL, "sv_FI.Utf8");

Environment interaction
According to the C standard, your application can interact with the environment using 
the functions getenv and system.

Note: The putenv function is not required by the standard, and the library does not 
provide an implementation of it.

The getenv function searches the string, pointed to by the global variable __environ, 
for the key that was passed as argument. If the key is found, the value of it is returned, 
otherwise 0 (zero) is returned. By default, the string is empty.

To create or edit keys in the string, you must create a sequence of null terminated strings 
where each string has the format:

key=value\0

The last string must be empty. Assign the created sequence of strings to the __environ 
variable.

For example:

const char MyEnv[] = ”Key=Value\0Key2=Value2\0”;
__environ = MyEnv;

If you need a more sophisticated environment variable handling, you should implement 
your own getenv, and possibly putenv function. This does not require that you rebuild 
the library. You can find source templates in the files getenv.c and environ.c in the 
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430\src\lib directory. For information about overriding default library modules, see 
Overriding library modules, page 53. 

If you need to use the system function, you need to implement it yourself. The system 
function available in the library simply returns -1.

If you decide to rebuild the library, you can find source templates in the library project 
template. For further information, see Building and using a customized library, page 55.

Note: If you link your application with support for I/O debugging, the functions 
getenv and system will be replaced by C-SPY variants. For further information, see 
Debug support in the runtime library, page 47.

Signal and raise
There are default implementations of the functions signal and raise available. If 
these functions do not provide the functionality that you need, you can implement your 
own versions.

This does not require that you rebuild the library. You can find source templates in the 
files signal.c and raise.c in the 430\src\lib directory. For information about 
overriding default library modules, see Overriding library modules, page 53. 

If you decide to rebuild the library, you can find source templates in the library project 
template. For further information, see Building and using a customized library, page 55.

Time
To make the time and date functions work, you must implement the three functions 
clock, time, and __getzone.

This does not require that you rebuild the library. You can find source templates in the 
files clock.c and time.c, and getzone.c in the 430\src\lib directory. For 
information about overriding default library modules, see Overriding library modules, 
page 53. 

If you decide to rebuild the library, you can find source templates in the library project 
template. For further information, see Building and using a customized library, page 55.

The default implementation of __getzone specifies UTC as the time zone.

Note: If you link your application with support for I/O debugging, the functions clock 
and time will be replaced by C-SPY variants that return the host clock and time 
respectively. For further information, see C-SPY Debugger runtime interface, page 69.
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Strtod
Strtod
The function strtod does not accept hexadecimal floating-point strings in libraries 
with the normal library configuration. To make a library do so, you need to rebuild the 
library, see Building and using a customized library, page 55. Enable the configuration 
symbol _DLIB_STRTOD_HEX_FLOAT in the library configuration file.

Assert
If you have linked your application with support for runtime debugging, C-SPY will be 
notified about failed asserts. If this is not the behavior you require, you must add the 
source file xreportassert.c to your application project. Alternatively, you can 
rebuild the library. The __ReportAssert function generates the assert notification. 
You can find template code in the 430\src\lib directory. For further information, see 
Building and using a customized library, page 55. To turn off assertions, you must define 
the symbol NDEBUG.

In the IAR Embedded Workbench IDE, this symbol NDEBUG is by default defined in a 
Release project and not defined in a Debug project. If you build from the command line, 
you must explicitly define the symbol according to your needs.

Heaps
The runtime environment supports heaps in the following memory types: 

See The heap, page 39 for information about how to set the size for each heap. To use a 
specific heap, the prefix in the table is the extended keyword to use in front of malloc, 
free, calloc, and realloc. The default functions will use one of the specific heap 
variants, depending on project settings such as data model. For information about how 
to use a specific heap in C++, see New and Delete operators, page 106.

Hardware multiplier support
Some MSP430 devices contain a hardware multiplier. The MSP430 IAR C/C++ 
Compiler supports this unit by means of dedicated runtime library modules.

Memory type Segment name Extended keyword
Used by default in data 

model

Data16 DATA16_HEAP __data16 Small and Medium

Data20 DATA20_HEAP __data20 Large

Table 18: Heaps and memory types 
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To make the compiler take advantage of the hardware multiplier unit, choose 
Project>Options>General Options>Target and select a device that contains a 
hardware multiplier unit from the Device drop-down menu. Make sure that the option 
Hardware multiplier is selected.

Specify which runtime library object file to use on the XLINK command line.

In addition to the runtime library object file, you must extend the XLINK command line 
with an additional linker command file if you want support for the hardware multiplier. 

To use the hardware multiplier, extend the XLINK command line with the directive: 

-f multiplier.xcl

Note: Interrupts are disabled during a hardware-multiply operation.

C-SPY Debugger runtime interface 
To include support for runtime and I/O debugging, you must link your application 
with the XLINK options With runtime control modules or With I/O emulation 
modules, see Debug support in the runtime library, page 47. 

In this case, C-SPY variants of the following library functions will be linked to the 
application:

Function Description

abort C-SPY notifies that the application has called abort *

clock Returns the clock on the host computer

__close Closes the associated host file on the host computer

__exit C-SPY notifies that the end of the application has been reached *

__open Opens a file on the host computer

__read stdin, stdout, and stderr will be directed to the Terminal I/O 
window; all other files will read the associated host file

remove Writes a message to the Debug Log window and returns -1

rename Writes a message to the Debug Log window and returns -1

_ReportAssert Handles failed asserts *

__seek Seeks in the associated host file on the host computer

system Writes a message to the Debug Log window and returns -1

time Returns the time on the host computer

__write stdin, stdout, and stderr will be directed to the Terminal I/O 
window, all other files will write to the associated host file

Table 19: Functions with special meanings when linked with debug info
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C-SPY Debugger runtime interface
* The linker option With I/O emulation modules is not required for these functions.

LOW-LEVEL DEBUGGER RUNTIME INTERFACE

The low-level debugger runtime interface is used for communication between the 
application being debugged and the debugger itself. The debugger provides runtime 
services to the application via this interface; services that allow capabilities like file and 
terminal I/O to be performed on the host computer. 

These capabilities can be valuable during the early development of an application, for 
example in an application using file I/O before any flash file system I/O drivers have 
been implemented. Or, if you need to debug constructions in your application that use 
stdin and stdout without the actual hardware device for input and output being 
available. Another debugging purpose can be to produce debug trace printouts.

The mechanism used for implementing this feature works as follows:

The debugger will detect the presence of the function __DebugBreak, which will be 
part of the application if you have linked it with the XLINK options for C-SPY runtime 
interface. In this case, the debugger will automatically set a breakpoint at the 
__DebugBreak function. When the application calls, for example open, the 
__DebugBreak function is called, which will cause the application to break and 
perform the necessary services. The execution will then resume.

THE DEBUGGER TERMINAL I/O WINDOW

To make the Terminal I/O window available, the application must be linked with 
support for I/O debugging, see Debug support in the runtime library, page 47. This 
means that when the functions __read or __write are called to perform I/O 
operations on the streams stdin, stdout, or stderr, data will be sent to or read 
from the C-SPY Terminal I/O window.

Note: The Terminal I/O window is not opened automatically just because __read or 
__write is called; you must open it manually.

See the MSP430 IAR Embedded Workbench® IDE User Guide for more information 
about the Terminal I/O window.

Speeding up terminal output

On some systems, terminal output might be slow because the host computer and the 
target hardware must communicate for each character.

For this reason, a replacement for the __write function called __write_buffered 
has been included in the DLIB library. This module buffers the output and sends it to the 
debugger one line at a time, speeding up the output. Note that this function uses about 
80 bytes of RAM memory.
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To use this feature you can either choose Project>Options>Linker>Output and select 
the option Buffered terminal output in the Embedded Workbench IDE, or add the 
following to the linker command line:

-e__write_buffered=__write

Checking module consistency
This section introduces the concept of runtime model attributes, a mechanism used by 
the IAR compiler, assembler, and linker to ensure module consistency.

When developing an application, it is important to ensure that incompatible modules are 
not used together. For example, in the MSP430 IAR C/C++ Compiler, it is possible to 
specify the size of the double floating-point type. If you write a routine that only works 
for 64-bit doubles, it is possible to check that the routine is not used in an application 
built using 32-bit doubles.

The tools provided by IAR Systems use a set of predefined runtime model attributes. 
You can use these predefined attributes or define your own to perform any type of 
consistency check.

RUNTIME MODEL ATTRIBUTES 

A runtime attribute is a pair constituted of a named key and its corresponding value. Two 
modules can only be linked together if they have the same value for each key that they 
both define.

There is one exception: if the value of an attribute is *, then that attribute matches any 
value. The reason for this is that you can specify this in a module to show that you have 
considered a consistency property, and this ensures that the module does not rely on that 
property.

Example

In the following table, the object files could (but do not have to) define the two runtime 
attributes color and taste. In this case, file1 cannot be linked with any of the other 
files, since the runtime attribute color does not match. Also, file4 and file5 cannot 
be linked together, because the taste runtime attribute does not match. 

On the other hand, file2 and file3 can be linked with each other, and with either 
file4 or file5, but not with both.

Object file Color Taste

file1 blue not defined

Table 20: Example of runtime model attributes 
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Checking module consistency
USING RUNTIME MODEL ATTRIBUTES

Runtime model attributes can be specified in your C/C++ source code to ensure module 
consistency with other object files by using the #pragma rtmodel directive. For 
example:

#pragma rtmodel="__rt_version", "1"

For detailed syntax information, see rtmodel, page 212.

Runtime model attributes can also be specified in your assembler source code by using 
the RTMODEL assembler directive. For example:

RTMODEL "color", "red"

For detailed syntax information, see the MSP430 IAR Assembler Reference Guide.

Note: The predefined runtime attributes all start with two underscores. Any attribute 
names you specify yourself should not contain two initial underscores in the name, to 
eliminate any risk that they will conflict with future IAR runtime attribute names.

At link time, the IAR XLINK Linker checks module consistency by ensuring that 
modules with conflicting runtime attributes will not be used together. If conflicts are 
detected, an error is issued.

PREDEFINED RUNTIME ATTRIBUTES 

The table below shows the predefined runtime model attributes that are available for the 
MSP430 IAR C/C++ Compiler. These can be included in assembler code or in mixed 
C/C++ and assembler code.

file2 red not defined

file3 red *

file4 red spicy

file5 red lean

Runtime model attribute Value Description

__core 430 or 430X Corresponds to the --core option.

__data_model small, 

medium,or large
Corresponds to the data model used in the 
project; only available for MSP430X.

__double_size 32 or 64 The size, in bits, of the double 
floating-point type.

Table 21: Predefined runtime model attributes 

Object file Color Taste

Table 20: Example of runtime model attributes  (Continued)
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Note: The value free should be seen as the opposite of locked, that is, the register is 
free to be used by the compiler.

The easiest way to find the proper settings of the RTMODEL directive is to compile a C or 
C++ module to generate an assembler file, and then examine the file.

If you are using assembler routines in the C or C++ code, refer to the chapter Assembler 
directives in the MSP430 IAR Assembler Reference Guide.

Examples

For an example of using the runtime model attribute __rt_version for checking 
module consistency on used calling convention, see Hints for a quick introduction to the 
calling conventions, page 90.

The following assembler source code provides a function that counts the number of 
times it has been called by increasing the register R4. The routine assumes that the 
application does not use R4 for anything else, that is, the register has been locked for 
usage. To ensure this, a runtime module attribute, __reg_r4, has been defined with a 
value counter. This definition will ensure that this specific module can only be linked 
with either other modules containing the same definition, or with modules that do not 
set this attribute. Note that the compiler sets this attribute to free, unless the register is 
locked.

RTMODEL "__reg_r4", "counter"
MODULE myCounter
PUBLIC myCounter
RSEG CODE:CODE:NOROOT(1)

myCounter: INC R4
RET
ENDMOD
END

__reg_r4

__reg_r5

free or undefined Corresponds to the use of the register, or 
undefined when the register is not used. A 
routine that assumes that the register is 
locked should set the attribute to a value 
other than free.

__rt_version 3 This runtime key is always present in all 
modules generated by the MSP430 IAR 
C/C++ Compiler. If a major change in the 
runtime characteristics occurs, the value of 
this key changes.

Runtime model attribute Value Description

Table 21: Predefined runtime model attributes  (Continued)
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If this module is used in an application that contains modules where the register R4 has 
not been locked, an error is issued by the linker:

Error[e117]: Incompatible runtime models. Module myCounter 
specifies that '__reg_r4' must be 'counter', but module part1 
has the value 'free'

USER-DEFINED RUNTIME MODEL ATTRIBUTES

In cases where the predefined runtime model attributes are not sufficient, you can define 
your own attributes by using the RTMODEL assembler directive. For each property, select 
a key and a set of values that describe the states of the property that are incompatible. 
Note that key names that start with two underscores are reserved by the compiler.

For example, if you have a UART that can run in two modes, you can specify a runtime 
model attribute, for example uart. For each mode, specify a value, for example mode1 
and mode2. You should declare this in each module that assumes that the UART is in a 
particular mode. This is how it could look like in one of the modules:

#pragma rtmodel="uart", "mode1"
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This chapter describes the runtime environment in which an application 
executes. In particular, it covers the CLIB runtime library and how you can 
optimize it for your application.

The standard library uses a small set of low-level input and output routines for 
character-based I/O. This chapter describes how the low-level routines can be 
replaced by your own version. The chapter also describes how you can choose 
printf and scanf formatters.

The chapter then describes system initialization and termination. It presents 
how an application can control what happens before the start function main is 
called, and the method for how you can customize the initialization. Finally, the 
C-SPY® runtime interface is covered.

Note that the legacy CLIB runtime environment is provided for backward 
compatibility and should not be used for new application projects.

For information about migrating from CLIB to DLIB, see the MSP430 IAR 
Embedded Workbench® Migration Guide.

Runtime environment
The CLIB runtime environment includes the C standard library. The linker will include 
only those routines that are required—directly or indirectly—by your application. For 
detailed reference information about the runtime libraries, see the chapter Library 
functions.

The MSP430 IAR Embedded Workbench comes with a set of prebuilt runtime libraries, 
which are configured for different combinations of the following features:

● Core

● Data model

● Size of the double floating-point type
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● Position-independent code.

For the MSP430 IAR C/C++ Compiler, this means there is a prebuilt runtime library for 
each combination of these options. The following table shows the mapping of the library 
file, code models, and processor variants:

The runtime library names are constructed in the following way:

<type><core><data_model><size_of_double><PIC>.r43

where

● <type> cl for the IAR CLIB Library

● <core> is 430 or 430x

● <data_model> is one of s, m, or l, for Small, Medium, and Large data model, 
respectively

● <size_of_double> is either f for 32 bits or d for 64 bits

● <PIC> is either p for position-independent code or empty for no support for 
position-independent code.

The IAR Embedded Workbench IDE includes the correct runtime library based on the 
options you select. See the MSP430 IAR Embedded Workbench® IDE User Guide for 
additional information.

Specify which runtime library object file to use on the XLINK command line, for 
instance:

cl430d.r43

Library object file Processor core Data model Size of double PIC

cl430f.r43 430 N/A 32 No

cl430fp.r43 430 N/A 32 Yes

cl430d.r43 430 N/A 64 No

cl430dp.r43 430 N/A 64 Yes

cl430xsf.r43 430X Small 32 No

cl430xsd.r43 430X Small 64 No

cl430xmf.r43 430X Medium 32 No

cl430xmd.r43 430X Medium 64 No

cl430xlf.r43 430X Large 32 No

cl430xld.r43 430X Large 64 No

Table 22: Runtime libraries 
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Input and output
You can customize:

● The functions related to character-based I/O

● The formatters used by printf/sprintf and scanf/sscanf.

CHARACTER-BASED I/O

The functions putchar and getchar are the fundamental C functions for 
character-based I/O. For any character-based I/O to be available, you must provide 
definitions for these two functions, using whatever facilities the hardware environment 
provides.

The creation of new I/O routines is based on the following files:

● putchar.c, which serves as the low-level part of functions such as printf 

● getchar.c, which serves as the low-level part of functions such as scanf. 

The code example below shows how memory-mapped I/O could be used to write to a 
memory-mapped I/O device:

__no_init volatile unsigned char DEV_IO @ address;

  int putchar(int outchar)
  {
    DEV_IO = outchar;
    return outchar;
  }

The exact address is a design decision. For example, it can depend on the selected 
processor variant.

For information about how to include your own modified version of putchar and 
getchar in your project build process, see Overriding library modules, page 53.

FORMATTERS USED BY PRINTF AND SPRINTF

The printf and sprintf functions use a common formatter, called 
_formatted_write. The full version of _formatted_write is very large, and 
provides facilities not required in many embedded applications. To reduce the memory 
consumption, two smaller, alternative versions are also provided in the standard C 
library.
C430-7

Part 1. Using the compiler 77



78

Input and output
_medium_write

The _medium_write formatter has the same functions as _formatted_write, except 
that floating-point numbers are not supported. Any attempt to use a %f, %g, %G, %e, or 
%E specifier will produce a runtime error:

FLOATS? wrong formatter installed!

_medium_write is considerably smaller than _formatted_write.

_small_write

The _small_write formatter works in the same way as  _medium_write, except that 
it supports only the %%, %d, %o, %c, %s, and %x specifiers for integer objects, and does 
not support field width or precision arguments. The size of _small_write is 10–15% 
that of _formatted_write.

Specifying the printf formatter in the IAR Embedded Workbench 
IDE

1 Choose Project>Options and select the General Options category. Click the Library 
options tab.

2 Select the appropriate Printf formatter option, which can be either Small, Medium, 
or Large.

Specifying the printf formatter from the command line

To use the _small_write or _medium_write formatter, add the corresponding line in 
the linker command file:

-e_small_write=_formatted_write

or

-e_medium_write=_formatted_write

To use the full version, remove the line.

Customizing printf 

For many embedded applications, sprintf is not required, and even printf with 
_small_write provides more facilities than are justified, considering the amount of 
memory it consumes. Alternatively, a custom output routine may be required to support 
particular formatting needs or non-standard output devices.

For such applications, a much reduced version of the printf function (without 
sprintf) is supplied in source form in the file intwri.c. This file can be modified to 
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meet your requirements, and the compiled module inserted into the library in place of 
the original file; see Overriding library modules, page 53.

FORMATTERS USED BY SCANF AND SSCANF

Similar to the printf and sprintf functions, scanf and sscanf use a common 
formatter, called _formatted_read. The full version of _formatted_read is very 
large, and provides facilities that are not required in many embedded applications. To 
reduce the memory consumption, an alternative smaller version is also provided.

_medium_read

The _medium_read formatter has the same functions as the full version, except that 
floating-point numbers are not supported. _medium_read is considerably smaller than 
the full version.

Specifying the scanf formatter in the IAR Embedded Workbench 
IDE

1 Choose Project>Options and select the General Options category. Click the Library 
options tab.

2 Select the appropriate Scanf formatter option, which can be either Medium or Large.

Specifying the read formatter from the command line

To use the _medium_read formatter, add the following line in the linker command file:

-e_medium_read=_formatted_read

To use the full version, remove the line.

System startup and termination
This section describes the actions the runtime environment performs during startup and 
termination of applications.

The code for handling startup and termination is located in the source files 
cstartup.s43 and low_level_init.c located in the 430\src\lib directory.

Note: Normally, there is no need for customizing the file cstartup.s43.

SYSTEM STARTUP

When an application is initialized, a number of steps are performed:

● The stack pointer (SP) is initialized
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Overriding default library modules
● The custom function __low_level_init is called if you have defined it, giving 
the application a chance to perform early initializations

● Static variables are initialized; this includes clearing zero-initialized memory and 
copying the ROM image of the RAM memory of the remaining initialized variables

● The main function is called, which starts the application.

Note that the system startup code contains code for more steps than described here. The 
other steps are applicable to the DLIB runtime environment.

SYSTEM TERMINATION

An application can terminate normally in two different ways:

● Return from the main function

● Call the exit function.

Because the ISO/ANSI C standard states that the two methods should be equivalent, the 
cstartup code calls the exit function if main returns. The parameter passed to the 
exit function is the return value of main. The default exit function is written in 
assembler.

When the application is built in debug mode, C-SPY stops when it reaches the special 
code label ?C_EXIT.

An application can also exit by calling the abort function. The default function just 
calls __exit in order to halt the system, without performing any type of cleanup.

Overriding default library modules
The IAR CLIB Library contains modules which you probably need to override with 
your own customized modules, for example for character-based I/O, without rebuilding 
the entire library. For information about how to override default library modules, see 
Overriding library modules, page 53, in the chapter The DLIB runtime environment.

Customizing system initialization
For information about how to customize system initialization, see Customizing system 
initialization, page 59.

C-SPY runtime interface 
The low-level debugger interface is used for communication between the application 
being debugged and the debugger itself. The interface is simple: C-SPY will place 
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breakpoints on certain assembler labels in the application. When code located at the 
special labels is about to be executed, C-SPY will be notified and can perform an action.

THE DEBUGGER TERMINAL I/O WINDOW

When code at the labels ?C_PUTCHAR and ?C_GETCHAR is executed, data will be sent to 
or read from the debugger window.

For the ?C_PUTCHAR routine, one character is taken from the output stream and written. 
If everything goes well, the character itself is returned, otherwise -1 is returned.

When the label ?C_GETCHAR is reached, C-SPY returns the next character in the input 
field. If no input is given, C-SPY waits until the user has typed some input and pressed 
the Return key.

To make the Terminal I/O window available, the application must be linked with the 
XLINK option With I/O emulation modules selected. See the MSP430 IAR Embedded 
Workbench® IDE User Guide.

TERMINATION

The debugger stops executing when it reaches the special label ?C_EXIT. 

Checking module consistency
For information about how to check module consistency, see Checking module 
consistency, page 71.
C430-7

Part 1. Using the compiler 81



82

Checking module consistency
C430-7

MSP430 IAR C/C++ Compiler
Reference Guide



Assembler language 
interface 
When you develop an application for an embedded system, there may be 
situations where you will find it necessary to write parts of the code in 
assembler, for example when using mechanisms in the MSP430 
microcontroller that require precise timing and special instruction sequences.

This chapter describes the available methods for this, as well as some C 
alternatives, with their advantages and disadvantages. It also describes how to 
write functions in assembler language that work together with an application 
written in C or C++.

Finally, the chapter covers how functions are called for the different cores, the 
different memory access methods corresponding to the supported memory 
types, and how you can implement support for call frame information in your 
assembler routines for use in the C-SPY® Call Stack window.

Mixing C and assembler
The MSP430 IAR C/C++ Compiler provides several ways to mix C or C++ and 
assembler: 

● Modules written entirely in assembler

● Intrinsic functions (the C alternative)

● Inline assembler.

It might be tempting to use simple inline assembler. However, you should carefully 
choose which method to use.

INTRINSIC FUNCTIONS

The compiler provides a small number of predefined functions that allow direct access 
to low-level processor operations without having to use the assembler language. These 
functions are known as intrinsic functions. They can be very useful in, for example, 
time-critical routines. 
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An intrinsic function looks like a normal function call, but it is really a built-in function 
that the compiler recognizes. The intrinsic functions compile into inline code, either as 
a single instruction, or as a short sequence of instructions. 

The advantage of an intrinsic function compared to using inline assembler is that the 
compiler has all necessary information to interface the sequence properly with register 
allocation and variables. The compiler also knows how to optimize functions with such 
sequences; something the compiler is unable to do with inline assembler sequences. The 
result is that you get the desired sequence properly integrated in your code, and that the 
compiler can optimize the result.

For detailed information about the available intrinsic functions, see the chapter Intrinsic 
functions.

MIXING C AND ASSEMBLER MODULES

It is possible to write parts of your application in assembler and mix them with your C 
or C++ modules. There are several benefits with this compared to using inline 
assembler:

● The function call mechanism is well-defined

● The code will be easy to read

● The optimizer can work with the C or C++ functions.

There will be some overhead in the form of a function call and return instruction 
sequences, and the compiler will regard some registers as scratch registers.

On the other hand, you will have a well-defined interface between what the compiler 
performs and what you write in assembler. When using inline assembler, you will not 
have any guarantees that your inline assembler lines do not interfere with the compiler 
generated code.

When an application is written partly in assembler language and partly in C or C++, you 
are faced with a number of questions:

● How should the assembler code be written so that it can be called from C?

● Where does the assembler code find its parameters, and how is the return value 
passed back to the caller?

● How should assembler code call functions written in C?

● How are global C variables accessed from code written in assembler language?

● Why does not the debugger display the call stack when assembler code is being 
debugged?

The first issue is discussed in the section Calling assembler routines from C, page 86. 
The following two are covered in the section Calling convention, page 89.
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The answer to the final question is that the call stack can be displayed when you run 
assembler code in the debugger. However, the debugger requires information about the 
call frame, which must be supplied as annotations in the assembler source file. For more 
information, see Call frame information, page 97.

The recommended method for mixing C or C++ and assembler modules is described in 
Calling assembler routines from C, page 86, and Calling assembler routines from C++, 
page 88, respectively.

INLINE ASSEMBLER 

It is possible to insert assembler code directly into a C or C++ function. The asm 
keyword assembles and inserts the supplied assembler statement in-line. The following 
example shows how to use inline assembler to insert assembler instructions directly in 
the C source code. This example also shows the risks of using inline assembler.

bool flag;

void foo()
{
  while (!flag)
  {
    asm("MOV.B &P1IN,&flag");
  }
}

In this example, the assignment of flag is not noticed by the compiler, which means the 
surrounding code cannot be expected to rely on the inline assembler statement.

The inline assembler instruction will simply be inserted at the given location in the 
program flow. The consequences or side-effects the insertion may have on the 
surrounding code have not been taken into consideration. If, for example, registers or 
memory locations are altered, they may have to be restored within the sequence of inline 
assembler instructions for the rest of the code to work properly.

Inline assembler sequences have no well-defined interface with the surrounding code 
generated from your C or C++ code. This makes the inline assembler code fragile, and 
will possibly also become a maintenance problem if you upgrade the compiler in the 
future. In addition, there are several limitations to using inline assembler:

● The compiler’s various optimizations will disregard any effects of the inline 
sequences, which will not be optimized at all

● In general, assembler directives will cause errors or have no meaning. Data 
definition directives will work as expected

● Alignment cannot be controlled

● Auto variables cannot be accessed.
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Calling assembler routines from C
Inline assembler is therefore often best avoided. If there is no suitable intrinsic function 
available, we recommend the use of modules written in assembler language instead of 
inline assembler, because the function call to an assembler routine normally causes less 
performance reduction.

Calling assembler routines from C
An assembler routine that is to be called from C must:

● Conform to the calling convention

● Have a PUBLIC entry-point label

● Be declared as external before any call, to allow type checking and optional 
promotion of parameters, as in the following examples:

extern int foo(void);

or

extern int foo(int i, int j);

One way of fulfilling these requirements is to create skeleton code in C, compile it, and 
study the assembler list file.

CREATING SKELETON CODE

The recommended way to create an assembler language routine with the correct 
interface is to start with an assembler language source file created by the C compiler. 
Note that you must create skeleton code for each function prototype.

The following example shows how to create skeleton code to which you can easily add 
the functional body of the routine. The skeleton source code only needs to declare the 
variables required and perform simple accesses to them. In this example, the assembler 
routine takes an int and a double, and then returns an int:

extern int gInt;
extern double gDouble;

int func(int arg1, double arg2)
{
  int locInt = arg1;
  gInt = arg1;
  gDouble = arg2;
  return locInt;
}
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int main()
{
  int locInt = gInt;
  gInt = func(locInt, gDouble);
  return 0;
}

Note: In this example we use a low optimization level when compiling the code to 
show local and global variable access. If a higher level of optimization is used, the 
required references to local variables could be removed during the optimization. The 
actual function declaration is not changed by the optimization level.

COMPILING THE CODE

In the IAR Embedded Workbench IDE, specify list options on file level. Select the file 
in the workspace window. Then choose Project>Options. In the C/C++ Compiler 
category, select Override inherited settings. On the List page, deselect Output list 
file, and instead select the Output assembler file option and its suboption Include 
source. Also, be sure to specify a low level of optimization.

Use the following options to compile the skeleton code:

icc430 skeleton -lA .

The -lA option creates an assembler language output file including C or C++ source 
lines as assembler comments. The . (period) specifies that the assembler file should be 
named in the same way as the C or C++ module (skeleton), but with the filename 
extension s43. Also remember to specify the data model you are using (if applicable) as 
well as a low level of optimization and -e for enabling language extensions.

The result is the assembler source output file skeleton.s43.

Note: The -lA option creates a list file containing call frame information (CFI) 
directives, which can be useful if you intend to study these directives and how they are 
used. If you only want to study the calling convention, you can exclude the CFI 
directives from the list file. In the IAR Embedded Workbench IDE, select 
Project>Options>C/C++ Compiler>List and deselect the suboption Include 
compiler runtime information. On the command line, use the option -lB instead of 
-lA. Note that CFI information must be included in the source code to make the C-SPY 
Call Stack window work. 

The output file

The output file contains the following important information:

● The calling convention

● The return values
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● The global variables

● The function parameters

● How to create space on the stack (auto variables)

● Call frame information (CFI).

The CFI directives describe the call frame information needed by the Call Stack window 
in the IAR C-SPY Debugger.

Calling assembler routines from C++
The C calling convention does not apply to C++ functions. Most importantly, a function 
name is not sufficient to identify a C++ function. The scope and the type of the function 
are also required to guarantee type-safe linkage, and to resolve overloading. 

Another difference is that non-static member functions get an extra, hidden argument, 
the this pointer.

However, when using C linkage, the calling convention conforms to the C calling 
convention. An assembler routine may therefore be called from C++ when declared in 
the following manner:

extern "C" 
{
  int my_routine(int x);
}

Memory access layout of non-PODs (“plain old data structures”) is not defined, and may 
change between compiler versions. Therefore, we do not recommend that you access 
non-PODs from assembler routines.

To achieve the equivalent to a non-static member function, the implicit this pointer has 
to be made explicit:

class X;

extern "C" 
{
  void doit(X *ptr, int arg);
}
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It is possible to “wrap” the call to the assembler routine in a member function. Using an 
inline member function removes the overhead of the extra call—provided that function 
inlining is enabled:

class X 
{
public:
  inline void doit(int arg) { ::doit(this, arg); }
}; 

Note: Support for C++ names from assembler code is extremely limited. This means 
that:

● Assembler list files resulting from compiling C++ files cannot, in general, be passed 
through the assembler.

It is not possible to refer to or define C++ functions that do not have C linkage in 
assembler.

Calling convention
A calling convention is the way a function in a program calls another function. The 
compiler handles this automatically, but, if a function is written in assembler language, 
you must know where and how its parameters can be found, how to return to the program 
location from where it was called, and how to return the resulting value.

It is also important to know which registers an assembler-level routine must preserve. If 
the program preserves too many registers, the program might be ineffective. If it 
preserves too few registers, the result would be an incorrect program.

The MSP430 IAR C/C++ Compiler provides two calling conventions—Version1 and 
Version2. This section describes the calling conventions used by the MSP430 IAR 
C/C++ Compiler. The following items are examined:

● Choosing a calling convention

● Function declarations

● C and C++ linkage

● Preserved versus scratch registers

● Function entrance

● Function exit

● Return address handling. 

At the end of the section, some examples are shown to describe the calling convention 
in practice. 
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CHOOSING A CALLING CONVENTION

The compiler supports two calling conventions:

● The Version1 calling convention is used by version 1.x, 2.x, and 3.x of the compiler

● The Version2 calling convention was introduced with version 4.x of the compiler. It 
is more efficient than the Version1 calling convention.

You can explicitly specify the calling convention when you declare and define functions. 
However, normally this is not needed, unless the function is written in assembler. 

For old routines written in assembler and that use the Version1 calling convention, the 
the keyword __cc_version1 function attribute should be used, for example:

extern __cc_version1 void doit(int arg);

New routines written in assembler should be declared using the keyword 
__cc_version2. This ensures that they will be called using the Version2 calling 
convention if new calling conventions are introduced in future compilers.

Hints for a quick introduction to the calling conventions

Both calling conventions are complex and if you intend to use any of them for your 
assembler routines, you should create a list file and see how the compiler assigns the 
different parameters to the available registers. For an example, see Creating skeleton 
code, page 86. 

If you intend to use both of the calling conventions, you should also specify a value to 
the runtime model attribute __rt_version using the RTMODEL assembler directive:

RTMODEL "__rt_version"="value"

The parameter value should have the same value as the one used internally by the 
compiler. For information about what value to use, see the generated list file. If the 
calling convention changes in future compiler versions, the runtime model value used 
internally by the compiler will also change. Using this method gives a module 
consistency check as the linker will produce an error if there is a mismatch between the 
values.

For more information about checking module consistency, see Checking module 
consistency, page 71.

FUNCTION DECLARATIONS 

In C, a function must be declared in order for the compiler to know how to call it. A 
declaration could look as follows:

int a_function(int first, char * second);
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This means that the function takes two parameters: an integer and a pointer to a 
character. The function returns a value, an integer.

In the general case, this is the only knowledge that the compiler has about a function. 
Therefore, it must be able to deduce the calling convention from this information.

USING C LINKAGE IN C++ SOURCE CODE

In C++, a function can have either C or C++ linkage. To call assembler routines from 
C++, it is easiest if you make the C++ function have C linkage.

The following is an example of a declaration of a function with C linkage:

extern "C"
{
   int f(int);
}

It is often practical to share header files between C and C++. The following is an 
example of a declaration that declares a function with C linkage in both C and C++:

#ifdef __cplusplus
extern "C" 
{
#endif

   int f(int);

#ifdef __cplusplus
}
#endif

PRESERVED VERSUS SCRATCH REGISTERS 

The general MSP430 CPU registers are divided into three separate sets, which are 
described in this section.

Scratch registers 

Any function may destroy the contents of a scratch register. If a function needs the 
register value after a call to another function, it must store it during the call, for example 
on the stack.

Any of the registers R12 to R15, as well as the return address registers, are considered 
scratch registers and can be used by the function.

When the registers R11:R10:R9:R8 are used for passing a 64-bit scalar parameter, they 
are also considered to be scratch registers.
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Preserved registers 

Preserved registers, on the other hand, are preserved across function calls. The called 
function may use the register for other purposes, but must save the value prior to use and 
restore it at the exit of the function.

The registers R4 to R11 are preserved registers.

If the registers R11:R10:R9:R8 are used for passing a 64-bit scalar parameter, they do 
not have to be preserved.

Note:

● When compiling for the MSP430X architecture in the Small data model, only the 
lower 16 bits of the registers are preserved, unless the __save_reg20 attribute 
is specified. It is only necessary to save and restore the upper 4 bits of you have 
an assembler routine that uses these bits

● When compiling using the options --lock_r4 or --lock_r5, the R4 and R5 
registers are not used.

Special registers

You must consider that the stack pointer register must at all times point to the last 
element on the stack or below. In the eventuality of an interrupt, which can occur at any 
time, everything below the point the stack pointer points to, will be destroyed.

FUNCTION ENTRANCE 

Parameters can be passed to a function using one of two basic methods: in registers or 
on the stack. It is much more efficient to use registers than to take a detour via memory, 
so the calling convention is designed to utilize registers as much as possible. There is 
only a limited number of registers that can be used for passing parameters; when no 
more registers are available, the remaining parameters are passed on the stack. In 
addition, the parameters are passed on the stack in the following cases:

● Structure types: struct, union, and classes
● Unnamed parameters to variable length functions; in other words, functions 

declared as foo(param1, ...), for example printf.

Note: Interrupt functions cannot take any parameters.

Hidden parameters 

In addition to the parameters visible in a function declaration and definition, there can 
be hidden parameters:

● If the function returns a structure, the memory location where to store the structure 
is passed in the register R12 as a hidden parameter.
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● If the function is a non-static C++ member function, then the this pointer is passed 
as the first parameter (but placed after the return structure pointer, if there is one). 
The reason for the requirement that the member function must be non-static is that 
static member methods do not have a this pointer.

Register parameters 

The following registers are available for passing parameters:

Note: When compiling for the MSP430X architecture which supports 20-bit registers, 
it is assumed that the upper four bits of all parameter registers are zero (0), with 
exception for registers used for passing 8-bit values.

The assignment of registers to parameters is a straightforward process. 

For Version1, the first parameter is assigned to R12 or R13:R12, depending on the size 
of the parameter. The second parameter is passed in R14 or R15:R14. Should there be 
no more available registers, the parameter is passed on the stack.

For Version2, the first parameter is assigned the first free register, starting from R12.

Parameters Passed in registers, Version1 Passed in registers, Version2

8-bit values R12, R14 R12 to R15

16-bit values R12, R14 R12 to R15

20-bit values R12, R14 R12 to R15

32-bit values (R13:R12), (R15:R14) (R13:R12), (R15:R14)

64-bit values (R15:R14:R13:R12), 
(R11:R10:R9:R8)

(R15:R14:R13:R12), 
(R11:R10:R9:R8)

Table 23: Registers used for passing parameters 
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Stack parameters and layout 

Stack parameters are stored in the main memory starting at the location pointed to by 
the stack pointer. Below the stack pointer (towards low memory) there is free space that 
the called function can use. The first stack parameter is stored at the location pointed to 
by the stack pointer. The next one is stored at the next even location on the stack. It is 
the responsibility of the caller to remove the parameters from the stack by restoring the 
stack pointer.

Figure 4: Stack image after the function call

Note: The number of bytes reserved for the return address depends on the --core 
option, see Calling functions, page 97.

FUNCTION EXIT 

A function can return a value to the function or program that called it, or it can have the 
return type void.

The return value of a function, if any, can be scalar (such as integers and pointers), 
floating-point, or a structure. 

Note: An interrupt function must have the return type void.

A function returns by performing any of the following instructions:

● RET instruction, when compiling for the MSP430 architecture
● RETA, when compiling for the MSP430X architecture
● RETI, for interrupt functions regardless of which architecture is being used.
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Registers used for returning values

The registers available for returning values are:

Stack layout

It is the responsibility of the caller to clean the stack after the called function has 
returned.

Return value pointer

If a structure is returned, the caller passes a pointer to a location where the called 
function should write the result. The pointer should be passed in the register R12. 

The called function must return the pointer in the register R12.

EXAMPLES

The following section shows a series of declaration examples and the corresponding 
calling conventions. The complexity of the examples increases towards the end.

Example 1

Assume that we have the following function declaration:

int add1(int);

This function takes one parameter in the register R12, and the return value is passed back 
to its caller in the register R12.

The following assembler routine is compatible with the declaration; it will return a value 
that is one number higher than the value of its parameter:

ADD.W #1,R12
RETA ; For the MSP430X architecture

Return values Passed in registers

8-bit values R12

16-bit values R12

32-bit values R13:R12

64-bit values R15:R14:R13:R12

Table 24: Registers used for returning values 
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Example 2

This example shows how structures are passed on the stack. Assume that we have the 
following declarations:

struct a_struct { int a; };
int a_function(struct a_struct x, int y);

The calling function must reserve 4 bytes on the top of the stack and copy the contents 
of the struct to that location. The integer parameter y is passed in the register R12. The 
return value is passed back to its caller in the register R12.

Example 3

The function below will return a struct.

struct a_struct { int a; };
struct a_struct  a_function(int x);

It is the responsibility of the calling function to allocate a memory location—typically 
on the stack—for the return value and pass a pointer to it as a hidden first parameter. The 
pointer to the location where the return value should be stored is passed in R12. The 
caller assumes that this register remains untouched. The parameter x is passed in R14.

Assume that the function instead would have been declared to return a pointer to the 
structure:

struct a_struct *  a_function(int x);

In this case, the return value is a pointer, so there is no hidden parameter. The parameter 
x is passed in R12 and the return value is also returned in R12.

FUNCTION DIRECTIVES

Note: This type of directive is primarily intended to support static overlay, a feature 
which is useful in some smaller microcontrollers. The MSP430 IAR C/C++ Compiler 
does not use static overlay, because it has no use for it.

The function directives FUNCTION, ARGFRAME, LOCFRAME, and FUNCALL are generated 
by the MSP430 IAR C/C++ Compiler to pass information about functions and function 
calls to the IAR XLINK Linker. These directives can be seen if you use the compiler 
option Assembler file (-lA) to create an assembler list file.

For reference information about the function directives, see the MSP430 IAR Assembler 
Reference Guide.
C430-7

MSP430 IAR C/C++ Compiler
Reference Guide



Assembler language interface
Calling functions
When calling an assembler module from C modules, it is important to match the calling 
convention which is different depending on the --core option. 

When C modules are compiled with the --core=430 option, they use the CALL 
instruction to call an external function, and with --core=430X they use the CALLA 
instruction. These two call instructions have different stack layouts. The CALL 
instruction pushes a 2-byte return address on the stack whereas CALLA pushes 4 bytes. 
This must be matched in your assembler routine by using the corresponding RET and 
RETA return instructions, or the function will not return properly which leads to a corrupt 
stack. 

Note: Interrupt functions written in assembler are not affected, because all interrupt 
routines must return using the RETI instruction, regardless of which architecture that 
you are using.

Because the calling convention differs slightly between the two architectures, you can 
define the runtime attribute __core in all your assembler routines, to avoid 
inconsistency. Use one of the following lines:

RTMODEL "__core"="430"
RTMODEL "__core"="430X"

Using this module consistency check, the linker will produce an error if there is a 
mismatch between the values.

For more information about checking module consistency, see Checking module 
consistency, page 71.

Call frame information
When debugging an application using C-SPY, it is possible to view the call stack, that 
is, the chain of functions that have called the current function. The compiler makes this 
possible by supplying debug information that describes the layout of the call frame, in 
particular information about where the return address is stored.

If you want the call stack to be available when debugging a routine written in assembler 
language, you must supply equivalent debug information in your assembler source using 
the assembler directive CFI. This directive is described in detail in the MSP430 IAR 
Assembler Reference Guide.

The CFI directives will provide C-SPY with information about the state of the calling 
function(s). Most important of this is the return address, and the value of the stack 
pointer at the entry of the function or assembler routine. Given this information, C-SPY 
can reconstruct the state for the calling function, and thereby unwind the stack. 
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A full description about the calling convention may require extensive call frame 
information. In many cases, a more limited approach will suffice.

When describing the call frame information, the following three components must be 
present:

● A names block describing the available resources to be tracked

● A common block corresponding to the calling convention

● A data block describing the changes that are performed on the call frame. This 
typically includes information about when the stack pointer is changed, and when 
permanent registers are stored or restored on the stack.

The following table lists all the resources defined in the names block used by the 
compiler:

Example

The following is an example of an assembler routine that stores a permanent register as 
well as the return register to the stack when compiling for the MSP430 architecture:

#include "cfi.m43"

        XCFI_NAMES myNames
        XCFI_COMMON myCommon, myNames
        MODULE  cfiexample
        PUBLIC  cfiexample

        RSEG    CODE:CODE:NOROOT(1)
        CFI     Block myBlock Using myCommon
        CFI     Function 'cfiexample'

        // The common block does not declare the scratch
        // registers as undefined.
        CFI     R12 Undefined

Resource Description

CFA The call frames of the stack

R4–R15 Normal registers

R4L–R15L Lower 16 bits, when compiling for the MSP430X architecture

R4H–R15H Higher 4 bits, when compiling for the MSP430X architecture

SP The stack pointer

SR The processor state register

PC The program counter

Table 25: Call frame information resources defined in a names block 
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cfiexample:
        PUSH    R11
        CFI     R11 Frame(CFA, -4)
        CFI     CFA SP+4

        // Do something useless just to demonstrate that the call
        // stack window works properly. You can check this by
        // single-stepping in the Disassembly window and
        // double-clicking on the parent function in the
        // Call Stack window.
        MOV     #0, R11
        POP     R11
        CFI     R11 SameValue
        CFI     CFA SP+2

        // Do something else.
        MOV     #0, R12
        RET
        CFI     ENDBLOCK myBlock

        ENDMOD

        END
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IAR Systems supports two levels of the C++ language: The industry-standard 
Embedded C++ and IAR Extended Embedded C++. They are described in this 
chapter.

Overview 
Embedded C++ is a subset of the C++ programming language which is intended for 
embedded systems programming. It was defined by an industry consortium, the 
Embedded C++ Technical Committee. Performance and portability are particularly 
important in embedded systems development, which was considered when defining the 
language.

STANDARD EMBEDDED C++

The following C++ features are supported:

● Classes, which are user-defined types that incorporate both data structure and 
behavior; the essential feature of inheritance allows data structure and behavior to 
be shared among classes

● Polymorphism, which means that an operation can behave differently on different 
classes, is provided by virtual functions

● Overloading of operators and function names, which allows several operators or 
functions with the same name, provided that there is a sufficient difference in their 
argument lists

● Type-safe memory management using the operators new and delete

● Inline functions, which are indicated as particularly suitable for inline expansion.

C++ features which have been excluded are those that introduce overhead in execution 
time or code size that are beyond the control of the programmer. Also excluded are 
recent additions to the ISO/ANSI C++ standard. This is because they represent potential 
portability problems, due to the fact that few development tools support the standard. 
Embedded C++ thus offers a subset of C++ which is efficient and fully supported by 
existing development tools.

Standard Embedded C++ lacks the following features of C++:

● Templates 

● Multiple and virtual inheritance 

● Exception handling 
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● Runtime type information 

● New cast syntax (the operators dynamic_cast, static_cast, 
reinterpret_cast, and const_cast)

● Namespaces

● The mutable attribute.

The exclusion of these language features makes the runtime library significantly more 
efficient. The Embedded C++ library furthermore differs from the full C++ library in 
that:

● The standard template library (STL) is excluded

● Streams, strings, and complex numbers are supported without the use of templates

● Library features which relate to exception handling and runtime type information 
(the headers except, stdexcept, and typeinfo) are excluded.

Note: The library is not in the std namespace, because Embedded C++ does not 
support namespaces.

EXTENDED EMBEDDED C++

IAR Systems’ Extended EC++ is a slightly larger subset of C++ which adds the 
following features to the standard EC++:

● Full template support

● Namespace support

● The mutable attribute

● The cast operators static_cast, const_cast, and reinterpret_cast.

All these added features conform to the C++ standard.

To support Extended EC++, this product includes a version of the standard template 
library (STL), in other words, the C++ standard chapters utilities, containers, iterators, 
algorithms, and some numerics. This STL has been tailored for use with the Extended 
EC++ language, which means that there are no exceptions, no multiple inheritance, and 
no support for runtime type information (rtti). Moreover, the library is not in the std 
namespace.

Note: A module compiled with Extended EC++ enabled is fully link-compatible with 
a module compiled without Extended EC++ enabled.

ENABLING C++ SUPPORT

In the MSP430 IAR C/C++ Compiler, the default language is C. To be able to compile 
files written in Embedded C++, you must use the --ec++ compiler option. See --ec++, 
page 151. You must also use the IAR DLIB runtime library.
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To take advantage of Extended Embedded C++ features in your source code, you must 
use the --eec++ compiler option. See --eec++, page 151.

To set the equivalent option in the IAR Embedded Workbench IDE, select 
Project>Options>C/C++ Compiler>Language.

Feature descriptions
When writing C++ source code for the IAR C/C++ Compiler, there are some benefits 
and some possible quirks that you need to be aware of when mixing C++ features—such 
as classes, and class members—with IAR language extensions, such as IAR-specific 
attributes.

CLASSES

A class type class and struct in C++ can have static and non-static data members, 
and static and non-static function members. The non-static function members can be 
further divided into virtual function members, non-virtual function members, 
constructors, and destructors. For the static data members, static function members, and 
non-static non-virtual function members the same rules apply as for statically linked 
symbols outside of a class. In other words, they can have any applicable IAR-specific 
type, memory, and object attribute.

The non-static virtual function members can have any applicable IAR-specific type, 
memory, and object attribute as long as a pointer to the member function can be 
implicitly converted to the default function pointer type. The constructors, destructors, 
and non-static data members cannot have any IAR attributes.

For further information about attributes, see Type qualifiers, page 176.

Example

class A {
  public:
   static __data16 __no_init int i @ 60; //Located in data16 at
                                         //address 60
};

The this pointer

The this pointer used for referring to a class object or calling a member function of a 
class object will by default have the data memory attribute for the default data pointer 
type. This means that such a class object can only be defined to reside in memory from 
which pointers can be implicitly converted to a default data pointer. This restriction may 
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also apply to objects residing on a stack, for example temporary objects and auto 
objects.

Example

class B {
  public:
    void f();
    int i;
};

Class memory

To compensate for this limitation, a class can be associated with a class memory type. 
The class memory type changes:

● the this pointer type in all member functions, constructors, and destructors into a 
pointer to class memory

● the default memory for static storage duration variables—that is, not auto 
variables—of the class type, into the specified class memory

● the pointer type used for pointing to objects of the class type, into a pointer to class 
memory.

Example

class __data20 C {
  public:
    void f();       // Has a this pointer of type C __data20 *
    void f() const; // Has a this pointer of type
                    // C __data20 const *
    C();            // Has a this pointer pointing into data20
                    // memory
    C(C const &);   // Takes a parameter of type C __data20
                    // const &
                    // (also true of generated copy constructor)
    int i;
};
C Ca;               // Resides in data20 memory instead of the
                    // default memory
C __data16 Cb;      // Resides in data16 memory, the 'this'
                    // pointer still points into data20 memory
void h()
{
  C Cd;             // Resides on the stack
}
C * Cp1;            // Creates a pointer to data20 memory
C __data16 * Cp2;     // Creates a pointer to data16 memory
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Note: Whenever a class type associated with a class memory type, like C, must be 
declared, the class memory type must be mentioned as well:

class __data20 C;

Also note that class types associated with different class memories are not compatible 
types.

There is a built-in operator that returns the class memory type associated with a class, 
__memory_of(class). For instance, __memory_of(C) returns __data20.

When inheriting, the rule is that it must be possible to convert implicitly a pointer to a 
subclass into a pointer to its base class. This means that a subclass can have a more 
restrictive class memory than its base class, but not a less restrictive class memory.

class __data20 D : public C { // OK, same class memory
  public:
    void g();
    int j;
};

class __data16 E : public C { // OK, data16 memory is inside
                               // data20
  public:
    void g()  // Has a this pointer pointing into data16 memory
    {
      f();    // Gets a this pointer into data20 memory
    }
    int j;
};

class G : public C { // OK, will be associated with same class
                     // memory as C
  public:
    void g();
    int j;
};
// A class with data16 as class memory
class __data16 H
{
public:
  void f();  // Has a this pointer of type H __data16 *
};

// Not OK, data20 memory is not inside data16 memory
{
class __data20 I : public H
  void g();
};
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A new expression on the class will allocate memory in the heap residing in the class 
memory. A delete expression will naturally deallocate the memory back to the same 
heap. To override the default new and delete operator for a class, declare

void *operator new(size_t);
void operator delete(void *);

as member functions, just like in ordinary C++.

For more information about memory types, see Memory types (MSP430X only), page 
15.

FUNCTIONS

A function with extern "C" linkage is compatible with a function that has C++ linkage.

Example

extern "C" {
  typedef void (*fpC)(void); // A C function typedef
};
void (*fpCpp)(void);         // A C++ function typedef

fpC f1;
fpCpp f2;
void f(fpC);

f(f1);                       // Always works
f(f2);                       // fpCpp is compatible with fpC

NEW AND DELETE OPERATORS

There are operators for new and delete for each memory that can have a heap, that is, 
data20 and data16 memory.

These examples assume that there is a heap in both data20 and data16 memory.

void __data16 * operator new __data16(__data16_size_t);
void __data20  * operator new __data20 (__data20_size_t);
void operator delete(void __data16 *);
void operator delete(void __data20  *);

And correspondingly for array new and delete operators:

void __data16 * operator new[] __data16(__data16_size_t);
void __data20  * operator new[] __data20 (__data20_size_t);
void operator delete[](void __data16 *);
void operator delete[](void __data20  *);
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Use this syntax if you want to override both global and class-specific operator new 
and operator delete for any data memory.

Note that there is a special syntax to name the operator new functions for each 
memory, while the naming for the operator delete functions relies on normal 
overloading.

New and delete expressions

A new expression calls the operator new function for the memory of the type given. If 
a class, struct, or union type with a class memory is used, the class memory will 
determine the operator new function called. For example,

//Calls operator new __data16(__data16_size_t)
int __data16 *p = new __data16 int;

//Calls operator new __data16(__data16_size_t)
int __data16 *q = new int __data16;

//Calls operator new[] __data16(__data16_size_t)
int __data16 *r = new __data16 int[10];

//Calls operator new __data20(__data20_size_t)
class __data20 S{...};
S *s = new S;

A delete expression calls the operator delete function that corresponds to the 
argument given. For example,

delete p; //Calls operator delete(void __data16 *)
delete s; //Calls operator delete(void __data20  *)

Note that the pointer used in a delete expression must have the correct type, that is, the 
same type as that returned by the new expression. If you use a pointer to the wrong 
memory, the result might be a corrupt heap. For example,

int __data16 * t = new __data20 int;
delete t; //Error: Causes a corrupt heap

TEMPLATES 

Extended EC++ supports templates according to the C++ standard, except for the 
support of the export keyword. The implementation uses a two-phase lookup which 
means that the keyword typename has to be inserted wherever needed. Furthermore, at 
each use of a template, the definitions of all possible templates must be visible. This 
means that the definitions of all templates have to be in include files or in the actual 
source file.
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Templates and data memory attributes

For data memory attributes to work as expected in templates, two elements of the 
standard C++ template handling have been changed—class template partial 
specialization matching and function template parameter deduction. 

In Extended Embedded C++, the class template partial specialization matching 
algorithm works like this:

When a pointer or reference type is matched against a pointer or reference to a template 
parameter type, the template parameter type will be the type pointed to, stripped of any 
data memory attributes, if the resulting pointer or reference type is the same.

Example

// We assume that data20 is the memory type of the default 
pointer.
template<typename> class Z;
template<typename T> class Z<T *>;

Z<int __data16 *> zn;    // T = int __data16
Z<int __data20  *> zf;   // T = int

In Extended Embedded C++, the function template parameter deduction algorithm 
works like this: 

When function template matching is performed and an argument is used for the 
deduction; if that argument is a pointer to a memory that can be implicitly converted to 
a default pointer, do the parameter deduction as if it was a default pointer.

When an argument is matched against a reference, do the deduction as if the argument 
and the parameter were both pointers.

Example

template<typename T> void fun(T *);

fun((int __data16 *) 0);  // T = int. The result is different
                          // than the analogous situation with
                          // class template specializations.
fun((int        *) 0);    // T = int
fun((int __data20  *) 0); // T = int

For templates that are matched using this modified algorithm, it is impossible to get 
automatic generation of special code for pointers to small memory types. For large and 
“other” memory types (memory that cannot be pointed to by a default pointer) it is 
possible. In order to make it possible to write templates that are fully 
memory-aware—in the rare cases where this is useful—use the 
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#pragma basic_template_matching directive in front of the template function 
declaration. That template function will then match without the modifications described 
above.

Example

#pragma basic_template_matching
template<typename T> void fun(T *);

fun((int __data16 *) 0); // T = int __data16

Non-type template parameters

It is allowed to have a reference to a memory type as a template parameter, even if 
pointers to that memory type are not allowed.

Example

#include <intrinsics.h>

__no_init int __regvar x @ __R4;

template<__regvar int &y>
void foo() 
{ 
  y = 17; 
}

void bar() 
{
  foo<x>();
}

Note: This example must be compiled with the --regvar_r4 compiler option.

The standard template library 

The STL (standard template library) delivered with the product is tailored for Extended 
EC++, as described in Extended Embedded C++, page 102.

The containers in the STL, like vector and map, are memory attribute aware. This 
means that a container can be declared to reside in a specific memory type which has the 
following consequences:

● The container itself will reside in the chosen memory

● Allocations of elements in the container will use a heap for the chosen memory

● All references inside it use pointers to the chosen memory.
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Example

vector<int> d;               // d placed in default memory, using
                             // the default heap, uses default
                             // pointers
vector<int __data16> __data16 x; // x placed in data16 memory,
                             // heap allocation from data16, uses
                             // pointers to data16 memory
vector<int __data20> __data16 y; // y placed in data16 memory,
                             // heap allocation from data20, uses
                             // pointers to data20 memory
vector<int __data16> __data20 z; // Illegal

Note that map<key, T>, multimap<key, T>, hash_map<key, T>, and 
hash_multimap<key, T> all use the memory of T. This means that the value_type 
of these collections will be pair<key, const T> mem where mem is the memory type 
of T. Supplying a key with a memory type is not useful.

Note that two containers that only differ by the data memory attribute they use cannot 
be assigned to each other.

Example

vector<int __data16> x;
vector<int __data20> y;

x = y; // Illegal
y = x; // Illegal

However, the templated assign member method will work:

x.assign(y.begin(), y.end());
y.assign(x.begin(), x.end());

STL and the IAR C-SPY® Debugger 

C-SPY has built-in display support for the STL containers. The logical structure of 
containers is presented in the watch views in a comprehensive way that is easy to 
understand and follow.

Note: To be able to watch STL containers with many elements in a comprehensive 
way, the STL container expansion option—available by choosing 
Tools>Options>Debugger—is set to display only a small number of items at first.

VARIANTS OF CASTS

In Extended EC++ the following additional C++ cast variants can be used:

  const_cast<t2>(t), static_cast<t2>(t), reinterpret_cast<t2>(t).
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MUTABLE

The mutable attribute is supported in Extended EC++. A mutable symbol can be 
changed even though the whole class object is const.

NAMESPACE 

The namespace feature is only supported in Extended EC++. This means that you can 
use namespaces to partition your code. Note, however, that the library itself is not placed 
in the std namespace.

THE STD NAMESPACE

The std namespace is not used in either standard EC++ or in Extended EC++. If you 
have code that refers to symbols in the std namespace, simply define std as nothing; 
for example:

#define std  // Nothing here

USING INTERRUPTS AND EC++ DESTRUCTORS

If interrupts are enabled and the interrupt functions use class objects that have 
destructors, there may be problems if the program exits either by using exit or by 
returning from main. If an interrupt occurs after an object has been destroyed, there is 
no guarantee that the program will work properly.

To avoid this, make sure that interrupts are disabled when returning from main or when 
calling exit or abort.

To avoid interrupts, place a call to the intrinsic function __disable_interrupt before 
the call to _exit.

C++ language extensions
When you use the compiler in C++ mode and have enabled IAR language extensions, 
the following C++ language extensions are available in the compiler:

● In a friend declaration of a class, the class keyword may be omitted, for 
example:

class B;
class A
{
  friend B;       //Possible when using IAR language
                  //extensions
  friend class B; //According to standard
};
C430-7

Part 1. Using the compiler 111



112

C++ language extensions
● Constants of a scalar type may be defined within classes, for example:

class A {
  const int size = 10;//Possible when using IAR language
                      //extensions
  int a[size];
};

According to the standard, initialized static data members should be used instead.

● In the declaration of a class member, a qualified name may be used, for example:

struct A {
  int A::f(); //Possible when using IAR language extensions
  int f();    //According to standard
};

● It is permitted to use an implicit type conversion between a pointer to a function 
with C linkage (extern "C") and a pointer to a function with C++ linkage 
(extern "C++"), for example:

extern "C" void f();//Function with C linkage
void (*pf) ()       //pf points to a function with C++ linkage
              = &f; //Implicit conversion of pointer. 

According to the standard, the pointer must be explicitly converted.

● If the second or third operands in a construction that contains the ? operator are 
string literals or wide string literals (which in C++ are constants), the operands may 
be implicitly converted to char * or wchar_t *, for example: 

char *P = x ? "abc" : "def"; //Possible when using IAR
                             //language extensions
char const *P = x ? "abc" : "def"; //According to standard

● Default arguments may be specified for function parameters not only in the 
top-level function declaration, which is according to the standard, but also in 
typedef declarations, in pointer-to-function function declarations, and in 
pointer-to-member function declarations.

● In a function that contains a non-static local variable and a class that contains a 
non-evaluated expression (for example a sizeof expression), the expression may 
reference the non-static local variable. However, a warning is issued.

Note: If you use any of these constructions without first enabling language extensions, 
errors are issued.
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For embedded systems, the size of the generated code and data is very 
important, because using smaller external memory or on-chip memory can 
significantly decrease the cost and power consumption of a system.

The topics discussed are:

● Selecting data types

● Controlling data and function placement in memory

● Controlling compiler optimizations

● Writing efficient code.

As a part of this, the chapter also demonstrates some of the more common 
mistakes and how to avoid them, and gives a catalog of good coding 
techniques.

Selecting data types
For efficient treatment of data, you should consider the data types used and the most 
efficient placement of the variables.

USING EFFICIENT DATA TYPES

The data types you use should be considered carefully, because this can have a large 
impact on code size and code speed.

● Use small data types.

● Try to avoid 64-bit data types, such as double and long long.

● Bitfields with sizes other than 1 bit should be avoided because they will result in 
inefficient code compared to bit operations.

● Using floating-point types is very inefficient, both in terms of code size and 
execution speed. If possible, consider using integer operations instead.
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● Declaring a pointer to const data tells the calling function that the data pointed to 
will not change, which opens for better optimizations.

For details about representation of supported data types, pointers, and structures types, 
see the chapter Data representation.

FLOATING-POINT TYPES

Using floating-point types on a microprocessor without a math coprocessor is very 
inefficient, both in terms of code size and execution speed. The MSP430 IAR C/C++ 
Compiler supports two floating-point formats—32 and 64 bits. The 32-bit floating-point 
type float is more efficient in terms of code size and execution speed. However, the 
64-bit format double supports higher precision and larger numbers.

In the MSP430 IAR C/C++ Compiler, the floating-point type float always uses the 
32-bit format. The format used by the double floating-point type depends on the setting 
of the double size (--double) compiler option.

Unless the application requires the extra precision that 64-bit floating-point numbers 
give, we recommend using 32-bit floats instead. Also consider replacing code using 
floating-point operations with code using integers since these are more efficient.

Note that a floating-point constant in the source code is treated as being of the type 
double. This can cause innocent-looking expressions to be evaluated in double 
precision. In the example below a is converted from a float to a double, 1 is added 
and the result is converted back to a float:

float test(float a)
{
   return a + 1.0;
}

To treat a floating-point constant as a float rather than as a double, add an f to it, for 
example:

float test(float a)
{
   return a + 1.0f;
}

REARRANGING ELEMENTS IN A STRUCTURE

The MSP430 microcontroller requires that data in memory must be aligned. Each 
element in a structure needs to be aligned according to its specified type requirements. 
This means that the compiler must insert pad bytes if the alignment is not correct. 
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There are two reasons why this can be considered a problem:

● Network communication protocols are usually specified in terms of data types with 
no padding in between

● There is a need to save data memory.

For information about alignment requirements, see Alignment, page 169.

There are two ways to solve the problem:

● Use the #pragma pack directive. This is an easy way to remove the problem with 
the drawback that each access to an unaligned element in the structure will use more 
code.

● Write your own customized functions for packing and unpacking structures. This is 
a more portable way, which will not produce any more code apart from your 
functions. The drawback is the need for two views on the structure data—packed 
and unpacked.

For further details about the #pragma pack directive, see pack, page 209.

ANONYMOUS STRUCTS AND UNIONS

When a structure or union is declared without a name, it becomes anonymous. The effect 
is that its members will only be seen in the surrounding scope.

Anonymous structures are part of the C++ language; however, they are not part of the C 
standard. In the MSP430 IAR C/C++ Compiler they can be used in C if language 
extensions are enabled.

In the IAR Embedded Workbench IDE, language extensions are enabled by default.

Use the -e compiler option to enable language extensions. See -e, page 150, for 
additional information.

Example

In the following example, the members in the anonymous union can be accessed, in 
function f, without explicitly specifying the union name:

struct s
{

char tag;
union
{

long l;
float f;

};
} st;
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void f(void)
{

st.l = 5;
}

The member names must be unique in the surrounding scope. Having an anonymous 
struct or union at file scope, as a global, external, or static variable is also allowed. 
This could for instance be used for declaring I/O registers, as in the following example:

__no_init volatile
union
{

unsigned char IOPORT;
struct
{

unsigned char way: 1;
unsigned char out: 1;

};
} @ 0x1234;

This declares an I/O register byte IOPORT at the address 0x1234. The I/O register has 2 
bits declared, way and out. Note that both the inner structure and the outer union are 
anonymous.

The following example illustrates how variables declared this way can be used:

void test(void)
{

IOPORT = 0;
way = 1;
out = 1;

}

Anonymous structures and unions are implemented in terms of objects named after the 
first field, with a prefix _A_ to place the name in the implementation part of the 
namespace. In this example, the anonymous union will be implemented through an 
object named _A_IOPORT.

Controlling data and function placement in memory
The compiler provides different mechanisms for controlling placement of functions and 
data objects in memory. To use memory efficiently, you should be familiar with these 
mechanisms to know which one is best suited for different situations. You can use:

● Data models (MSP430X only)

Use the compiler option for selecting a data model, to take advantage of the different 
addressing modes available for the microcontroller and thereby place data objects in 
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different parts of memory. To read more about data models, see Data models 
(MSP430X only), page 14.

● Memory attributes (MSP430X only)

Use memory attributes to override the default addressing mode and placement of 
individual data objects. To read more about memory attributes for data, see Using 
data memory attributes, page 16.

● The @ operator and the #pragma location directive for absolute placement

Use the @ operator or the #pragma location directive to place individual global 
and static variables at absolute addresses. The variables must be declared either 
__no_init or const. This is useful for individual data objects that must be located 
at a fixed address, for example variables with external requirements, or for 
populating any hardware tables similar to interrupt vector tables. Note that it is not 
possible to use this notation for absolute placement of individual functions.

● The @ operator and the #pragma location directive for segment placement

Use the @ operator or the #pragma location directive to place groups of functions 
or global and static variables in named segments, without having explicit control of 
each object. The variables must be declared either __no_init or const. The 
segments can, for example, be placed in specific areas of memory, or initialized or 
copied in controlled ways using the segment begin and end operators. This is also 
useful if you want an interface between separately linked units, for example an 
application project and a boot loader project. Use named segments when absolute 
control over the placement of individual variables is not needed, or not useful.

At compile time, data and functions are placed in different segments as described in 
Data segments, page 35, and Code segments, page 41, respectively. At link time, one of 
the most important functions of the linker is to assign load addresses to the various 
segments used by the application. All segments, except for the segments holding 
absolute located data, are automatically allocated to memory according to the 
specifications of memory ranges in the linker command file, as described in Placing 
segments in memory, page 32. 

DATA PLACEMENT AT AN ABSOLUTE LOCATION

The @ operator, alternatively the #pragma location directive, can be used for placing 
global and static variables at absolute addresses. The variables must be declared 
__no_init and/or const. If declared const, they must have an initializer unless they 
are declared __no_init. To place a variable at an absolute address, the argument to the 
@ operator and the #pragma location directive should be a literal number, 
representing the actual address. The absolute location must fulfill the alignment 
requirement for the variable that should be located.

C++ static member variables can be placed at an absolute address just like any other 
static variable.
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Note: A variable placed in an absolute location should be defined in an include file, to 
be included in every module that uses the variable. An unused definition in a module 
will be ignored. A normal extern declaration—one that does not use an absolute 
placement directive—can refer to a variable at an absolute address; however, 
optimizations based on the knowledge of the absolute address cannot be performed.

Declaring located variables extern and volatile 

In C++, const variables are static (module local), which means that each module that 
declares a certain const variable will contain a separate variable with this name. If you 
link an application with several such modules all containing (via a header file), for 
instance, the declaration:

volatile const __no_init int x @ 0x100;        /* Bad in C++ */

the linker will report that there are more than one variable located at address 0x100.

To avoid this problem and make the process the same in C and C++, you should declare 
these SFRs extern, for example:

extern volatile const __no_init int x @ 0x100;  /* the extern
                                     /* keyword makes x public */

For information about volatile declared objects, see Protecting simultaneously 
accessed variables, page 126.

Examples

In this example, a __no_init declared variable is placed at an absolute address. This 
is useful for interfacing between multiple processes, applications, etc:

__no_init volatile char alpha @ 0x0200;/* OK */

In the following examples, there are two const declared objects, where the first is not 
initialized, and the second is initialized to a specific value. Both objects are placed in 
ROM. This is useful for configuration parameters, which are accessible from an external 
interface. Note that in the second case, the compiler is not obliged to actually read from 
the variable, because the value is known.

#pragma location=0x0202
__no_init const int beta; /* OK */

const int gamma @ 0x0204 = 3; /* OK */
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In the first case, the value is not initialized by the compiler; the value must be set by other 
means. The typical use is for configurations where the values are loaded to ROM 
separately, or for special function registers that are read-only.

The following examples show incorrect usage:

int delta @ 0x0206; /* Error, neither */
                               /* "__no_init" nor "const".*/

__no_init int epsilon @ 0x0207; /* Error, misaligned. */

DATA AND FUNCTION PLACEMENT IN SEGMENTS

The @ operator, alternatively the #pragma location directive, can be used for placing 
individual variables or individual functions in named segments. The named segment can 
either be a predefined segment, or a user-defined segment. The variables must be 
declared either __no_init or const. If declared const, they can have initializers.

C++ static member variables can be placed in named segments just like any other static 
variable.

If you use your own segments, in addition to the predefined segments, the segments 
must also be defined in the linker command file using the -Z or the -P segment control 
directives.

Note: Take care when explicitly placing a variable or function in a predefined segment 
other than the one used by default. This is useful in some situations, but incorrect 
placement can result in anything from error messages during compilation and linking to 
a malfunctioning application. Carefully consider the circumstances; there might be strict 
requirements on the declaration and use of the function or variable.

For more information about segments, see the chapter Segment reference.

Examples of placing variables in named segments

In the following three examples, a data object is placed in a user-defined segment. The 
segment will be allocated in default memory depending on the used data model.

__no_init int alpha @ "NOINIT"; /* OK */

#pragma location="CONSTANTS"
const int beta; /* OK */

const int gamma @ "CONSTANTS" = 3; /* OK */

To override the default segment allocation, you can explicitly specify a memory attribute 
other than the default:

__data20 __no_init int alpha @ "NOINIT";/* Placed in data20*/
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The following example shows incorrect usage:

int delta @ "NOINIT"; /* Error, neither */
/* "__no_init" nor "const" */

Examples of placing functions in named segments

void f(void) @ "FUNCTIONS";

void g(void) @ "FUNCTIONS"
{
}

#pragma location="FUNCTIONS"
void h(void);

To override the default segment allocation, you can explicitly specify a memory attribute 
other than the default:

__data20 void f(void) @ "FUNCTIONS";

Controlling compiler optimizations
The compiler performs many transformations on your application in order to generate 
the best possible code. Examples of such transformations are storing values in registers 
instead of memory, removing superfluous code, reordering computations in a more 
efficient order, and replacing arithmetic operations by cheaper operations.

The linker should also be considered an integral part of the compilation system, because 
there are some optimizations that are performed by the linker. For instance, all unused 
functions and variables are removed and not included in the final output.

SCOPE FOR PERFORMED OPTIMIZATIONS

You can decide whether optimizations should be performed on your whole application 
or on individual files. By default, the same types of optimizations are used for an entire 
project, but you should consider using different optimization settings for individual files. 
For example, put code that must execute very quickly into a separate file and compile it 
for minimal execution time, and the rest of the code for minimal code size. This will give 
a small program, which is still fast enough where it matters.

In addition, you can exclude individual functions from the performed optimizations. The 
#pragma optimize directive allows you to either lower the optimization level, or 
specify another type of optimization to be performed. Refer to optimize, page 208, for 
information about the pragma directive.
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OPTIMIZATION LEVELS

The MSP430 IAR C/C++ Compiler supports different levels of optimizations. The 
following table lists the optimizations that are performed on each level:

Note: Some of the performed optimizations can be individually enabled or disabled. 
For more information about these, see Fine-tuning enabled transformations, page 122.

A high level of optimization might result in increased compile time, and will most likely 
also make debugging more difficult, because it will be less clear how the generated code 
relates to the source code. For example, at the low, medium, and high optimization 
levels, variables do not live through their entire scope, which means processor registers 
used for storing variables can be reused immediately after they were last used. Due to 
this, the C-SPY Watch window might not be able to display the value of the variable 
throughout its scope. At any time, if you experience difficulties when debugging your 
code, try lowering the optimization level.

SPEED VERSUS SIZE

At the high optimization level, the compiler balances between size and speed 
optimizations. However, it is possible to fine-tune the optimizations explicitly for either 
size or speed. They only differ in what thresholds that are used; speed will trade size for 

Optimization level Description

None (Best debug support) Dead code elimination
Redundant label elimination
Redundant branch elimination

Note: Variables live through their entire scope

Low Same as above but variables only live for as long as they are 
needed, not necessarily through their entire scope

Medium Same as above
Live-dead analysis and optimization
Code hoisting
Register content analysis and optimization
Common subexpression elimination

High (Maximum optimization) Same as above
Peephole optimization
Cross jumping
Cross call
Loop unrolling
Function inlining
Code motion
Type-based alias analysis

Table 26: Compiler optimization levels 
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speed, whereas size will trade speed for size. Note that one optimization sometimes 
enables other optimizations to be performed, and an application may in some cases 
become smaller even when optimizing for speed rather than size.

FINE-TUNING ENABLED TRANSFORMATIONS

At each optimization level you can disable some of the transformations individually. To 
disable a transformation, use either the appropriate option, for instance the command 
line option --no_inline, alternatively its equivalent in the IAR Embedded Workbench 
IDE Function inlining, or the #pragma optimize directive. The following 
transformations can be disabled: 

● Common subexpression elimination

● Loop unrolling

● Function inlining

● Code motion

● Type-based alias analysis.

Common subexpression elimination   

Redundant re-evaluation of common subexpressions is by default eliminated at 
optimization levels Medium and High. This optimization normally reduces both code 
size and execution time. However, the resulting code might be difficult to debug.

Note: This option has no effect at optimization levels None and Low.

To read more about the command line option, see --no_cse, page 157.

Loop unrolling   

It is possible to duplicate the loop body of a small loop, whose number of iterations can 
be determined at compile time, to reduce the loop overhead.

This optimization, which can be performed at optimization level High, normally 
reduces execution time, but increases code size. The resulting code might also be 
difficult to debug.

The compiler heuristically decides which loops to unroll. Different heuristics are used 
when optimizing for speed, size, or when balancing between size and speed.

Note: This option has no effect at optimization levels None, Low, and Medium.

To read more about the command line option, see --no_unroll, page 159.
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Function inlining 

Function inlining means that a simple function, whose definition is known at compile 
time, is integrated into the body of its caller to eliminate the overhead of the call. This 
optimization, which is performed at optimization level High, normally reduces 
execution time, but increases code size. The resulting code might also be difficult to 
debug.

The compiler decides which functions to inline. Different heuristics are used when 
optimizing for speed, size, or when balancing between size and speed.

Note: This option has no effect at optimization levels None, Low, and Medium.

To read more about the command line option, see --no_inline, page 157.

Code motion 

Evaluation of loop-invariant expressions and common subexpressions are moved to 
avoid redundant re-evaluation. This optimization, which is performed at optimization 
level High, normally reduces code size and execution time. The resulting code might 
however be difficult to debug.

Note: This option has no effect at optimization levels None, and Low.

Type-based alias analysis 

When two or more pointers reference the same memory location, these pointers are said 
to be aliases for each other. The existence of aliases makes optimization more difficult 
because it is not necessarily known at compile time whether a particular value is being 
changed.

Type-based alias analysis optimization assumes that all accesses to an object will take 
place using its declared type or as a char type. This assumption lets the compiler detect 
whether pointers may reference the same memory location or not. 

Type-based alias analysis is performed at optimization level High. For ISO/ANSI 
standard-conforming C or C++ application code, this optimization can reduce code size 
and execution time. However, non-standard-conforming C or C++ code might result in 
the compiler producing code that leads to unexpected behavior. Therefore, it is possible 
to turn this optimization off.

Note: This option has no effect at optimization levels None, Low, and Medium.

To read more about the command line option, see --no_tbaa, page 158.

Example

short f(short * p1, long * p2)
{
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  *p2 = 0;
  *p1 = 1;
  return *p2;
}

With type-based alias analysis, it is assumed that a write access to the short pointed to 
by p1 cannot affect the long value that p2 points to. Thus, it is known at compile time 
that this function returns 0. However, in non-standard-conforming C or C++ code these 
pointers could overlap each other by being part of the same union. By using explicit 
casts, you can also force pointers of different pointer types to point to the same memory 
location.

Writing efficient code
This section contains general programming hints on how to implement functions to 
make your applications robust, but at the same time facilitate compiler optimizations.

The following is a list of programming techniques that will, when followed, enable the 
compiler to better optimize the application.

● Local variables—auto variables and parameters—are preferred over static or global 
variables. The reason is that the optimizer must assume, for example, that called 
functions may modify non-local variables. When the life spans for local variables 
end, the previously occupied memory can then be reused. Globally declared 
variables will occupy data memory during the whole program execution.

● Avoid taking the address of local variables using the & operator. There are two main 
reasons why this is inefficient. First, the variable must be placed in memory, and 
thus cannot be placed in a processor register. This results in larger and slower code. 
Second, the optimizer can no longer assume that the local variable is unaffected 
over function calls.

● Module-local variables—variables that are declared static—are preferred over 
global variables. Also avoid taking the address of frequently accessed static 
variables.

● The compiler is capable of inlining functions. This means that instead of calling a 
function, the compiler inserts the content of the function at the location where the 
function was called. The result is a faster, but often larger, application. Also, 
inlining may enable further optimizations. The compiler often inlines small 
functions declared static. The use of the #pragma inline directive and the C++ 
keyword inline gives you fine-grained control, and it is the preferred method 
compared to the traditional way of using preprocessor macros. This feature can be 
disabled using the --no_inline command line option; see --no_inline, page 157.
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● Avoid using inline assembler. Instead, try writing the code in C or C++, use intrinsic 
functions, or write a separate module in assembler language. For more details, see 
Mixing C and assembler, page 83.

SAVING STACK SPACE AND RAM MEMORY

The following is a list of programming techniques that will, when followed, save 
memory and stack space:

● If stack space is limited, avoid long call chains and recursive functions.

● Avoid using large non-scalar types, such as structures, as parameters or return type; 
in order to save stack space, you should instead pass them as pointers or, in C++, as 
references.

● Use the --reduced_stack_space option. This will eliminate holes in the stack 
resulting from normal optimizations.

FUNCTION PROTOTYPES

It is possible to declare and define functions using one of two different styles:

● Prototyped

● Kernighan & Ritchie C (K&R C)

Both styles are included in the C standard; however, it is recommended to use the 
prototyped style, since it makes it easier for the compiler to find problems in the code. 
In addition, using the prototyped style will make it possible to generate more efficient 
code, since type promotion (implicit casting) is not needed. The K&R style is only 
supported for compatibility reasons.

To make the compiler verify that all functions have proper prototypes, use the compiler 
option Require prototypes (--require_prototypes).

Prototyped style

In prototyped function declarations, the type for each parameter must be specified.

int test(char, int); /* declaration */
int test(char a, int b) /* definition */
{
  .....
}

Kernighan & Ritchie style

In K&R style—traditional pre-ISO/ANSI C—it is not possible to declare a function 
prototyped. Instead, an empty parameter list is used in the function declaration. Also, 
the definition looks different.
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int test(); /* old declaration */
int test(a,b) /* old definition */
char a;
int b;
{
  .....
}

INTEGER TYPES AND BIT NEGATION

There are situations when the rules for integer types and their conversion lead to 
possibly confusing behavior. Things to look out for are assignments or conditionals (test 
expressions) involving types with different size and logical operations, especially bit 
negation. Here, types also includes types of constants.

In some cases there may be warnings (for example, constant conditional or pointless 
comparison), in others just a different result than what is expected. Under certain 
circumstances the compiler might warn only at higher optimizations, for example, if the 
compiler relies on optimizations to identify some instances of constant conditionals. In 
the following example an 8-bit character, a 16-bit integer, and two’s complement is 
assumed:

void f1(unsigned char c1)
{
  if  (c1 == ~0x80)
  ;
}

Here, the test is always false. On the right hand side, 0x80 is 0x0080, and ~0x0080 
becomes 0xFF7F. On the left hand side, c1 is an 8-bit unsigned character, so it cannot 
be larger than 255. It also cannot be negative, which means that the integral promoted 
value can never have the topmost 8 bits set.

PROTECTING SIMULTANEOUSLY ACCESSED VARIABLES

Variables that are accessed asynchronously, for example by interrupt routines or by code 
executing in separate threads, must be properly marked and have adequate protection. 
The only exception to this is a variable that is always read-only.

To mark a variable properly, use the volatile keyword. This informs the compiler, 
among other things, that the variable can be changed from other threads. The compiler 
will then avoid optimizing on the variable (for example, keeping track of the variable in 
registers), will not delay writes to it, and be careful accessing the variable only the 
number of times given in the source code. To read more about the volatile type 
qualifier, see Declaring objects volatile, page 176.
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A sequence that accesses a volatile declared variable must also not be interrupted. 
This can be achieved by using the __monitor keyword in interruptible code. This must 
be done for both write and read sequences, otherwise you might end up reading a 
partially updated variable. This is true for all variables of all sizes. Accessing a 
small-sized variable can be an atomic operation, but this is not guaranteed and you 
should not rely on it unless you continuously study the compiler output. It is safer to use 
the __monitor keyword to ensure that the sequence is an atomic operation.

Protecting the eeprom write mechanism

A typical example of when it can be necessary to use the __monitor keyword is when 
protecting the eeprom write mechanism, which can be used from two threads (for 
example, main code and interrupts).

ACCESSING SPECIAL FUNCTION REGISTERS

Specific header files for a number of MSP430 devices are included in the MSP430 IAR 
C/C++ product installation. The header files are named iodevice.h and define the 
processor-specific special function registers (SFRs). 

Note: Assembler files must use the header files called mspdevice.h. 

The header file contains definitions that include bitfields, so individual bits can be 
accessed. The following example is from io430x14x.h:

/* Watchdog Timer Control */
__no_init volatile union
{
  unsigned short WDTCTL;
  struct
  {
    unsigned short WDTIS0        : 1;
    unsigned short WDTIS1        : 1;
    unsigned short WDTSSEL       : 1;
    unsigned short WDTCNTCL      : 1;
    unsigned short WDTTMSEL      : 1;
    unsigned short WDTNMI        : 1;
    unsigned short WDTNMIES      : 1;
    unsigned short WDTHOLD       : 1;
    unsigned short               : 8;
  } WDTCTL_bit;
} @ 0x0120;

enum {
  WDTIS0        = 0x0001,
  WDTIS1        = 0x0002,
  WDTSSEL       = 0x0004,
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  WDTCNTCL      = 0x0008,
  WDTTMSEL      = 0x0010,
  WDTNMI        = 0x0020,
  WDTNMIES      = 0x0040,
  WDTHOLD       = 0x0080
};

#define WDTPW               (0x5A00)

By including the appropriate include file in your source code, you make it possible to 
access either the object or any individual bit (or bitfields) from C code as follows:

/* Object access */
WDTCTL = 0x1234;

/* Bitfield accesses */
WDTCTL_bit.WDTSSEL  = 1;

If more than one bit must be written to a memory-mapped peripheral unit at the same 
time, for instance to stop the watchdog timer, the defined bit constants can be used 
instead, for example:

  WDTCTL = WDTPW + WDTHOLD;             /* Stop watchdog timer */

You can also use the header files as templates when you create new header files for other 
MSP430 devices. For details about the @ operator, see Located data, page 40.

NON-INITIALIZED VARIABLES

Normally, the runtime environment will initialize all global and static variables when the 
application is started.

The compiler supports the declaration of variables that will not be initialized, using the 
__no_init type modifier. They can be specified either as a keyword or using the 
#pragma object_attribute directive. The compiler places such variables in 
separate segment, according to the specified memory keyword. See the chapter Placing 
code and data for more information.

For __no_init, the const keyword implies that an object is read-only, rather than that 
the object is stored in read-only memory. It is not possible to give a __no_init object 
an initial value. 

Variables declared using the __no_init keyword could, for example, be large input 
buffers or mapped to special RAM that keeps its content even when the application is 
turned off.

For information about the __no_init keyword, see page 196. Note that to use this 
keyword, language extensions must be enabled; see -e, page 150. For information about 
the #pragma object_attribute, see page 208.
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EFFICIENT SWITCH STATEMENTS

The compiler provides a way to generate very efficient code for switch statements when 
it is known that the value in the expression is even and within a specific limit. This can 
for example be used for writing efficient interrupt service routines that use the Interrupt 
Vector Generators Timer A, Timer B, the I2C module, and the ADC12 module. For more 
information, see Interrupt Vector Generator interrupt functions, page 25.
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Part 2. Reference 
information
This part of the MSP430 IAR C/C++ Compiler Reference Guide contains 
the following chapters:

● External interface details

● Compiler options

● Data representation

● Compiler extensions

● Extended keywords

● Pragma directives

● Intrinsic functions

● The preprocessor

● Library functions

● Segment reference

● Implementation-defined behavior.
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External interface details
This chapter provides reference information about how the compiler interacts 
with its environment. The chapter briefly lists and describes the invocation 
syntax, methods for passing options to the tools, environment variables, the 
include file search procedure, and finally the different types of compiler output.

Invocation syntax
You can use the compiler either from the IAR Embedded Workbench IDE or from the 
command line. Refer to the MSP430 IAR Embedded Workbench® IDE User Guide for 
information about using the compiler from the IAR Embedded Workbench IDE.

COMPILER INVOCATION SYNTAX

The invocation syntax for the compiler is:

icc430 [options] [sourcefile] [options]

For example, when compiling the source file prog.c, use the following command to 
generate an object file with debug information:

icc430 prog --debug

The source file can be a C or C++ file, typically with the filename extension c or cpp, 
respectively. If no filename extension is specified, the file to be compiled must have the 
extension c.

Generally, the order of options on the command line, both relative to each other and to 
the source filename, is not significant. There is, however, one exception: when you use 
the -I option, the directories are searched in the same order that they are specified on the 
command line.

If you run the compiler from the command line without any arguments, the compiler 
version number and all available options including brief descriptions are directed to 
stdout and displayed on the screen.

PASSING OPTIONS

There are three different ways of passing options to the compiler:

● Directly from the command line

Specify the options on the command line after the icc430 command, either before 
or after the source filename; see Invocation syntax, page 133.
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● Via environment variables

The compiler automatically appends the value of the environment variables to every 
command line; see Environment variables, page 134.

● Via a text file by using the -f option; see -f, page 152.

For general guidelines for the option syntax, an options summary, and a detailed 
description of each option, see the Compiler options chapter.

ENVIRONMENT VARIABLES

The following environment variables can be used with the MSP430 IAR C/C++ 
Compiler:

Include file search procedure
This is a detailed description of the compiler’s #include file search procedure:

● If the name of the #include file is an absolute path, that file is opened.

● If the compiler encounters the name of an #include file in angle brackets, such as:

#include <stdio.h>

it searches the following directories for the file to include:

1 The directories specified with the -I option, in the order that they were 
specified, see -I, page 153.

2 The directories specified using the C_INCLUDE environment variable, if any, see 
Environment variables, page 134.

● If the compiler encounters the name of an #include file in double quotes, for 
example:

#include "vars.h"

it searches the directory of the source file in which the #include statement occurs, 
and then performs the same sequence as for angle-bracketed filenames.

Environment variable Description

C_INCLUDE Specifies directories to search for include files; for example: 
C_INCLUDE=c:\program files\iar systems\embedded 

workbench 4.n\430\inc;c:\headers

QCC430 Specifies command line options; for example: QCC430=-lA asm.lst

Table 27: Compiler environment variables
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If there are nested #include files, the compiler starts searching the directory of the 
file that was last included, iterating upwards for each included file, searching the 
source file directory last. For example:

src.c in directory dir\src
#include "src.h"
...

src.h in directory dir\include
#include "config.h"
...

When dir\exe is the current directory, use the following command for compilation:

icc430 ..\src\src.c -I..\include -I..\debugconfig

Then the following directories are searched in the order listed below for the file 
config.h, which in this example is located in the dir\debugconfig directory:

dir\include Current file is src.h.

dir\src File including current file (src.c).

dir\include As specified with the first -I option.

dir\debugconfig As specified with the second -I option.

Use angle brackets for standard header files, like stdio.h, and double quotes for files 
that are part of your application.

Note: Both \ and / can be used as directory delimiters.

Compiler output
The compiler can produce the following output:

● A linkable object file

The object files produced by the compiler use a proprietary format called UBROF, 
which stands for Universal Binary Relocatable Object Format. By default, the object 
file has the filename extension r43.

● Optional list files

Different types of list files can be specified using the compiler option -l, see -l, page 
153. By default, these files will have the filename extension lst. 

● Optional preprocessor output files

A preprocessor output file is produced when you use the --preprocess option; by 
default, the file will have the filename extension i.
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● Diagnostic messages

Diagnostic messages are directed to stderr and displayed on the screen, as well as 
printed in an optional list file. To read more about diagnostic messages, see 
Diagnostics, page 136.

● Error return codes

These codes provide status information to the operating system which can be tested 
in a batch file, see Error return codes, page 136.

● Size information

Information about the generated amount of bytes for functions and data for each 
memory is directed to stdout and displayed on the screen. Some of the bytes might 
be reported as shared.

Shared objects are functions or data objects that are shared between modules. If any 
of these occur in more than one module, only one copy will be retained. For example, 
in some cases inline functions are not inlined, which means that they are marked as 
shared, because only one instance of each function will be included in the final 
application. This mechanism is sometimes also used for compiler-generated code or 
data not directly associated with a particular function or variable, and when only one 
instance is required in the final application.

Error return codes

The MSP430 IAR C/C++ Compiler returns status information to the operating system 
that can be tested in a batch file. 

The following command line error codes are supported:

Diagnostics
This section describes the format of the diagnostic messages and explains how 
diagnostic messages are divided into different levels of severity. 

Code Description

0 Compilation successful, but there may have been warnings.

1 There were warnings and the option --warnings_affect_exit_code was 
used.

2 There were errors.

3 There were fatal errors making the compiler abort.

4 There were internal errors making the compiler abort.

Table 28: Error return codes  
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MESSAGE FORMAT

All diagnostic messages are issued as complete, self-explanatory messages. A typical 
diagnostic message from the compiler is produced in the form:

filename,linenumber level[tag]: message

with the following elements:

Diagnostic messages are displayed on the screen, as well as printed in the optional list 
file.

Use the option --diagnostics_tables to list all possible compiler diagnostic 
messages.

SEVERITY LEVELS

The diagnostic messages are divided into different levels of severity:

Remark

A diagnostic message that is produced when the compiler finds a source code 
construction that can possibly lead to erroneous behavior in the generated code. 
Remarks are by default not issued, but can be enabled, see --remarks, page 164.

Warning

A diagnostic message that is produced when the compiler finds a programming error or 
omission which is of concern, but not so severe as to prevent the completion of 
compilation. Warnings can be disabled by use of the command line option 
--no_warnings, see page 159.

Error

A diagnostic message that is produced when the compiler has found a construction 
which clearly violates the C or C++ language rules, such that code cannot be produced. 
An error will produce a non-zero exit code.

filename The name of the source file in which the issue was encountered

linenumber The line number at which the compiler detected the issue

level The level of seriousness of the issue

tag A unique tag that identifies the diagnostic message

message An explanation, possibly several lines long
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Fatal error

A diagnostic message that is produced when the compiler has found a condition that not 
only prevents code generation, but which makes further processing of the source code 
pointless. After the message has been issued, compilation terminates. A fatal error will 
produce a non-zero exit code.

SETTING THE SEVERITY LEVEL

The diagnostic messages can be suppressed or the severity level can be changed for all 
diagnostics messages, except for fatal errors and some of the regular errors. 

See Compiler options summary, page 142, for a description of the compiler options that 
are available for setting severity levels.

See the chapter Pragma directives, for a description of the pragma directives that are 
available for setting severity levels.

INTERNAL ERROR

An internal error is a diagnostic message that signals that there has been a serious and 
unexpected failure due to a fault in the compiler. It is produced using the following form:

Internal error: message

where message is an explanatory message. If internal errors occur, they should be 
reported to your software distributor or IAR Systems Technical Support. Include enough 
information to reproduce the problem, typically: 

● The product name

● The version number of the compiler, which can be seen in the header of the list files 
generated by the compiler

● Your license number

● The exact internal error message text

● The source file of the application that generated the internal error

● A list of the options that were used when the internal error occurred.
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This chapter describes the syntax of compiler options and the general syntax 
rules for specifying option parameters, and gives detailed reference 
information about each option.

Options syntax
Compiler options are parameters you can specify to change the default behavior of the 
compiler. You can specify options from the command line—which is described in more 
detail in this section—and from within the IAR Embedded Workbench IDE. 

Refer to the MSP430 IAR Embedded Workbench® IDE User Guide for information 
about the compiler options available in the IAR Embedded Workbench IDE and how to 
set them.

TYPES OF OPTIONS

There are two types of names for command line options, short names and long names. 
Some options have both.

● A short option name consists of one character, and it may have parameters. You 
specify it with a single dash, for example -e

● A long option name consists of one or several words joined by underscores, and it 
may have parameters. You specify it with double dashes, for example 
--char_is_signed.

For information about the different methods for passing options, see Passing options, 
page 133.

RULES FOR SPECIFYING PARAMETERS

There are some general syntax rules for specifying option parameters. First, the rules 
depending on whether the parameter is optional or mandatory, and whether the option 
has a short or a long name, are described. Then, the rules for specifying filenames and 
directories are listed. Finally, the remaining rules are listed.

Rules for optional parameters

For options with a short name and an optional parameter, any parameter should be 
specified without a preceding space, for example:

-O or -Ohb
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For options with a long name and an optional parameter, any parameter should be 
specified with a preceding equal sign (=), for example:

--misrac=n

Rules for mandatory parameters

For options with a short name and a mandatory parameter, the parameter can be 
specified either with or without a preceding space, for example:

-I..\src or -I ..\src\

For options with a long name and a mandatory parameter, the parameter can be specified 
either with a preceding equal sign (=) or with a preceding space, for example:

--diagnostics_tables=filename

or 

--diagnostics_tables filename

Rules for options with both optional and mandatory parameters

For options taking both optional and mandatory parameters, the rules for specifying the 
parameters are:

● For short options, optional parameters are specified without a preceding space

● For long options, optional parameters are specified with a preceding equal sign (=)

● For short and long options, mandatory parameters are specified with a preceding 
space.

For example, a short option with an optional parameter followed by a mandatory 
parameter:

-lA filename

For example, a long option with an optional parameter followed by a mandatory 
parameter:

--preprocess=n filename

Rules for specifying a filename or directory as parameters

The following rules apply for options taking a filename or directory as parameters:

● Options that take a filename as a parameter can optionally also take a path. The path 
can be relative or absolute. For example, to generate a listing to the file list.lst 
in the directory ..\listings\:

icc430 prog -l ..\listings\list.lst
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● For options that take a filename as the destination for output, the parameter can be 
specified as a path without a specified filename. The compiler stores the output in 
that directory, in a file with an extension according to the option. The filename will 
be the same as the name of the compiled source file, unless a different name has 
been specified with the option -o, in which case that name will be used. For 
example:

icc430 prog -l ..\listings\

The produced list file will have the default name ..\listings\prog.lst

● The current directory is specified with a period (.). For example:

icc430 prog -l .

● / can be used instead of \ as the directory delimiter.

● By specifying -, input files and output files can be redirected to stdin and stdout, 
respectively. For example:

icc430 prog -l -

Additional rules

In addition, the following rules apply:

● When an option takes a parameter, the parameter cannot start with a dash (-) 
followed by another character. Instead, you can prefix the parameter with two 
dashes; the following example will create a list file called -r:

icc430 prog -l ---r

● For options that accept multiple arguments of the same type, the arguments can be 
provided as a comma-separated list (without a space), for example:

--diag_warning=Be0001,Be0002

Alternatively, the option may be repeated for each argument, for example:

--diag_warning=Be0001
--diag_warning=Be0002
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Compiler options summary
The following table summarizes the compiler command line options:

Command line option Description

--char_is_signed Treats char as signed

--core Specifies the architecture

-D Defines preprocessor symbols

--data_model Specifies the data model

--debug Generates debug information

--dependencies Lists file dependencies

--diag_error Treats these as errors

--diag_remark Treats these as remarks

--diag_suppress Suppresses these diagnostics

--diag_warning Treats these as warnings

--diagnostics_tables Lists all diagnostic messages

--dlib_config Determines the library configuration file

--double Forces the compiler to use 32-bit or 64-bit doubles

-e Enables language extensions

--ec++ Enables Embedded C++ syntax

--eec++ Enables Extended Embedded C++ syntax

--enable_multibytes Enables support for multibyte characters in source 
files

--error_limit Specifies the allowed number of errors before 
compilation stops

-f Extends the command line

--header_context Lists all referred source files and header files

-I Specifies include file path

-l Creates a list file

--library_module Creates a library module

--lock_r4 Excludes R4 from use

--lock_r5 Excludes R5 from use

--migration_preprocessor

_extensions

Extends the preprocessor

--misrac Enables MISRA C-specific error messages

Table 29: Compiler options summary
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--misrac_verbose Enables verbose logging of MISRA C checking

--module_name Sets the object module name

--no_code_motion Disables code motion optimization

--no_cse Disables common subexpression elimination

--no_inline Disables function inlining

--no_path_in_file_macros Removes the path from the return value of the 
symbols __FILE__ and __BASE_FILE__

--no_tbaa Disables type-based alias analysis

--no_typedefs_in_diagnostics Disables the use of typedef names in diagnostics

--no_unroll Disables loop unrolling

--no_warnings Disables all warnings

--no_wrap_diagnostics Disables wrapping of diagnostic messages

-O Sets the optimization level

-o Sets the object filename 

--omit_types Excludes type information 

--only_stdout Uses standard output only

--output Sets the object filename

--pic Produces position-independent code

--preinclude Includes an include file before reading the source 
file

--preprocess Generates preprocessor output

--public_equ Defines a global named assembler label

-r Generates debug information

--reduce_stack_usage Reduces stack usage

--regvar_r4 Reserves R4 for use by global register variables

--regvar_r5 Reserves R5 for use by global register variables

--remarks Enables remarks

--require_prototypes Verifies that functions are declared before they are 
defined

--save_reg20 Declares all interrupt functions __save_reg20 
by default

--silent Sets silent operation

--strict_ansi Checks for strict compliance with ISO/ANSI C

Command line option Description

Table 29: Compiler options summary (Continued)
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Descriptions of options
The following section gives detailed reference information about each compiler option.

Note that if you use the options page Extra Options to specify specific command line 
options, the IAR Embedded Workbench IDE does not perform an instant check for 
consistency problems like conflicting options, duplication of options, or use of 
irrelevant options.

--char_is_signed

Syntax --char_is_signed 

Description By default, the compiler interprets the char type as unsigned. Use this option to make 
the compiler interpret the char type as signed instead. This can be useful when you, for 
example, want to maintain compatibility with another compiler.

Note: The runtime library is compiled without the --char_is_signed option. If you 
use this option, you may get type mismatch warnings from the linker, because the library 
uses unsigned char.

Project>Options>C/C++ Compiler>Language>Plain ‘char’ is

--core

Syntax --core={430|430X}

Parameters

Description Use this option to select the architecture for which the code is to be generated. If you do 
not use the option, the compiler generates code for the MSP430 architecture by default.

The object code that is generated when compiling for the MSP430 architecture can be 
executed also by the MSP430X architecture. The other way around is not possible.

--warnings_affect_exit_code Warnings affects exit code

--warnings_are_errors Warnings are treated as errors

Command line option Description

Table 29: Compiler options summary (Continued)

430 (default) For devices based on the MSP430 architecture

430X For devices based on the MSP430X architecture
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Project>Options>General Options>Target>Device

-D

Syntax -D symbol[=value]

Parameters

Description Use this option to define a preprocessor symbol. If no value is specified, 1 is used. This 
option can be used one or more times on the command line.

The option -D has the same effect as a #define statement at the top of the source file:

-Dsymbol

is equivalent to:

#define symbol 1

In order to get the equivalence of:

#define FOO

specify the = sign but nothing after, for example:

-DFOO=

Project>Options>C/C++ Compiler>Preprocessor>Defined symbols

--data_model

Syntax --data_model={small|medium|large}

Parameters

symbol The name of the preprocessor symbol

value The value of the preprocessor symbol

small (default) Sets data16 as the default memory type, both for data objects and 

pointers. This means that the first 64 Kbytes of memory can be 

accessed.

medium Sets data16 as the default memory type, both for data objects and 

pointers. This means that the first 64 Kbytes of memory can be 

accessed. But if required, also the entire memory can be used.

large Sets data20 as the default memory type, both for data objects and 
pointers. This means that the entire memory range can be accessed.
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Description For MSP430X devices, use this option to select the data model for which the code is to 
be generated. If you do not choose a data model option, the compiler uses the default 
data model. Note that all modules of your application must use the same data model.

See also Data models (MSP430X only), page 14.

Project>Options>General Options>Target>Data model

--debug, -r

Syntax --debug
-r

Description Use the --debug or -r option to make the compiler include information in the object 
modules required by the IAR C-SPY® Debugger and other symbolic debuggers.

Note: Including debug information will make the object files larger than otherwise.

Project>Options>C/C++ Compiler>Output>Generate debug information

--dependencies

Syntax --dependencies[=[i|m]] {filename|directory}

Parameters

For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 140.

Description Use this option to make the compiler list all source and header files opened by the 
compilation into a file with the default filename extension i.

Example If --dependencies or --dependencies=i is used, the name of each opened source 
file, including the full path, if available, is output on a separate line. For example:

   c:\iar\product\include\stdio.h
   d:\myproject\include\foo.h

i (default) Lists only the names of files

m Lists in makefile style
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If --dependencies=m is used, the output uses makefile style. For each source file, one 
line containing a makefile dependency rule is produced. Each line consists of the name 
of the object file, a colon, a space, and the name of a source file. For example:

   foo.r43: c:\iar\product\include\stdio.h
   foo.r43: d:\myproject\include\foo.h

An example of using --dependencies with a popular make utility, such as gmake 
(GNU make):

1 Set up the rule for compiling files to be something like:

     %.r43 : %.c
           $(ICC) $(ICCFLAGS) $< --dependencies=m $*.d

That is, in addition to producing an object file, the command also produces a 
dependency file in makefile style (in this example, using the extension .d).

2 Include all the dependency files in the makefile using, for example:

     -include $(sources:.c=.d)

Because of the dash (-) it works the first time, when the .d files do not yet exist.

This option is not available in the IAR Embedded Workbench IDE.

--diag_error

Syntax --diag_error=tag[,tag,...] 

Parameters

Description Use this option to reclassify certain diagnostic messages as errors. An error indicates a 
violation of the C or C++ language rules, of such severity that object code will not be 
generated. The exit code will be non-zero. This option may be used more than once on 
the command line.

Project>Options>C/C++ Compiler>Diagnostics>Treat these as errors

tag The number of a diagnostic message, for example the message 
number Pe117
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--diag_remark

Syntax --diag_remark=tag[,tag,...] 

Parameters

Description Use this option to reclassify certain diagnostic messages as remarks. A remark is the 
least severe type of diagnostic message and indicates a source code construction that 
may cause strange behavior in the generated code. This option may be used more than 
once on the command line.

Note: By default, remarks are not displayed; use the --remarks option to display 
them.

Project>Options>C/C++ Compiler>Diagnostics>Treat these as remarks

--diag_suppress

Syntax --diag_suppress=tag[,tag,...]

Parameters

Description Use this option to suppress certain diagnostic messages. These messages will not be 
displayed. This option may be used more than once on the command line.

Project>Options>C/C++ Compiler>Diagnostics>Suppress these diagnostics

--diag_warning

Syntax --diag_warning=tag[,tag,...]

Parameters

Description Use this option to reclassify certain diagnostic messages as warnings. A warning 
indicates an error or omission that is of concern, but which will not cause the compiler 

tag The number of a diagnostic message, for example the message 
number Pe177

tag The number of a diagnostic message, for example the message 
number Pe117

tag The number of a diagnostic message, for example the message 
number Pe826
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to stop before compilation is completed. This option may be used more than once on the 
command line.

Project>Options>C/C++ Compiler>Diagnostics>Treat these as warnings

--diagnostics_tables

Syntax --diagnostics_tables {filename|directory}

Parameters For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 140.

Description Use this option to list all possible diagnostic messages in a named file. This can be 
convenient, for example if you have used a pragma directive to suppress or change the 
severity level of any diagnostic messages, but forgot to document why.

This option cannot be given together with other options.

This option is not available in the IAR Embedded Workbench IDE.

 --dlib_config

Syntax --dlib_config filename

Parameters For information about specifying a filename, see Rules for specifying a filename or 
directory as parameters, page 140.

Description Each runtime library has a corresponding library configuration file. Use this option to 
specify the library configuration file for the compiler. Make sure that you specify a 
configuration file that corresponds to the library you are using.

All prebuilt runtime libraries are delivered with corresponding configuration files. You 
can find the library object files and the library configuration files in the directory 
430\lib. For examples and a list of prebuilt runtime libraries, see Using a prebuilt 
library, page 48.

If you build your own customized runtime library, you should also create a 
corresponding customized library configuration file, which must be specified to the 
compiler. For more information, see Building and using a customized library, page 55.

Note: This option only applies to the IAR DLIB runtime environment.
C430-7

Part 2. Compiler reference 149



150

Descriptions of options
To set related options, choose:

Project>Options>General Options>Library Configuration

 --double

Syntax --double={32|64}

Parameters

Description Use this option to select the precision used by the compiler for representing the 
floating-point types double and long double. The compiler can use either 32-bit or 
64-bit precision. By default, the compiler uses 32-bit precision.

See also Floating-point types, page 172.

Project>Options>General Options>Target>Size of type 'double'

-e 

Syntax -e 

Description In the command line version of the MSP430 IAR C/C++ Compiler, language extensions 
are disabled by default. If you use language extensions such as extended keywords and 
anonymous structs and unions in your source code, you must enable them by using this 
option.

Note: The -e option and the --strict_ansi option cannot be used at the same time.

See also The chapter Compiler extensions.

Project>Options>C/C++ Compiler>Language>Allow IAR extensions

Note: By default, this option is enabled in the IAR Embedded Workbench IDE.

32 (default) 32-bit doubles are used

64 64-bit doubles are used
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--ec++

Syntax --ec++

Description In the MSP430 IAR C/C++ Compiler, the default language is C. If you use Embedded 
C++, you must use this option to set the language the compiler uses to Embedded C++.

Project>Options>C/C++ Compiler>Language>Embedded C++

--eec++

Syntax --eec++

Description In the MSP430 IAR C/C++ Compiler, the default language is C. If you take advantage 
of Extended Embedded C++ features like namespaces or the standard template library 
in your source code, you must use this option to set the language the compiler uses to 
Extended Embedded C++. 

See also Extended Embedded C++, page 102.

Project>Options>C/C++ Compiler>Language>Extended Embedded C++

--enable_multibytes

Syntax --enable_multibytes 

Description By default, multibyte characters cannot be used in C or C++ source code. Use this option 
to make multibyte characters in the source code be interpreted according to the host 
computer’s default setting for multibyte support.

Multibyte characters are allowed in C and C++ style comments, in string literals, and in 
character constants. They are transferred untouched to the generated code.

Project>Options>C/C++ Compiler>Language>Enable multibyte support
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--error_limit

Syntax --error_limit=n 

Parameters

Description Use the --error_limit option to specify the number of errors allowed before the 
compiler stops the compilation. By default, 100 errors are allowed.

This option is not available in the IAR Embedded Workbench IDE.

-f

Syntax -f filename

Parameters For information about specifying a filename, see Rules for specifying a filename or 
directory as parameters, page 140.

Descriptions Use this option to make the compilerread command line options from the named file, 
with the default filename extension xcl.

In the command file, you format the items exactly as if they were on the command line 
itself, except that you may use multiple lines, because the newline character acts just as 
a space or tab character.

Both C and C++ style comments are allowed in the file. Double quotes behave in the 
same way as in the Microsoft Windows command line environment.

To set this option, use Project>Options>C/C++ Compiler>Extra Options.

--header_context

Syntax --header_context 

Description Occasionally, to find the cause of a problem it is necessary to know which header file 
that was included from which source line. Use this option to list, for each diagnostic 
message, not only the source position of the problem, but also the entire include stack at 
that point.

This option is not available in the IAR Embedded Workbench IDE.

n The number of errors before the compiler stops the compilation. n 
must be a positive integer; 0 indicates no limit.
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-I

Syntax -I path

Parameters

Description Use this option to specify the search paths for #include files. This option may be used 
more than once on the command line.

See also Include file search procedure, page 134.

Project>Options>C/C++ Compiler>Preprocessor>Additional include directories

-l

Syntax -l[a|A|b|B|c|C|D][N][H] {filename|directory}

Parameters

* This makes the list file less useful as input to the assembler, but more useful for reading by a 
human.

path The search path for #include files

a Assembler list file

A Assembler list file with C or C++ source as comments

b Basic assembler list file. This file has the same contents as a list file 
produced with -la, except that no extra compiler-generated 
information (runtime model attributes, call frame information, frame 
size information) is included *

B Basic assembler list file. This file has the same contents as a list file 
produced with -lA, except that no extra compiler generated 
information (runtime model attributes, call frame information, frame 
size information) is included *

c C or C++ list file

C (default) C or C++ list file with assembler source as comments

D C or C++ list file with assembler source as comments, but without 
instruction offsets and hexadecimal byte values

N No diagnostics in file

H Include source lines from header files in output. Without this 
option, only source lines from the primary source file are included
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For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 140.

Description Use this option to generate an assembler or C/C++ listing to a file. Note that this option 
can be used one or more times on the command line.

To set related options, choose:

Project>Options>C/C++ Compiler>List

--library_module

Syntax --library_module 

Description Use this option to make the compiler generate a library module rather than a program 
module. A program module is always included during linking. A library module will 
only be included if it is referenced in your program.

Project>Options>C/C++ Compiler>Output>Module type>Library Module

--lock_r4

Syntax --lock_R4

Description Use this option to exclude the register R4 from use by the compiler. This makes the 
module linkable with both modules that use R4 as __regvar and modules that does not 
define its R4 usage. Use this option if the R4 registers is used by another tool, for 
example a ROM-monitor debugger.

Project>Options>C/C++ Compiler>Code>R4 utilization>Not used

--lock_r5

Syntax --lock_R5

Description Use this option to exclude the register R5 from use by the compiler. This makes the 
module linkable with both modules that use R5 as __regvar and modules that does not 
define its R5 usage. Use this option if the R5 registers is used by another tool, for 
example a ROM-monitor debugger.

Project>Options>C/C++ Compiler>Code>R5 utilization>Not used
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--migration_preprocessor_extensions

Syntax --migration_preprocessor_extensions

Description If you need to migrate code from an earlier IAR Systems C or C/C++ compiler, you may 
want to use this option. Use this option to use the following in preprocessor expressions:

● Floating-point expressions

● Basic type names and sizeof

● All symbol names (including typedefs and variables).

Note: If you use this option, not only will the compiler accept code that does not 
conform to the ISO/ANSI C standard, but it will also reject some code that does conform 
to the standard.

Important! Do not depend on these extensions in newly written code, because support 
for them may be removed in future compiler versions.

Project>Options>C/C++ Compiler>Language>Enable IAR migration 
preprocessor extensions

--misrac

Syntax --misrac[={n,o-p,…|all|required}]

Parameters

Description Use this option to enable the compiler to check for deviations from the rules described 
in the MISRA Guidelines for the Use of the C Language in Vehicle Based Software 
(1998). By using one or more arguments with the option, you can restrict the checking 
to a specific subset of the MISRA C rules. If the compiler is unable to check for a rule, 
specifying the option for that rule has no effect. For instance, MISRA C rule 15 is a 

--misrac=n Enables checking for the MISRA C rule with number n

--misrac=o,n Enables checking for the MISRA C rules with numbers o and n

--misrac=o-p Enables checking for all MISRA C rules with numbers from o to p

--misrac=m,n,o-p Enables checking for MISRA C rules with numbers m, n, and from o 
to p

--misrac=all Enables checking for all MISRA C rules

--misrac=required Enables checking for all MISRA C rules categorized as required
C430-7

Part 2. Compiler reference 155



156

Descriptions of options
documentation issue, and the rule is not checked by the compiler. As a consequence, 
specifying --misrac=15 has no effect.

To set related options, choose:

Project>Options>General Options>MISRA C or Project>Options>C/C++ 
Compiler>MISRA C

--misrac_verbose

Syntax --misrac_verbose

Description Use this option to generate a MISRA C log during compilation. This is a list of the rules 
that are enabled—but not necessarily checked—and a list of rules that are actually 
checked.

If this option is enabled, the compiler display a text at sign-on that shows both enabled 
and checked MISRA C rules.

Project>Options>General Options>MISRA C>Log MISRA C Settings

--module_name

Syntax --module_name=name 

Parameters

Description Normally, the internal name of the object module is the name of the source file, without 
a directory name or extension. Use this option to specify an object module name 
explicitly.

This option is useful when several modules have the same filename, because the 
resulting duplicate module name would normally cause a linker error; for example, 
when the source file is a temporary file generated by a preprocessor. 

Project>Options>C/C++ Compiler>Output>Object module name

name An explicit object module name
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--no_code_motion

Syntax --no_code_motion 

Description Use this option to disable code motion optimizations. These optimizations, which are 
performed at the optimization levels Medium and High, normally reduce code size and 
execution time. However, the resulting code may be difficult to debug.

Note: This option has no effect at optimization levels below Medium.

Project>Options>C/C++ Compiler>Optimizations>Enable 
transformations>Code motion

--no_cse

Syntax --no_cse 

Description Use this option to disable common subexpression elimination. At the optimization 
levels Medium and High, the compiler avoids calculating the same expression more than 
once. This optimization normally reduces both code size and execution time. However, 
the resulting code may be difficult to debug.

Note: This option has no effect at optimization levels below Medium.

Project>Options>C/C++ Compiler>Optimizations>Enable 
transformations>Common subexpression elimination

--no_inline

Syntax --no_inline 

Description Use this option to disable function inlining. Function inlining means that a simple 
function, whose definition is known at compile time, is integrated into the body of its 
caller to eliminate the overhead of the call. 

This optimization, which is performed at the optimization level High, normally reduces 
execution time and increases code size. The resulting code may also be difficult to 
debug.

The compiler heuristically decides which functions to inline. Different heuristics are 
used when optimizing for speed than for size.
C430-7

Part 2. Compiler reference 157



158

Descriptions of options
Note: This option has no effect at optimization levels below High.

Project>Options>C/C++ Compiler>Optimizations>Enable 
transformations>Function inlining

--no_path_in_file_macros

Syntax --no_path_in_file_macros

Description Use this option to exclude the path from the return value of the predefined preprocessor 
symbols __FILE__ and __BASE_FILE__.

See also Descriptions of predefined preprocessor symbols, page 226.

This option is not available in the IAR Embedded Workbench IDE.

--no_tbaa

Syntax --no_tbaa

Description Use this option to disable type-based alias analysis. When this options is not used, the 
compiler is free to assume that objects are only accessed through the declared type or 
through unsigned char. 

See also Type-based alias analysis, page 123.

Project>Options>C/C++ Compiler>Optimizations>Enable 
transformations>Type-based alias analysis

--no_typedefs_in_diagnostics

Syntax --no_typedefs_in_diagnostics 

Description Use this option to disable the use of typedef names in diagnostics. Normally, when a 
type is mentioned in a message from the compiler, most commonly in a diagnostic 
message of some kind, the typedef names that were used in the original declaration are 
used whenever they make the resulting text shorter.

Example typedef int (*MyPtr)(char const *);
MyPtr p = "foo";
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will give an error message like the following:

Error[Pe144]: a value of type "char *" cannot be used to 
initialize an entity of type "MyPtr"

If the --no_typedefs_in_diagnostics option is used, the error message will be like 
this:

Error[Pe144]: a value of type "char *" cannot be used to 
initialize an entity of type "int (*)(char const *)"

To set this option, use Project>Options>C/C++ Compiler>Extra Options.

--no_unroll

Syntax --no_unroll 

Description Use this option to disable loop unrolling. The code body of a small loop, whose number 
of iterations can be determined at compile time, is duplicated to reduce the loop 
overhead. 

For small loops, the overhead required to perform the looping can be large compared 
with the work performed in the loop body.

The loop unrolling optimization duplicates the body several times, reducing the loop 
overhead. The unrolled body also opens up for other optimization opportunities.

This optimization, which is performed at the optimization level High, normally reduces 
execution time, but increases code size. The resulting code may also be difficult to 
debug.

The compiler heuristically decides which loops to unroll. Different heuristics are used 
when optimizing for speed and size. 

Note: This option has no effect at optimization levels below High.

Project>Options>C/C++ Compiler>Optimizations>Enable 
transformations>Loop unrolling

--no_warnings

Syntax --no_warnings 

Description By default, the compiler issues warning messages. Use this option to disable all warning 
messages.
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This option is not available in the IAR Embedded Workbench IDE.

--no_wrap_diagnostics

Syntax --no_wrap_diagnostics 

Description By default, long lines in diagnostic messages are broken into several lines to make the 
message easier to read. Use this option to disable line wrapping of diagnostic messages.

This option is not available in the IAR Embedded Workbench IDE.

-O

Syntax -O[n|l|m|h|hs|hz] 

Parameters

*The most important difference between None and Low is that at None, all non-static variables 
will live during their entire scope.

Description Use this option to set the optimization level to be used by the compiler when optimizing 
the code. If no optimization option is specified, the optimization level Low is used by 
default. If only -O is used without any parameter, the optimization level High balanced 
is used.

A low level of optimization makes it relatively easy to follow the program flow in the 
debugger, and, conversely, a high level of optimization makes it relatively hard.

See also Controlling compiler optimizations, page 120.

Project>Options>C/C++ Compiler>Optimizations

n None* (Best debug support)

l (default) Low*

m Medium

h High, balanced

hs High, favoring speed

hz High, favoring size
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-o, --output

Syntax -o {filename|directory} 
--output {filename|directory}

Parameters For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 140.

Description By default, the object code output produced by the compiler is located in a file with the 
same name as the source file, but with the extension r43. Use this option to explicitly 
specify a different output filename for the object code output.

This option is not available in the IAR Embedded Workbench IDE.

--omit_types

Syntax --omit_types

Description By default, the compiler includes type information about variables and functions in the 
object output. Use this option if you do not want the compiler to include this type 
information in the output, which is useful when you build a library that should not 
contain type information. The object file will then only contain type information that is 
a part of a symbol’s name. This means that the linker cannot check symbol references 
for type correctness.

To set this option, use Project>Options>C/C++ Compiler>Extra Options.

--only_stdout

Syntax --only_stdout 

Description Use this option to make the compiler use the standard output stream (stdout) also for 
messages that are normally directed to the error output stream (stderr).

This option is not available in the IAR Embedded Workbench IDE.
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--output, -o

Syntax --output {filename|directory}
-o {filename|directory}

Parameters For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 140.

Description By default, the object code output produced by the compiler is located in a file with the 
same name as the source file, but with the extension r43. Use this option to explicitly 
specify a different output filename for the object code output.

This option is not available in the IAR Embedded Workbench IDE.

--pic

Syntax --pic

Description Use this option to make the compiler produce position-independent code, which means 
that functions can be relocated at runtime. This option is not available when compiling 
for the MSP430X architecture.

Project>Options>General Options>Target>Position-independent code

 --preinclude 

Syntax --preinclude includefile

Parameters For information about specifying a filename, see Rules for specifying a filename or 
directory as parameters, page 140.

Description Use this option to make the compiler include the specified include file before it starts to 
read the source file. This is useful if you want to change something in the source code 
for the entire application, for instance if you want to define a new symbol.

Project>Options>C/C++ Compiler>Preprocessor>Preinclude file
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--preprocess

Syntax --preprocess[=[c][n][l]] {filename|directory}

Parameters

For information about specifying a filename or a directory, see Rules for specifying a 
filename or directory as parameters, page 140.

Description Use this option to generate preprocessed output to a named file.

Project>Options>C/C++ Compiler>Preprocessor>Preprocessor output to file

--public_equ

Syntax --public_equ symbol[=value]

Parameters

Description This option is equivalent to defining a label in assembler language using the EQU 
directive and exporting it using the PUBLIC directive. This option may be used more 
than once on the command line. 

This option is not available in the IAR Embedded Workbench IDE.

-r, --debug

Syntax -r
--debug

Description Use the -r or the --debug option to make the compiler include information in the 
object modules required by the IAR C-SPY Debugger and other symbolic debuggers.

Note: Including debug information will make the object files larger than otherwise.

Project>Options>C/C++ Compiler>Output>Generate debug information

c Preserve comments

n Preprocess only

l Generate #line directives

symbol The name of the assembler symbol to be defined

value An optional value of the defined assembler symbol
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--reduce_stack_usage

Syntax --reduce_stack_usage

Description Use this option to make the compiler minimize the use of stack space at the cost of 
somewhat larger and slower code.

Project>Options>C/C++ Compiler>Code>Reduce stack usage

--regvar_r4

Syntax --regvar_R4

Description Use this option to reserve the register R4 for use by global register variables, declared 
with the __regvar attribute. This can give more efficient code if used on frequently 
used variables.

See also --lock_r4, page 154 and __regvar, page 196.

Project>Options>C/C++ Compiler>Code>R4 utilization>__regvar variables

--regvar_r5

Syntax --regvar_R5

Description Use this option to reserve the register R5 for use by global register variables, declared 
with the __regvar attribute. This can give more efficient code if used on frequently 
used variables.

See also --lock_r5, page 154 and __regvar, page 196.

Project>Options>C/C++ Compiler>Code>R5 utilization>__regvar variables

--remarks

Syntax --remarks 

Description The least severe diagnostic messages are called remarks. A remark indicates a source 
code construct that may cause strange behavior in the generated code. By default, the 
compiler does not generate remarks. Use this option to make the compiler generate 
remarks. 
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See also Severity levels, page 137.

Project>Options>C/C++ Compiler>Diagnostics>Enable remarks

--require_prototypes

Syntax --require_prototypes

Description Use this option to force the compiler to verify that all functions have proper prototypes. 
Using this option means that code containing any of the following will generate an error:

● A function call of a function with no declaration, or with a Kernighan & Ritchie 
C declaration

● A function definition of a public function with no previous prototype declaration

● An indirect function call through a function pointer with a type that does not include 
a prototype.

Note: This option only applies to functions in the C standard library.

Project>Options>C/C++ Compiler>Language>Require prototypes

--save_reg20

Syntax --save_reg20

Description Use this option to make all interrupt functions be treated as a __save_reg20 declared 
function. This means that you do not have to explicitly use the __save_reg20 keyword 
on any interrupt functions.

This is necessary if your application requires that all 20 bits of registers are preserved. 
The drawback is that the code will be somewhat slower.

Note: This option is only available when compiling for the MSP430X architecture.

See also __save_reg20, page 197

Project>Options>C/C++ Compiler>Code>20-bit context save on interrupt
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--silent

Syntax --silent 

Description By default, the compiler issues introductory messages and a final statistics report. Use 
this option to make the compiler operate without sending these messages to the standard 
output stream (normally the screen). 

This option does not affect the display of error and warning messages.

This option is not available in the IAR Embedded Workbench IDE.

--strict_ansi

Syntax --strict_ansi 

Description By default, the compiler accepts a relaxed superset of ISO/ANSI C/C++, see Minor 
language extensions, page 186. Use this option to ensure that the program conforms to 
the ISO/ANSI C/C++ standard.

Note: The -e option and the --strict_ansi option cannot be used at the same time.

Project>Options>C/C++ Compiler>Language>Language conformances>Strict 
ISO/ANSI

--warnings_affect_exit_code

Syntax --warnings_affect_exit_code 

Description By default, the exit code is not affected by warnings, because only errors produce a 
non-zero exit code. With this option, warnings will also generate a non-zero exit code.

This option is not available in the IAR Embedded Workbench IDE.

--warnings_are_errors

Syntax --warnings_are_errors

Description Use this option to make the compiler treat all warnings as errors. If the compiler 
encounters an error, no object code is generated. Warnings that have been changed into 
remarks are not treated as errors.
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Note: Any diagnostic messages that have been reclassified as warnings by the option 
--diag_warning or the #pragma diag_warning directive will also be treated as 
errors when --warnings_are_errors is used.

See also diag_warning, page 205.

Project>Options>C/C++ Compiler>Diagnostics>Treat all warnings as errors
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This chapter describes the data types, pointers, and structure types supported 
by the MSP430 IAR C/C++ Compiler.

See the chapter Efficient coding for embedded applications for information about 
which data types and pointers provide the most efficient code for your 
application.

Alignment
Every C data object has an alignment that controls how the object can be stored in 
memory. Should an object have an alignment of, for example, 4, it must be stored on an 
address that is divisible by 4.

The reason for the concept of alignment is that some processors have hardware 
limitations for how the memory can be accessed.

Assume that a processor can read 4 bytes of memory using one instruction, but only 
when the memory read is placed on an address divisible by 4. Then, 4-byte objects, such 
as long integers, will have alignment 4.

Another processor might only be able to read 2 bytes at a time; in that environment, the 
alignment for a 4-byte long integer might be 2.

A structure type will inherit the alignment from its components.

All objects must have a size that is a multiple of the alignment. Otherwise, only the first 
element of an array would be placed in accordance with the alignment requirements. 

In the following example, the alignment of the structure is 4, under the assumption that 
long has alignment 4. Its size is 8, even though only 5 bytes are effectively used.

struct str {
  long a;
  char b;
};

In standard C, the size of an object can be determined by using the sizeof operator.

ALIGNMENT ON THE MSP430 MICROCONTROLLER 

The MSP430 microcontroller can access memory using 8- or 16-bit operations. 
However, when a 16-bit access is performed, the data must be located at an even address. 
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The MSP430 IAR C/C++ Compiler ensures this by assigning an alignment to every data 
type, ensuring that the MSP430 microcontroller will be able to read the data.

Basic data types 

The compiler supports both all ISO/ANSI C basic data types and some additional types.

INTEGER TYPES

The following table gives the size and range of each integer data type:

Signed variables are represented using the two’s complement form.

Bool

The bool data type is supported by default in the C++ language. If you have enabled 
language extensions, the bool type can also be used in C source code if you include the 
file stdbool.h. This will also enable the boolean values false and true.

The long long type 

The long long data type is supported with the following restrictions:

● The CLIB runtime library does not support the long long type
● A long long variable cannot be used in a switch statement.

Data type Size Range Alignment

bool 8 bits 0 to 1 1

char 8 bits 0 to 255 1

signed char 8 bits -128 to 127 1

unsigned char 8 bits 0 to 255 1

signed short 16 bits -32768 to 32767 2

unsigned short 16 bits 0 to 65535 2

signed int 16 bits -32768 to 32767 2

unsigned int 16 bits 0 to 65535 2

signed long 32 bits -231 to 231-1 2

unsigned long 32 bits 0 to 232-1 2

signed long long 64 bits -263 to 263-1 2

unsigned long long 64 bits 0 to 264-1 2

Table 30: Integer types 
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The enum type 

The compiler will use the smallest type required to hold enum constants, preferring 
signed in front of unsigned.

When IAR Systems language extensions are enabled, and in C++, the enum constants 
and types can also be of the type long, unsigned long, long long, or unsigned 
long long. 

To make the compiler use a larger type than it would automatically use, define an enum 
constant with a large enough value. For example,

/* Disables usage of the char type for enum */
enum Cards{Spade1, Spade2,
           DontUseChar=257};

The char type 

The char type is by default unsigned in the compiler, but the --char_is_signed 
compiler option allows you to make it signed. Note, however, that the library is compiled 
with the char type as unsigned.

The wchar_t type 

The wchar_t data type is an integer type whose range of values can represent distinct 
codes for all members of the largest extended character set specified among the 
supported locals.

The wchar_t data type is supported by default in the C++ language. To use the 
wchar_t type also in C source code, you must include the file stddef.h from the 
runtime library.

Note: The IAR CLIB Library has only rudimentary support for wchar_t.

Bitfields

In ISO/ANSI C, int and unsigned int can be used as the base type for integer 
bitfields. In the MSP430 IAR C/C++ Compiler, any integer type can be used as the base 
type when language extensions are enabled.

Bitfields in expressions will have the same data type as the integer base type.

By default, the compiler places bitfield members from the least significant to the most 
significant bit in the container type. 

By using the directive #pragma bitfields=reversed, the bitfield members are 
placed from the most significant to the least significant bit.
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FLOATING-POINT TYPES 

In the MSP430 IAR C/C++ Compiler, floating-point values are represented in standard 
IEEE 754 format. The sizes for the different floating-point types are:

Note: The size of double and long double depends on the --double={32|64} 
option, see --double, page 150. The type long double uses the same precision as 
double.

 The compiler does not support subnormal numbers. All operations that should produce 
subnormal numbers will instead generate zero.

Exception flags according to the IEEE 754 standard are not supported.

32-bit floating-point format

The representation of a 32-bit floating-point number as an integer is:

The exponent is 8 bits, and the mantissa is 23 bits.

The value of the number is:

(-1)S * 2(Exponent-127) * 1.Mantissa

The range of the number is:

±1.18E-38 to ±3.39E+38

The precision of the float operators (+, -, *, and /) is approximately 7 decimal digits.

Type Size if --double=32 Size if --double=64

float 32 bits 32 bits

double 32 bits (default) 64 bits

long double 32 bits 64 bits

Table 31: Floating-point types 
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64-bit floating-point format

The representation of a 64-bit floating-point number as an integer is:

The exponent is 11 bits, and the mantissa is 52 bits.

The value of the number is:

(-1)S * 2(Exponent-1023) * 1.Mantissa

The range of the number is:

±2.23E-308 to ±1.79E+308

The precision of the float operators (+, -, *, and /) is approximately 15 decimal digits.

Representation of special floating-point numbers

The following list describes the representation of special floating-point numbers:

● Zero is represented by zero mantissa and exponent. The sign bit signifies positive or 
negative zero.

● Infinity is represented by setting the exponent to the highest value and the mantissa 
to zero. The sign bit signifies positive or negative infinity.

● Not a number (NaN) is represented by setting the exponent to the highest positive 
value and the mantissa to a non-zero value. The value of the sign bit is ignored.

Note: The IAR CLIB Library does not fully support the special cases of floating-point 
numbers, such as infinity and NaN. A library function which gets one of these special 
cases of floating-point numbers as an argument may behave unexpectedly.

Pointer types
The MSP430 IAR C/C++ Compiler has two basic types of pointers: function pointers 
and data pointers. 

FUNCTION POINTERS

For the MSP430 architecture, function pointers are always 16 bits. For the MSP430X 
architecture, function pointers are 20 bits (4 bytes when stored in memory) and they can 
address the entire 1 Mbyte of memory.

   63  62                 52 51                               0
S Exponent Mantissa
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DATA POINTERS

The following data pointers are available:

* The __data20 pointer type is not available in the Small data model.

CASTING

Casts between pointers have the following characteristics:

● Casting a value of an integer type to a pointer of a smaller type is performed by 
truncation

● Casting a value of an integer type to a pointer of a larger type is performed by zero 
extension

● Casting a pointer type to a smaller integer type is performed by truncation

● Casting a pointer type to a larger integer type is performed by zero extension

● Casting a data pointer to a function pointer and vice versa is illegal

● Casting a function pointer to an integer type gives an undefined result

● Casting from a smaller pointer to a larger pointer is performed by zero extension

● Casting from a larger pointer to a smaller pointer is performed by truncation.

size_t

size_t is the unsigned integer type required to hold the maximum size of an object. For 
the MSP430 architecture, and for the MSP430X architecture in the Small and Medium 
data models, the size of size_t is 16 bits. In the Large data model, the size of size_t 
is 32 bits.

ptrdiff_t

ptrdiff_t is the type of the signed integer required to hold the difference between two 
pointers to elements of the same array. For the MSP430 architecture, and for the 
MSP430X architecture in the Small and Medium data models, the size of ptrdiff_t 
is 16 bits. In the Large data model, the size of ptrdiff_t is 32 bits.

Note: Subtracting the start address of an object from the end address can yield a 
negative value, because the object can be larger than what the ptrdiff_t can represent. 

Keyword Pointer size Index type Address range

__data16 16 bits signed int 0x0–0xFFFF

__data20* 20 bits signed int 0x0–0xFFFFF

Table 32: Data pointers 
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See this example:

char buff[60000];           /* Assuming ptrdiff_t is a 16-bit */
char *p1 = buff;            /* signed integer type. */
char *p2 = buff + 60000;
ptrdiff_t diff = p2 - p1;

intptr_t

intptr_t is a signed integer type large enough to contain a void *. For the MSP430 
architecture, and for the MSP430X architecture in the Small and Medium data models, 
the size of intptr_t is 16 bits. In the Large data model, the size of intptr_t is 32 bits.

uintptr_t

uintptr_t is equivalent to intptr_t, with the exception that it is unsigned.

Structure types 
The members of a struct are stored sequentially in the order in which they are 
declared: the first member has the lowest memory address.

ALIGNMENT

The struct and union types inherit the alignment requirements of their members. In 
addition, the size of a struct is adjusted to allow arrays of aligned structure objects.

GENERAL LAYOUT 

Members of a struct (fields) are always allocated in the order given in the declaration. 
The members are placed in memory according to the given alignment (offsets). 

Example

struct {
short s; /* stored in byte 0 and 1 */
char c; /* stored in byte 2 */
long l; /* stored in byte 4, 5, 6, and 7 */
char c2; /* stored in byte 8 */

} s;
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The following diagram shows the layout in memory:

The alignment of the structure is 2 bytes, and its size is 10 bytes.

PACKED STRUCTURE TYPES 

The #pragma pack directive is used for relaxing the alignment requirements of the 
members of a structure. This will change the way the layout of the structure is 
performed. The members will be placed in the same order as when declared, but there 
might be less pad space between members.

Note: This can result in significantly larger and slower code when accessing members 
of the structure.

Example

#pragma pack(1)
struct {

short s;
char c;
long l;
char c2;

} s;

will be placed: 

For more information, see Rearranging elements in a structure, page 114.

Type qualifiers
According to the ISO/ANSI C standard, volatile and const are type qualifiers.

DECLARING OBJECTS VOLATILE 

There are three main reasons for declaring an object volatile:

● Shared access; the object is shared between several tasks in a multitasking 
environment
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● Trigger access; as for a memory-mapped SFR where the fact that an access occurs 
has an effect

● Modified access; where the contents of the object can change in ways not known to 
the compiler.

Definition of access to volatile objects

The ISO/ANSI standard defines an abstract machine, which governs the behavior of 
accesses to volatile declared objects. In general and in accordance to the abstract 
machine, the compiler:

● Considers each read and write access to an object that has been declared volatile 
as an access

● The unit for the access is either the entire object or, for accesses to an element in a 
composite object—such as an array, struct, class, or union—the element. For 
example:

char volatile a;
a = 5;   /* A write access */
a += 6;  /* First a read then a write access */

● An access to a bitfield is treated as an access to the underlaying type.

However, these rules are not detailed enough to handle the hardware-related 
requirements. The rules specific to the MSP430 IAR C/C++ Compiler are described 
below.

Rules for accesses

In the MSP430 IAR C/C++ Compiler, accesses to volatile declared objects are 
subject to the following rules:

● All accesses are preserved

● All accesses are complete, that is, the whole object is accessed

● All accesses are performed in the same order as given in the abstract machine

● All accesses are atomic, that is, they cannot be interrupted.

The MSP430 IAR C/C++ Compiler adheres to these rules for all 8-bit and 16-bit 
memory accesses. For MSP430X also for all 20-bit memory accesses.

For larger types, all accesses are preserved but it is not guaranteed that all parts of the 
object is accessed.

DECLARING OBJECTS CONST

The const type qualifier is used for indicating that a data object, accessed directly or 
via a pointer, is non-writable. A pointer to const declared data can point to both 
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constant and non-constant objects. It is good programming practice to use const 
declared pointers whenever possible because this improves the compiler’s possibilities 
to optimize the generated code and reduces the risk of application failure due to 
erroneously modified data.

Static and global objects declared const are allocated in ROM.

In C++, objects that require runtime initialization cannot be placed in ROM.

Data types in C++
In C++, all plain C data types are represented in the same way as described earlier in this 
chapter. However, if any Embedded C++ features are used for a type, no assumptions 
can be made concerning the data representation. This means, for example, that it is not 
legal to write assembler code that accesses class members.
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This chapter gives a brief overview of the MSP430 IAR C/C++ Compiler 
extensions to the ISO/ANSI C standard. All extensions can also be used for 
the C++ programming language. More specifically the chapter describes the 
available C language extensions.

Compiler extensions overview
The compiler offers the standard features of ISO/ANSI C as well as a wide set of 
extensions, ranging from features specifically tailored for efficient programming in the 
embedded industry to the relaxation of some minor standards issues.

You can find the extensions available as:

● C/C++ language extensions

For a summary of available language extensions, see C language extensions, page 
180. For reference information about the extended keywords, see the chapter 
Extended keywords. For information about C++, the two levels of support for the 
language, and C++ language extensions; see the chapter Using C++.

● Pragma directives

The #pragma directive is defined by the ISO/ANSI C standard and is a mechanism 
for using vendor-specific extensions in a controlled way to make sure that the source 
code is still portable. 

The compiler provides a set of predefined pragma directives, which can be used for 
controlling the behavior of the compiler, for example how it allocates memory, 
whether it allows extended keywords, and whether it outputs warning messages. 
Most pragma directives are preprocessed, which means that macros are substituted 
in a pragma directive. The pragma directives are always enabled in the compiler and 
many of them have an equivalent C/C++ language extensions. For a list of available 
pragma directives, see the chapter Pragma directives.

● Preprocessor extensions

The preprocessor of the compiler adheres to the ISO/ANSI standard. In addition, the 
compiler also makes a number of preprocessor-related extensions available to you. 
For more information, see the chapter The preprocessor.

● Intrinsic functions

The intrinsic functions provide direct access to low-level processor operations and 
can be very useful in, for example, time-critical routines. The intrinsic functions 
compile into inline code, either as a single instruction or as a short sequence of 
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instructions. To read more about using intrinsic functions, see Mixing C and 
assembler, page 83. For a list of available functions, see the chapter Intrinsic 
functions.

● Library functions

The IAR DLIB Library provides most of the important C and C++ library definitions 
that apply to embedded systems. In addition, the library also provides some 
extensions, partly taken from the C99 standard. For more information, see IAR DLIB 
Library, page 233.

Note: Any use of these extensions, except for the pragma directives, makes your 
application inconsistent with the ISO/ANSI C standard.

ENABLING LANGUAGE EXTENSIONS

In the IAR Embedded Workbench® IDE, language extensions are enabled by default.

For information about how to enable and disable language extensions from the 
command line, see the compiler options -e, page 150, and --strict_ansi, page 166.

C language extensions
This section gives a brief overview of the C language extensions available in the 
MSP430 IAR C/C++ Compiler. The compiler provides a wide set of extensions, so to 
help you to find the extensions required by your application, the extensions have been 
grouped according to their expected usefulness. In short, this means:

● Important language extensions—extensions specifically tailored for efficient 
embedded programming, typically to meet memory restrictions

● Useful language extensions—features considered useful and typically taken from 
related standards, such as C99 and C++

● Minor language extensions, that is, the relaxation of some minor standards issues 
and also some useful but minor syntax extensions.

IMPORTANT LANGUAGE EXTENSIONS

The following language extensions available both in the C and the C++ programming 
languages are well suited for embedded systems programming:

● Memory attributes, type attributes, and object attributes

For information about the related concepts, the general syntax rules, and for 
reference information, see the chapter Extended keywords.
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● Placement at an absolute address or in a named segment

The @ operator or the directive #pragma location can be used for placing global 
and static variables at absolute addresses, or placing a variable or function in a named 
segment. For more information about using these primitives, see Controlling data 
and function placement in memory, page 116, and location, page 207.

● Alignment

Each data type has its own alignment, for more details, see Alignment, page 169. If 
you want to change the alignment, the #pragma pack and #pragma 
data_alignment directives are available. If you want to check the alignment of an 
object, use the __ALIGNOF__() operator.

The __ALIGNOF__ operator is used for accessing the alignment of an object. It takes 
one of two forms:

● __ALIGNOF__ (type)

● __ALIGNOF__ (expression)

In the second form, the expression is not evaluated.

● Anonymous structs and unions

C++ includes a feature named anonymous unions. The compiler allows a similar 
feature for both structs and unions in the C programming language. For more 
information, see Anonymous structs and unions, page 115.

● Bitfields and non-standard types

In ISO/ANSI C, a bitfield must be of type int or unsigned int. Using IAR 
Systems language extensions, any integer type or enumeration may be used. The 
advantage is that the struct will sometimes be smaller. This matches G.5.8 in the 
appendix of the ISO standard, ISO Portability Issues. For more information, see 
Bitfields, page 171.

●  Dedicated segment operators __segment_begin and __segment_end

The syntax for these operators is:

 void * __segment_begin(section)
 void * __segment_end(section)

These operators return the address of the first byte of the named segment and the 
first byte after the named segment, respectively. This can be useful if you have used 
the @ operator or the #pragma location directive to place a data object or a function 
in a user-defined segment. 

The named segment must be a string literal that has been declared earlier with the 
#pragma segment directive. If the segment was declared with a memory attribute 
memattr, the type of the __segment_begin operator is a pointer to memattr void. 
Otherwise, the type is a default pointer to void. Note that you must have enabled 
language extensions to use these operators.
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In the following example, the type of the __segment_begin operator is void 
__data16 *.

#pragma segment="MYSEGMENT" __data16
...
segment_start_address = __segment_begin("MYSECTION");

See also segment, page 213, and location, page 207.

USEFUL LANGUAGE EXTENSIONS

This section lists and briefly describes useful extensions, that is, useful features typically 
taken from related standards, such as C99 and C++:

● Inline functions

The #pragma inline directive, alternatively the inline keyword, advises the 
compiler that the function whose declaration follows immediately after the directive 
should be inlined. This is similar to the C++ keyword inline. For more information, 
see inline, page 206.

● Mixing declarations and statements

It is possible to mix declarations and statements within the same scope. This feature 
is part of the C99 standard and C++.

● Declaration in for loops

It is possible to have a declaration in the initialization expression of a for loop, for 
example:

for (int i = 0; i < 10: ++i)
{...}

This feature is part of the C99 standard and C++.

● The bool data type

To use the bool type in C source code, you must include the file stdbool.h. This 
feature is part of the C99 standard and C++. (The bool data type is supported by 
default in C++.)

● C++ style comments

C++ style comments are accepted. A C++ style comment starts with the character 
sequence // and continues to the end of the line. For example:

// The length of the bar, in centimeters.
int length;

This feature is copied from the C99 standard and C++.

Inline assembler

Inline assembler can be used for inserting assembler instructions in the generated 
function. This feature is part of the C99 standard and C++. 
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The asm and __asm extended keywords both insert an assembler instruction. However, 
when compiling C source code, the asm keyword is not available when the option 
--strict_ansi is used. The __asm keyword is always available.

Note: Not all assembler directives or operators can be inserted using this keyword.

The syntax is:

asm ("string");

The string can be a valid assembler instruction or a data definition assembler directive, 
but not a comment. You can write several consecutive inline assembler instructions, for 
example:

asm ("Label: nop\n"
     " jmp Label");

where \n (new line) separates each new assembler instruction. Note that you can define 
and use local labels in inline assembler instructions.

For more information about inline assembler, see Mixing C and assembler, page 83.

Compound literals

To create compound literals you can use the following syntax:

/* Create a pointer to an anonymous array */
int *p = (int []) {1,2,3};

/* Create a pointer to an anonymous structX */
structX *px = &(structX) {5,6,7};

Note:

● A compound literal can be modified unless it is declared const

● Compound literals are not supported in Embedded C++ and Extended EC++.

● This feature is part of the C99 standard.

Incomplete arrays at end of structs

The last element of a struct may be an incomplete array. This is useful because one 
chunk of memory can be allocated for the struct itself and for the array, regardless of 
the size of the array.

Note: The array cannot be the only member of the struct. If that was the case, then 
the size of the struct would be zero, which is not allowed in ISO/ANSI C.

Example

struct str 
C430-7

Part 2. Compiler reference 183



184

C language extensions
{
  char a;
  unsigned long b[];
};

struct str * GetAStr(int size)
{
  return malloc(sizeof(struct str) +
                sizeof(unsigned long) * size);
}

void UseStr(struct str * s)
{
  s->b[10] = 0;
}

The struct will inherit the alignment requirements from all elements, including the 
alignment of the incomplete array. The array itself will not be included in the size of the 
struct. However, the alignment requirements will ensure that the struct will end exactly 
at the beginning of the array; this is known as padding.

In the example, the alignment of struct str will be 4 and the size is also 4. (Assuming 
a processor where the alignment of unsigned long is 4.)

The memory layout of struct str is described in the following figure.

This feature is part of the C99 standard.

Hexadecimal floating-point constants 

Floating-point constants can be given in hexadecimal style. The syntax is 
0xMANTp{+|-}EXP, where MANT is the mantissa in hexadecimal digits, including an 
optional . (decimal point), and EXP is the exponent with decimal digits, representing an 
exponent of 2. This feature is part of the C99 standard.

Examples

0x1p0 is 1

0xA.8p2 is 10.5*2^2
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Designated initializers in structures and arrays

Any initialization of either a structure (struct or union) or an array can have a 
designation. A designation consists of one or more designators followed by an 
initializer. A designator for a structure is specified as .elementname and for an array 
[constant index expression]. Using designated initializers is not supported in 
C++.

Examples

The following definition shows a struct and its initialization using designators:

struct{
  int i;
  int j;
  int k;
  int l;
  short array[10]
} x = {
  .l.j = 6,      /* initialize l and j to 6 */
  8,             /* initialize k to 8 */
  {[7][3] = 2,   /* initialize element 7 and 3 to 2 */
  5}             /* initialize element 4 to 5 */
  .k = 4         /* reinitialize k to 4 */ 
};

Note that a designator specifies the destination element of the initialization. Note also 
that if one element is initialized more than once, it is the last initialization that will be 
used.

To initialize an element in a union other than the first, do like this:

union{
  int i;
  float f;
}y = {.f = 5.0};

To set the size of an array by initializing the last element, do like this:

char array[] = {[10] = ‘a’};
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MINOR LANGUAGE EXTENSIONS

This section lists and briefly describes minor extensions, that is, the relaxation of some 
standards issues and also some useful but minor syntax extensions:

● Arrays of incomplete types

An array may have an incomplete struct, union, or enum type as its element type. 
The types must be completed before the array is used (if it is), or by the end of the 
compilation unit (if it is not).

● Forward declaration of enum types

The IAR Systems language extensions allow that you first declare the name of an 
enum and later resolve it by specifying the brace-enclosed list.

● Missing semicolon at end of struct or union specifier

A warning is issued if the semicolon at the end of a struct or union specifier is 
missing.

● Null and void

In operations on pointers, a pointer to void is always implicitly converted to another 
type if necessary, and a null pointer constant is always implicitly converted to a null 
pointer of the right type if necessary. In ISO/ANSI C, some operators allow such 
things, while others do not allow them.

● Casting pointers to integers in static initializers

In an initializer, a pointer constant value may be cast to an integral type if the integral 
type is large enough to contain it. For more information about casting pointers, see 
Casting, page 174.

● Taking the address of a register variable

In ISO/ANSI C, it is illegal to take the address of a variable specified as a register 
variable. The compiler allows this, but a warning is issued.

● Duplicated size and sign specifiers

Should the size or sign specifiers be duplicated (for example, short short or 
unsigned unsigned), an error is issued. 

● long float means double

The type long float is accepted as a synonym for double.

● Repeated typedef declarations

Redeclarations of typedef that occur in the same scope are allowed, but a warning 
is issued.

● Mixing pointer types

Assignment and pointer difference is allowed between pointers to types that are 
interchangeable but not identical; for example, unsigned char * and char *. This 
includes pointers to integral types of the same size. A warning is issued.
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Assignment of a string constant to a pointer to any kind of character is allowed, and 
no warning will be issued.

● Non-top level const

Assignment of pointers is allowed in cases where the destination type has added type 
qualifiers that are not at the top level (for example, int ** to int const **). 
Comparing and taking the difference of such pointers is also allowed.

● Non-lvalue arrays

A non-lvalue array expression is converted to a pointer to the first element of the 
array when it is used.

● Comments at the end of preprocessor directives

This extension, which makes it legal to place text after preprocessor directives, is 
enabled, unless strict ISO/ANSI mode is used. The purpose of this language 
extension is to support compilation of legacy code; we do not recommend that you 
write new code in this fashion.

● An extra comma at the end of enum lists

Placing an extra comma is allowed at the end of an enum list. In strict ISO/ANSI 
mode, a warning is issued.

● A label preceding a }

In ISO/ANSI C, a label must be followed by at least one statement. Therefore, it is 
illegal to place the label at the end of a block. In the MSP430 IAR C/C++ Compiler, 
a warning is issued.

Note: This also applies to the labels of switch statements. 

● Empty declarations

An empty declaration (a semicolon by itself) is allowed, but a remark is issued 
(provided that remarks are enabled).

● Single-value initialization

ISO/ANSI C requires that all initializer expressions of static arrays, structs, and 
unions are enclosed in braces. 

Single-value initializers are allowed to appear without braces, but a warning is 
issued. In the MSP430 IAR C/C++ Compiler, the following expression is allowed:

struct str
{
  int a;
} x = 10;

● Declarations in other scopes

External and static declarations in other scopes are visible. In the following example, 
the variable y can be used at the end of the function, even though it should only be 
visible in the body of the if statement. A warning is issued.
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C language extensions
int test(int x)
{
  if (x)
  {
    extern int y;
    y = 1;
  }

  return y;
}

● Expanding function names into strings with the function as context

Use any of the symbols __func__ or __FUNCTION__ inside a function body to 
make it expand into a string, with the function name as context. Use the symbol 
__PRETTY_FUNCTION__ to also include the parameter types and return type. The 
result might, for example, look like this if you use the __PRETTY_FUNCTION__ 
symbol: 

"void func(char)"

These symbols are useful for assertions and other trace utilities and they require that 
language extensions are enabled, see -e, page 150.
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This chapter describes the extended keywords that support specific features 
of the MSP430 microcontroller and the general syntax rules for the keywords. 
Finally the chapter gives a detailed description of each keyword.

For information about the address ranges of the different memory areas, see 
the chapter Segment reference.

General syntax rules for extended keywords
To understand the syntax rules for the extended keywords, it is important to be familiar 
with some related concepts.

The MSP430 IAR C/C++ Compiler provides a set of attributes that can be used on 
functions or data objects to support specific features of the MSP430 microcontroller. 
There are two types of attributes—type attributes and object attributes:

● Type attributes affect the external functionality of the data object or function

● Object attributes affect the internal functionality of the data object or function.

The syntax for the keywords differs slightly depending on whether it is a type attribute 
or an object attribute, and whether it is applied to a data object or a function.

For information about how to use attributes to modify data, see the chapter Data storage. 
For detailed information about each attribute, see Descriptions of extended keywords, 
page 193.

Note: The extended keywords are only available when language extensions are enabled 
in the MSP430 IAR C/C++ Compiler.

In the IAR Embedded Workbench IDE, language extensions are enabled by default.

Use the -e compiler option to enable language extensions. See -e, page 150 for 
additional information.

TYPE ATTRIBUTES

Type attributes define how a function is called, or how a data object is accessed. This 
means that if you use a type attribute, it must be specified both when a function or data 
object is defined and when it is declared.

You can either place the type attributes directly in your source code, or use the pragma 
directive #pragma type_attribute.
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General syntax rules for extended keywords
Type attributes can be further divided into memory attributes and general type 
attributes. 

Memory attributes

A memory attribute corresponds to a certain logical or physical memory in the 
microcontroller.

Available data memory attributes: __data16, __data20, and __regvar

Data objects, functions, and destinations of pointers or C++ references always have a 
memory attribute. If no attribute is explicitly specified in the declaration or by the 
pragma directive #pragma type_attribute, an appropriate default attribute is used. 
You can only specify one memory attribute for each level of pointer indirection.

General type attributes

The following general type attributes are available:

● Function type attributes affect how the function should be called: __interrupt, 
__monitor, __task, __cc_version1, and __cc_version2

● Data type attributes: const and volatile

You can specify as many type attributes as required for each level of pointer indirection.

To read more about the type qualifiers const and volatile, see Type qualifiers, page 
176.

Syntax for type attributes used on data objects

In general, type attributes for data objects follow the same syntax as the type qualifiers 
const and volatile.

The following declaration assigns the __data20 type attribute to the variables i and j; 
in other words, the variable i and j is placed in data20 memory. The variables k and l 
behave in the same way:

__data20 int i, j;
int __data20 k, l;

Note that the attribute affects both identifiers.

The following declaration of i and j is equivalent with the previous one:

#pragma type_attribute=__data20
int i, j;

The advantage of using pragma directives for specifying keywords is that it offers you a 
method to make sure that the source code is portable. Note that the pragma directive has 
no effect if a memory attribute is already explicitly declared.
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For more examples of using memory attributes, see More examples, page 19.

An easier way of specifying storage is to use type definitions. The following two 
declarations are equivalent:

typedef char __data20 Byte;
typedef Byte *BytePtr;
Byte b;
BytePtr bp; 

and

__data20 char b;
char __data20 *bp;

Note that #pragma type_attribute can be used together with a typedef 
declaration.

Syntax for type attributes on data pointers

The syntax for declaring pointers using type attributes follows the same syntax as the 
type qualifiers const and volatile:

Syntax for type attributes on functions

The syntax for using type attributes on functions, differs slightly from the syntax of type 
attributes on data objects. For functions, the attribute must be placed either in front of 
the return type, alternatively in parentheses, for example:

__interrupt void my_handler(void);

or

void (__interrupt my_handler)(void);

The following declaration of my_handler is equivalent with the previous one:

#pragma type_attribute=__interrupt
void my_handler(void);

OBJECT ATTRIBUTES 

Object attributes affect the internal functionality of functions and data objects, but not 
how the function is called or how the data is accessed. This means that an object attribute 
does not need to be present in the declaration of an object.

int __data20 * p; The int object is located in __data20 memory.

int * __data20 p; The pointer is located in __data20 memory.

__data20 int * p; The pointer is located in __data20 memory.
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Summary of extended keywords
The following object attributes are available:

● Object attributes that can be used for variables: __no_init

● Object attributes that can be used for functions and variables: location, @, and 
__root

● Object attributes that can be used for functions: __intrinsic, __noreturn, 
__raw, __save_reg20, and vector.

You can specify as many object attributes as required for a specific function or data 
object.

For more information about location and @, see Controlling data and function 
placement in memory, page 116. For more information about vector, see vector, page 
214.

Syntax for object attributes

The object attribute must be placed in front of the type. For example, to place myarray 
in memory that is not initialized at startup:

__no_init int myarray[10]; 

The #pragma object_attribute directive can also be used. The following 
declaration is equivalent to the previous one:

#pragma object_attribute=__no_init
int myarray[10];

Note: Object attributes cannot be used in combination with the typedef keyword.

Summary of extended keywords
The following table summarizes the extended keywords:

Extended keyword Description

__cc_version1 Specifies the Version1 calling convention

__cc_version2 Specifies the Version2 calling convention

__data16 Controls the storage of data objects

__data20 Controls the storage of data objects

__interrupt Supports interrupt functions

__intrinsic Reserved for compiler internal use only

__monitor Supports atomic execution of a function

__no_init Supports non-volatile memory

Table 33: Extended keywords summary
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Descriptions of extended keywords
The following sections give detailed information about each extended keyword.

__cc_version1

Syntax Follows the generic syntax rules for type attributes that can be used on functions, see 
Type attributes, page 189.

Description The __cc_version1 keyword is available for backward compatibility of the interface 
for calling assembler routines from C. It makes a function use the calling convention of 
the MSP430 IAR C/C++ Compiler version 1.x, 2.x, and 3.x instead of the default calling 
convention.

Example __cc_version1 int func(int arg1, double arg2)

See also Calling convention, page 85.

__cc_version2

Syntax Follows the generic syntax rules for type attributes that can be used on functions, see 
Type attributes, page 189.

Description The __cc_version2 keyword sets the default calling convention of the interface for 
calling assembler routines from C. It makes a function use the calling convention of the 
MSP430 IAR C/C++ Compiler version 4.x.

Example __cc_version2 int func(int arg1, double arg2)

__noreturn Informs the compiler that the declared function will not 
return

__raw Prevents saving used registers in interrupt functions

__regvar Permanently places a variable in a specified register

__root Ensures that a function or variable is included in the object 
code even if unused

__save_reg20 Saves and restores all 20 bits in 20-bit registers

__task Allows functions to exit without restoring registers

Extended keyword Description

Table 33: Extended keywords summary (Continued)
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Descriptions of extended keywords
See also Calling convention, page 85.

__data16

Syntax Follows the generic syntax rules for memory type attributes that can be used on data 
objects, see Type attributes, page 189.

Description The __data16 memory attribute explicitly places individual variables and constants in 
data16 memory, which is the entire 64 Kbytes of memory in the MSP430 architecture 
and the lower 64 Kbytes in the MSP430X architecture. You can also use the __data16 
attribute to create a pointer explicitly pointing to an object located in the data16 memory.

Storage information ● Address range: 0–0xFFFF (64 Kbytes)
● Maximum object size: 65535 bytes
● Pointer size: 2 bytes

Example __data16 int x;

See also Memory types (MSP430X only), page 15.

__data20

Syntax Follows the generic syntax rules for memory type attributes that can be used on data 
objects, see Type attributes, page 189.

Description The __data20 memory attribute explicitly places individual variables and constants in 
data20 memory, which is the entire 1 Mbyte of memory in the MSP430X architecture. 
You can also use the __data20 attribute to create a pointer explicitly pointing to an 
object located in the data20 memory. The __data20 attribute cannot be used in the 
Small data model.

Storage information ● Address range: 0–0xFFFFF (1 Mbyte)
● Maximum object size: 0xFFFFF bytes
● Pointer size: 20 bits in register, 4 bytes in memory

Example __data20 int x;

See also Memory types (MSP430X only), page 15.
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__interrupt

Syntax Follows the generic syntax rules for type attributes that can be used on functions, see 
Type attributes, page 189.

Description The __interrupt keyword specifies interrupt functions. To specify one or several 
interrupt vectors, use the #pragma vector directive. The range of the interrupt vectors 
depends on the device used. It is possible to define an interrupt function without a vector, 
but then the compiler will not generate an entry in the interrupt vector table.

An interrupt function must have a void return type and cannot have any parameters.

The header file iodevice.h, where device corresponds to the selected device, 
contains predefined names for the existing interrupt vectors.

Example #pragma vector=0x14
__interrupt void my_interrupt_handler(void);

See also Interrupt functions, page 23, vector, page 214, INTVEC, page 248. 

__intrinsic

Description The __intrinsic keyword is reserved for compiler internal use only.

__monitor

Syntax Follows the generic syntax rules for type attributes that can be used on functions, see 
Type attributes, page 189.

Description The __monitor keyword causes interrupts to be disabled during execution of the 
function. This allows atomic operations to be performed, such as operations on 
semaphores that control access to resources by multiple processes. A function declared 
with the __monitor keyword is equivalent to any other function in all other respects.

Example __monitor int get_lock(void);

See also Monitor functions, page 26. Read also about the intrinsic functions __disable_interrupt, 
page 220, __enable_interrupt, page 220, __get_interrupt_state, page 221, and 
__set_interrupt_state, page 223.
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Descriptions of extended keywords
__no_init

Syntax Follows the generic syntax rules for object attributes, see Object attributes, page 191.

Description Use the  __no_init keyword to place a data object in non-volatile memory. This means 
that the initialization of the variable, for example at system startup, is suppressed. 

Example __no_init int myarray[10];

__noreturn

Syntax Follows the generic syntax rules for object attributes, see Object attributes, page 191.

Description The __noreturn keyword can be used on a function to inform the compiler that the 
function will not return. If you use this keyword on such functions, the compiler can 
optimize more efficiently. Examples of functions that do not return are abort and exit.

Example __noreturn void terminate(void);

__raw

Syntax Follows the generic syntax rules for object attributes, see Object attributes, page 191.

Description This keyword prevents saving used registers in interrupt functions.

Interrupt functions preserve the contents of all used processor registers at function 
entrance and restore them at exit. However, for some very special applications, it can be 
desirable to prevent the registers from being saved at function entrance. This can be 
accomplished by the use of the keyword __raw.

Example __raw __interrupt void my_interrupt_function()

__regvar

Syntax Follows the generic syntax rules for type attributes, see Type attributes, page 189.

Description This keyword is used for declaring that a global or static variable should be placed 
permanently in the specified register. The registers R4–R5 can be used for this purpose, 
provided that they have been reserved with one of the --regvar_r4 or --regvar_r5 
compiler options.
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The __regvar attribute can be used on integer types, pointers, 32-bit floating-point 
numbers, structures with one element and unions of all these. However, it is not possible 
to point to an object that has been declared __regvar. An object declared __regvar 
cannot have an initial value.

Note: If a module in your application has been compiled using --regvar_r4, it can 
only be linked with modules that have been compiled with either --regvar_r4 or 
--lock_r4. The same is true for --regvar_r5/--lock_r5.

Example To declare a global register variable, use the following syntax:

__regvar __no_init type variable_name @ location

where location is either __R4 or __R5, declared in intrinsics.h.

This will create a variable called variable_name of type type, located in register R4 
or R5, for example:

__regvar __no_init int counter @ __R4;

See also --regvar_r4, page 164 and --regvar_r5, page 164.

__root

Syntax Follows the generic syntax rules for object attributes, see Object attributes, page 191.

Description A function or variable with the __root attribute is kept whether or not it is referenced 
from the rest of the application, provided its module is included. Program modules are 
always included and library modules are only included if needed.

Example __root int myarray[10];

See also To read more about modules, segments, and the link process, see the IAR Linker and 
Library Tools Reference Guide.

__save_reg20

Syntax Follows the generic syntax rules for object attributes, see Object attributes, page 191.

Description When compiling for the MSP430X architecture in the Small data model, use this 
keyword to save and restore all 20 bits of the registers that are used, instead of only 16 
bits, which are saved and restored by normal functions. This keyword will make the 
function save all registers and not only the ones used by the function to guarantee that 
20-bit registers are not destroyed by subsequent calls.
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Descriptions of extended keywords
This may be necessary if the function is called from assembler routines that use the 
upper 4 bits of the 20-bit registers.

Note: The __save_reg20 keyword has only effect when compiling for the MSP430X 
architecture.

Example __save_reg20 void myFunction(void);

See also Interrupt functions for the MSP430X architecture, page 26

__task

Syntax Follows the generic syntax rules for type attributes that can be used on functions, see 
Type attributes, page 189.

Description This keyword allows functions to exit without restoring registers and it is typically used 
for the main function. 

By default, functions save the contents of used non-scratch registers (permanent 
registers) on the stack upon entry, and restore them at exit. Functions declared __task 
do not save any registers, and therefore require less stack space. Such functions should 
only be called from assembler routines.

The function main may be declared __task, unless it is explicitly called from the 
application. In real-time applications with more than one task, the root function of each 
task may be declared __task.

Example __task void my_handler(void);
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This chapter describes the pragma directives of the MSP430 IAR C/C++ 
Compiler.

The #pragma directive is defined by the ISO/ANSI C standard and is a 
mechanism for using vendor-specific extensions in a controlled way to make 
sure that the source code is still portable. 

The pragma directives control the behavior of the compiler, for example how 
it allocates memory for variables and functions, whether it allows extended 
keywords, and whether it outputs warning messages.

The pragma directives are always enabled in the compiler.

Summary of pragma directives
The following table lists the pragma directives of the compiler that can be used either 
with the #pragma preprocessor directive or the _Pragma() preprocessor operator:

Pragma directive Description

basic_template_matching Makes a template function fully memory-attribute aware

bis_nmi_ie1 Generates a BIS instruction just before the RETI 
instruction

bitfields Controls the order of bitfield members

constseg Places constant variables in a named segment

data_alignment Gives a variable a higher (more strict) alignment

dataseg Places variables in a named segment

diag_default Changes the severity level of diagnostic messages

diag_error Changes the severity level of diagnostic messages

diag_remark Changes the severity level of diagnostic messages

diag_suppress Suppresses diagnostic messages

diag_warning Changes the severity level of diagnostic messages

include_alias Specifies an alias for an include file

inline Inlines a function

Table 34: Pragma directives summary
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Descriptions of pragma directives
Note: For portability reasons, see also Recognized pragma directives (6.8.6), page 257.

Descriptions of pragma directives
This section gives detailed information about each pragma directive.

basic_template_matching

Syntax #pragma basic_template_matching

Description Use this pragma directive in front of a template function declaration to make the 
function fully memory-attribute aware, in the rare cases where this is useful. That 
template function will then match the template without the modifications described in 
Templates and data memory attributes, page 108.

Example #pragma basic_template_matching
template<typename T> void fun(T *);

fun((int __data16 *) 0); /* Template parameter T becomes
                          int __data16 */

language Controls the IAR Systems language extensions

location Specifies the absolute address of a variable, or places groups 
of functions or variables in named segments

message Prints a message 

no_epilogue Performs a local return sequence

object_attribute Changes the definition of a variable or a function

optimize Specifies the type and level of an optimization

pack Specifies the alignment of structures and union members

required Ensures that a symbol that is needed by another symbol is 
included in the linked output

rtmodel Adds a runtime model attribute to the module

segment Declares a segment name to be used by intrinsic functions

type_attribute Changes the declaration and definitions of a variable or 
function

vector Specifies the vector of an interrupt or trap function

Pragma directive Description

Table 34: Pragma directives summary (Continued)
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bis_nmi_ie1

Syntax #pragma bis_nmi_ie1=mask

Parameters

Description Use this pragma directive for changing the interrupt control bits in the register IE, within 
an NMI service routine. A BIS.W #mask, IE1 instruction is generated right before the 
RETI instruction at the end of the function, after any POP instructions.

The effect is that NMI interrupts cannot occur until after the BIS instruction. The 
advantage of placing it at the end of the POP instructions is that less stack will be used 
in the case of nested interrupts.

Example In the following example, the OFIE bit will be set as the last instruction before the RETI 
instruction:

#pragma bis_nmi_ie1=OFIE
#pragma vector=NMI_VECTOR
__interrupt void myInterruptFunction(void)
{
...
}

bitfields

Syntax #pragma bitfields={reversed|default}

Parameters

Description Use this pragma directive to control the order of bitfield members. 

By default, the MSP430 IAR C/C++ Compiler places bitfield members from the least 
significant bit to the most significant bit in the container type. Use the 
#pragma bitfields=reversed directive to place the bitfield members from the 
most significant to the least significant bit. This setting remains active until you turn it 
off again with the #pragma bitfields=default directive.

See also Bitfields, page 171.

mask A constant expression

reversed Bitfield members are placed from the most significant bit to the 
least significant bit.

default Bitfield members are placed from the least significant bit to the 
most significant bit.
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Descriptions of pragma directives
constseg

Syntax #pragma constseg=[__memoryattribute ]{SEGMENT_NAME|default}

Parameters

Description Use this pragma directive to place constant variables in a named segment. The segment 
name cannot be a segment name predefined for use by the compiler and linker. The 
setting remains active until you turn it off again with the #pragma constseg=default 
directive.

Example #pragma constseg=__data20 MY_CONSTANTS
const int factorySettings[] = {42, 15, -128, 0};
#pragma constseg=default

data_alignment

Syntax #pragma data_alignment=expression

Parameters

Description Use this pragma directive to give a variable a higher (more strict) alignment than it 
would otherwise have. It can be used on variables with static and automatic storage 
duration.

When you use this directive on variables with automatic storage duration, there is an 
upper limit on the allowed alignment for each function, determined by the calling 
convention used.

__memoryattribute An optional memory attribute denoting in what memory the 
segment will be placed; if not specified, default memory is used.

SEGMENT_NAME A user-defined segment name; cannot be a segment name 
predefined for use by the compiler and linker.

default Uses the default segment for constants.

expression A constant which must be a power of two (1, 2, 4, etc.).
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dataseg

Syntax #pragma dataseg=[__memoryattribute ]{SEGMENT_NAME|default}

Parameters

Description Use this pragma directive to place variables in a named segment. The segment name 
cannot be a segment name predefined for use by the compiler and linker. The variable 
will not be initialized at startup, and can for this reason not have an initializer, which 
means it must be declared __no_init. The setting remains active until you turn it off 
again with the #pragma constseg=default directive.

Example #pragma dataseg=__data20 MY_SEGMENT 
__no_init char myBuffer[1000];
#pragma dataseg=default

diag_default

Syntax #pragma diag_default=tag[,tag,...]

Parameters

Description Use this pragma directive to change the severity level back to default, or to the severity 
level defined on the command line by using any of the options --diag_error, 
--diag_remark, --diag_suppress, or --diag_warnings, for the diagnostic 
messages specified with the tags.

See also Diagnostics, page 136.

__memoryattribute An optional memory attribute denoting in what memory the 
segment will be placed; if not specified, default memory is used.

SEGMENT_NAME A user-defined segment name; cannot be a segment name 
predefined for use by the compiler and linker.

default Uses the default segment.

tag The number of a diagnostic message, for example the message 
number Pe117
C430-7

Part 2. Compiler reference 203



204

Descriptions of pragma directives
diag_error

Syntax #pragma diag_error=tag[,tag,...]

Parameters

Description Use this pragma directive to change the severity level to error for the specified 
diagnostics.

See also Diagnostics, page 136.

diag_remark

Syntax #pragma diag_remark=tag[,tag,...]

Parameters

Description Use this pragma directive to change the severity level to remark for the specified 
diagnostic messages. 

See also Diagnostics, page 136.

diag_suppress

Syntax #pragma diag_suppress=tag[,tag,...]

Parameters

Description Use this pragma directive to suppress the specified diagnostic messages. 

See also Diagnostics, page 136.

tag The number of a diagnostic message, for example the message 
number Pe117

tag The number of a diagnostic message, for example the message 
number Pe177

tag The number of a diagnostic message, for example the message 
number Pe117
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diag_warning

Syntax #pragma diag_warning=tag[,tag,...]

Parameters

Description Use this pragma directive to change the severity level to warning for the specified 
diagnostic messages. 

See also Diagnostics, page 136.

include_alias

Syntax #pragma include_alias "orig_header" "subst_header"
#pragma include_alias <orig_header> <subst_header>

Parameters

Description Use this pragma directive to provide an alias for a header file. This is useful for 
substituting one header file with another, and for specifying an absolute path to a relative 
file.

This pragma directive must appear before the corresponding #include directives and 
subst_header must match its corresponding #include directive exactly.

Example #pragma include_alias <stdio.h> <C:\MyHeaders\stdio.h>
#include <stdio.h>

This example will substitute the relative file stdio.h with a counterpart located 
according to the specified path.

See also Include file search procedure, page 134.

tag The number of a diagnostic message, for example the message 
number Pe826

orig_header The name of a header file for which you want to create an alias.

subst_header The alias for the original header file.
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Descriptions of pragma directives
inline

Syntax #pragma inline[=forced]

Parameters

Description Use this pragma directive to advise the compiler that the function whose declaration 
follows immediately after the directive should be inlined—that is, expanded into the 
body of the calling function. Whether the inlining actually takes place is subject to the 
compiler’s heuristics.

This is similar to the C++ keyword inline, but has the advantage of being available in 
C code.

Specifying #pragma inline=forced disables the compiler’s heuristics and forces 
inlining. If the inlining fails for some reason, for example if it cannot be used with the 
function type in question (like printf), an error message is emitted.

Note: Because specifying #pragma inline=forced disables the compiler’s 
heuristics, including the inlining heuristics, the function declared immediately after the 
directive will not be inlined on optimization levels 0–3. No error or warning message 
will be emitted.

language

Syntax #pragma language={extended|default}

Parameters

Description Use this pragma directive to enable the compiler language extensions or for using the 
language settings specified on the command line.

forced Disables the compiler’s heuristics and forces inlining.

extended Turns on the IAR Systems language extensions and turns off the 
--strict_ansi command line option.

default Uses the language settings specified by compiler options.
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location

Syntax #pragma location={address|NAME}

Parameters

Description Use this pragma directive to specify the location—the absolute address—of the global 
or static variable whose declaration follows the pragma directive. The variable must be 
declared either __no_init or const. Alternatively, the directive can take a string 
specifying a segment for placing either a variable or a function whose declaration 
follows the pragma directive.

Example #pragma location=0x22E
__no_init volatile char PORT1; /* PORT1 is located at address
                                  0x22E */

#pragma location="foo" 
char PORT1; /* PORT1 is located in segment foo */

/* A better way is to use a corresponding mechanism */
#define FLASH _Pragma("location=\"FLASH\"")
...
FLASH int i; /* i is placed in the FLASH segment */

See also Controlling data and function placement in memory, page 116.

message

Syntax #pragma message(message)

Parameters

Description Use this pragma directive to make the compiler print a message to stdout when the file 
is compiled. 

Example: #ifdef TESTING
#pragma message("Testing")
#endif

address The absolute address of the global or static variable for which you 
want an absolute location.

NAME A user-defined segment name; cannot be a segment name 
predefined for use by the compiler and linker.

message The message that you want to direct to stdout.
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no_epilogue

Syntax #pragma no_epilogue

Description Use this pragma directive to use a local return sequence instead of a call to the library 
routine ?EpilogueN. This pragma directive can be used when a function needs to exist 
on its own as in for example a bootloader that needs to be independent of the libraries it 
is replacing.

Example #pragma no_epilogue
void bootloader(void) @"BOOTSECTOR"
{...

object_attribute

Syntax #pragma object_attribute=object_attribute[,object_attribute,...]

Parameters For a list of object attributes that can be used with this pragma directive, see Object 
attributes, page 191.

Description Use this pragma directive to declare a variable or a function with an object attribute. This 
directive affects the definition of the identifier that follows immediately after the 
directive. The object is modified, not its type. Unlike the directive #pragma 
type_attribute that specifies the storing and accessing of a variable or function, it is 
not necessary to specify an object attribute in declarations.

Example #pragma object_attribute=__no_init 
char bar; 

See also General syntax rules for extended keywords, page 189.

optimize

Syntax #pragma optimize=param[ param...]

Parameters
balanced|size|speed Optimizes balanced between speed and size, 

optimizes for size, or optimizes for speed

none|low|medium|high Specifies the level of optimization

no_code_motion Turns off code motion

no_cse Turns off common subexpression elimination
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MSP430 IAR C/C++ Compiler
Reference Guide



Pragma directives
Description Use this pragma directive to decrease the optimization level, or to turn off some specific 
optimizations. This pragma directive only affects the function that follows immediately 
after the directive.

The parameters speed, size, and balanced only have effect on the high optimization 
level and only one of them can be used as it is not possible to optimize for speed and size 
at the same time. It is also not possible to use preprocessor macros embedded in this 
pragma directive. Any such macro will not be expanded by the preprocessor.

Note: If you use the #pragma optimize directive to specify an optimization level that 
is higher than the optimization level you specify using a compiler option, the pragma 
directive is ignored.

Example #pragma optimize=speed
int small_and_used_often()
{
    ...
}

#pragma optimize=size no_inline
int big_and_seldom_used()
{
    ...
}

pack 

Syntax #pragma pack(n)
#pragma pack()
#pragma pack({push|pop}[,name] [,n])

Parameters

no_inline Turns off function inlining

no_tbaa Turns off type-based alias analysis

no_unroll Turns off loop unrolling

n Sets an optional structure alignment; one of: 1, 2, 4, 8, or 16

Empty list Restores the structure alignment to default

push Sets a temporary structure alignment

pop Restores the structure alignment from a temporarily pushed 
alignment
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Description Use this pragma directive to specify the alignment of structs and union members.

The #pragma pack directive affects declarations of structures following the pragma 
directive to the next #pragma pack or end of file.

Note that accessing an object that is not aligned at its correct alignment requires code 
that is both larger and slower than the code needed to access the same kind of object 
when aligned correctly. If there are many accesses to such fields in the program, it is 
usually better to construct the correct values in a struct that is not packed, and access this 
instead.

Also, special care is needed when creating and using pointers to misaligned fields. For 
direct access to misaligned fields in a packed struct, the compiler will emit the correct 
(but slower and larger) code when needed. However, when a misaligned field is accessed 
through a pointer to the field, the normal (smaller and faster) code for accessing the type 
of the field is used. In the general case, this will not work.

Example 1 This example declares a structure without using the #pragma pack directive:

struct First
{
  char alpha;
  short beta;
};

In this example, the structure First is not packed and has the following memory layout:

Note that one pad byte has been added.

Example 2 This example declares a similar structure using the #pragma pack directive:

#pragma pack(1)

struct FirstPacked
{
  char alpha;
  short beta;
};

#pragma pack()

name An optional pushed or popped alignment label

alpha beta

1 byte 2 bytes1 byte
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In this example, the structure FirstPacked is packed and has the following memory 
layout:

Example 3 This example declares a new structure, Second, that contains the structure 
FirstPacked declared in the previous example. The declaration of Second is not 
placed inside a #pragma pack block:

struct Second
{
  struct FirstPacked first;
  short gamma;
};

The following memory layout is used:

Note that the structure FirstPacked will use the memory layout, size, and alignment 
described in Example 2. The alignment of the member gamma is 2, which means that 
alignment of the structure Second will become 2 and one pad byte will be added.

required

Syntax #pragma required=symbol

Parameters

Description Use this pragma directive to ensure that a symbol which is needed by a second symbol 
is included in the linked output. The directive must be placed immediately before the 
second symbol.

Use the directive if the requirement for a symbol is not otherwise visible in the 
application, for example if a variable is only referenced indirectly through the segment 
it resides in.

alpha beta

1 byte 2 bytes

first.alpha first.beta

1 byte 2 bytes 1 byte 2 bytes

gamma

symbol Any statically linked function or variable.
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Descriptions of pragma directives
Example const char copyright[] = "Copyright by me";
...
#pragma required=copyright
int main[]
{...}

Even if the copyright string is not used by the application, it will still be included by the 
linker and available in the output.

rtmodel

Syntax #pragma rtmodel="key","value"

Parameters

Description Use this pragma directive to add a runtime model attribute to a module, which can be 
used by the linker to check consistency between modules.

This pragma directive is useful for enforcing consistency between modules. All modules 
that are linked together and define the same runtime attribute key must have the same 
value for the corresponding key, or the special value *. It can, however, be useful to state 
explicitly that the module can handle any runtime model.

A module can have several runtime model definitions.

Note: The predefined compiler runtime model attributes start with a double underscore. 
In order to avoid confusion, this style must not be used in the user-defined attributes. 

Example #pragma rtmodel="I2C","ENABLED"

The linker will generate an error if a module that contains this definition is linked with 
a module that does not have the corresponding runtime model attributes defined.

See also Checking module consistency, page 71.

"key" A text string that specifies the runtime model attribute.

"value" A text string that specifies the value of the runtime model attribute. 
Using the special value * is equivalent to not defining the attribute at 
all.
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segment

Syntax #pragma segment="NAME" [__memoryattribute] [align]

Parameters

Description Use this pragma directive to define a segment name that can be used by the segment 
operators __segment_begin and __segment_end. All segment declarations for a 
specific segment must have the same memory type attribute and alignment.

If an optional memory attribute is used, the return type of the segment operators 
__segment_begin and __segment_end is:

void __memoryattribute *.

Example #pragma segment="MYSEGMENT" __data16 4

See also Important language extensions, page 180. For more information about segments and 
segment parts, see the chapter Placing code and data.

type_attribute

Syntax #pragma type_attribute=type_attribute[,type_attribute,...]

Parameters For a list of type attributes that can be used with this pragma directive, see Type 
attributes, page 189.

Description Use this pragma directive to specify IAR-specific type attributes, which are not part of 
the ISO/ANSI C language standard. Note however, that a given type attribute may not 
be applicable to all kind of objects.

This directive affects the declaration of the identifier, the next variable, or the next 
function that follows immediately after the pragma directive.

"NAME" The name of the segment 

__memoryattribute An optional memory attribute identifying the memory the segment 
will be placed in; if not specified, default memory is used.

align Specifies an alignment for the segment part. The value must be a 
constant integer expression to the power of two.
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Example In the following example, an int object with the memory attribute __data16 is 
defined:

#pragma type_attribute=__data16
int x;

The following declaration, which uses extended keywords, is equivalent:

__data16 int x;

See also  See the chapter Extended keywords for more details.

vector

Syntax #pragma vector=vector1[, vector2, vector3, ...]

Parameters

Description Use this pragma directive to specify the vector(s) of an interrupt or trap function whose 
declaration follows the pragma directive. Note that several vectors can be defined for 
each function. 

Example! #pragma vector=0x14
__interrupt void my_handler(void);

vector The vector number(s) of an interrupt or trap function.
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This chapter gives reference information about the intrinsic functions, a 
predefined set of functions available in the compiler.

The intrinsic functions provide direct access to low-level processor operations 
and can be very useful in, for example, time-critical routines. The intrinsic 
functions compile into inline code, either as a single instruction or as a short 
sequence of instructions.

Intrinsic functions summary
To use intrinsic functions in an application, include the header file intrinsics.h. 

Note that the intrinsic function names start with double underscores, for example:

__disable_interrupt

The following table summarizes the intrinsic functions:

Intrinsic function Description

__bcd_add_type Performs a binary coded decimal operation

__bic_SR_register Clears bits in the SR register

__bic_SR_register_on_exit Clears bits in the SR register when an 
interrupt or monitor function returns

__bis_SR_register Sets bits in the SR register

__bis_SR_register_on_exit Sets bits in the SR register when an interrupt 
or monitor function returns

__data16_read_addr Reads data to a 20-bit SFR register

__data16_write_addr Writes data to a 20-bit SFR register

__data20_read_type Reads data which has a 20-bit address

__data20_write_type Writes data which has a 20-bit address

__delay_cycles Provides cycle accurate code size minimized 
delay functionality

__disable_interrupt Disables interrupts

__enable_interrupt Enables interrupts

Table 35: Intrinsic functions summary 
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Descriptions of intrinsic functions
Descriptions of intrinsic functions
The following section gives reference information about each intrinsic function.

__bcd_add_type 

Syntax unsigned type __bcd_add_type(unsigned type x, unsigned type y);

where:

__even_in_range Makes switch statements rely on the specified 
value being even and within the specified range

__get_interrupt_state Returns the interrupt state

__get_R4_register Returns the value of the R4 register

__get_R5_register Returns the value of the R5 register

__get_SP_register Returns the value of the stack pointer

__get_SR_register Returns the value of the SR register

__get_SR_register_on_exit Returns the value that the processor status 
register will have when the current interrupt 
or monitor function returns

__low_power_mode_n Enters a MSP430 low power mode

__low_power_mode_off_on_exit Turns off low power mode when a monitor or 
interrupt function returns

__no_operation Inserts a NOP instruction

__op_code Inserts a constant into the instruction stream

__set_interrupt_state Restores the interrupt state

__set_R4_register Writes a specific value to the R4 register

__set_R5_register Writes a specific value to the R5 register

__set_SP_register Writes a specific value to the SP register

__swap_bytes Executes the SWPB instruction

Intrinsic function Description

Table 35: Intrinsic functions summary  (Continued)

type Can be one of the types short, long, or long long
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Description Performs a binary coded decimal addition. The parameters and the return value are 
represented as binary coded decimal (BCD) numbers, that is when a hexadecimal 
number (0x19) is used for representing the decimal number 19. The following functions 
are supported:

Example /* c = 0x19 */
c = __bcd_add_short(c, 0x01);
/* c = 0x20 */

__bic_SR_register

Syntax void __bic_SR_register(unsigned short);

Description Clears bits in the processor status register. The function takes an integer as its argument, 
that is, a bit mask with the bits to be cleared.

__bic_SR_register_on_exit

Syntax void __bic_SR_register_on_exit(unsigned short);

Description Clears bits in the processor status register when an interrupt or monitor function returns. 
The function takes an integer as its argument, that is, a bit mask with the bits to be 
cleared.

This intrinsic function is only available in interrupt and monitor functions.

Function Return value

__bcd_add_short Returns the sum of the two short parameters. The parameters 
and the return value are represented as four-digit BCD numbers.

__bcd_add_long Returns the sum of the two long parameters. The parameters 
and the return value are represented as eight-digit BCD 
numbers.

__bcd_add_long_long Returns the sum of the two long long parameters. The 
parameters and the return value are represented as sixteen-digit 
BCD numbers.

Table 36: Functions for binary coded decimal operations 
C430-7

Part 2. Compiler reference 217



218

Descriptions of intrinsic functions
__bis_SR_register

Syntax void __bis_SR_register(unsigned short);

Description Sets bits in the status register. The function takes an integer literal as its argument, that 
is, a bit mask with the bits to be set.

__bis_SR_register_on_exit

Syntax void __bis_SR_register_on_exit(unsigned short);

Description Sets bits in the processor status register when an interrupt or monitor function returns. 
The function takes an integer literal as its argument, that is, a bit mask with the bits to 
be set.

This intrinsic function is only available in interrupt and monitor functions.

__data16_read_addr

Syntax unsigned long __data16_read_addr(unsigned short address);

where:

Description Reads data from a 20-bit SFR register located at the given 16-bit address. This intrinsic 
function is only useful on devices based on the MSP430X architecture.

__data16_write_addr

Syntax void __data16_write_addr(unsigned short address,
                           unsigned long data);

where:

address Specifies the address for the read operation

address Specifies the address for the write operation

data The data to be written
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Description Writes a value to a 20-bit SFR register located at the given 16-bit address. This intrinsic 
function is only useful on devices based on the MSP430X architecture.

__data20_read_type

Syntax unsigned type __data20_read_type(unsigned long address);

where:

Description Reads data from the MSP430X full 1-Mbyte memory area. This intrinsic function is 
intended to be used in the Small data model. In the Medium and Large data models it is 
recommended to use __data20 variables and pointers.

The following functions are supported:

__data20_write_type

Syntax void __data20_write_type(unsigned long address, unsigned type);

where:

address Specifies the address for the read operation

type Can be one of the types char, short, or long

Function Operation size Alignment

unsigned char __data20_read_char 1 byte 1

unsigned short __data20_read_short 2 bytes 2

unsigned long __data20_read_long 4 bytes 2

Table 37: Functions for reading data that has a 20-bit address 

address Specifies the address for the write operation

type Can be one of the types char, short, or long
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Description Writes data to the MSP430X full 1-Mbyte memory area. This intrinsic function is 
intended to be used in the Small data model. In the Medium and Large data models it is 
recommended to use __data20 variables and pointers.

The following functions are supported:

__delay_cycles

Syntax void __delay_cycles(unsigned long cycles);

Parameters

Description Inserts assembler instructions that delays execution the number of clock cycles 
specified.

__disable_interrupt

Syntax void __disable_interrupt(void);

Description Disables interrupts by inserting the DI instruction.

__enable_interrupt

Syntax void __enable_interrupt(void);

Description Enables interrupts by inserting the EI instruction.

Function Operation size Alignment

unsigned char __data20_write_char 1 byte 1

unsigned short __data20_write_short 2 bytes 2

unsigned long __data20_write_long 4 bytes 2

Table 38: Functions for writing data that has a 20-bit address 

cycles The time delay in number of cycles.
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__even_in_range

Syntax unsigned short __even_in_range(unsigned short value,
                               unsigned short upper_limit);

Parameters

Description Instructs the compiler to rely on the specified value being even and within the specified 
range. The code will be generated accordingly and will only work if the requirement is 
fulfilled.

This intrinsic function can be used for achieving optimal code for switch statements 
where you know that the only values possible are even values within a given range, for 
example an interrupt service routine for an Interrupt Vector Generator interrupt. 

Example switch (__even_in_range(TAIV, 10))

See also Interrupt Vector Generator interrupt functions, page 25.

__get_interrupt_state

Syntax __istate_t __get_interrupt_state(void);

Description Returns the global interrupt state. The return value can be used as an argument to the 
__set_interrupt_state intrinsic function, which will restore the interrupt state.

Example __istate_t s = __get_interrupt_state();
__disable_interrupt();

  /* Do something */

__set_interrupt_state(s);

The advantage of using this sequence of code compared to using 
__disable_interrupt and __enable_interrupt is that the code in this example 
will not enable any interrupts disabled.

value The switch expression

upper_limit The last value in the allowed range
C430-7

Part 2. Compiler reference 221



222

Descriptions of intrinsic functions
__get_R4_register

Syntax unsigned short __get_R4_register(void);

Description Returns the value of the R4 register. This intrinsic function is only available when the 
register is locked.

See also --lock_r4, page 154

__get_R5_register

Syntax unsigned short __get_R5_register(void);

Description Returns the value of the R5 register. This intrinsic function is only available when the 
register is locked.

See also --lock_r5, page 154

__get_SP_register

Syntax unsigned short __get_SP_register(void);

Description Returns the value of the stack pointer register SP.

__get_SR_register

Syntax unsigned short __get_SR_register(void);

Description Returns the value of the processor status register SR.

__get_SR_register_on_exit

Syntax unsigned short __get_SR_register_on_exit(void);

Description Returns the value that the processor status register SR will have when the current 
interrupt or monitor function returns.

This intrinsic function is only available in interrupt and monitor functions.
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__low_power_mode_n

Syntax void __low_power_mode_n(void);

Description Enters a MSP430 low power mode, where n can be one of 0–4.

__low_power_mode_off_on_exit

Syntax void __low_power_mode_off_on_exit(void);

Description Turns off the low power mode when a monitor or interrupt function returns. This 
intrinsic function is only available in interrupt and monitor functions.

__no_operation

Syntax void __no_operation(void);

Description Inserts a NOP instruction.

__op_code

Syntax void __op_code(unsigned short);

Description Emits the 16-bit value into the instruction stream for the current function by inserting a 
DC16 constant.

__set_interrupt_state

Syntax void __set_interrupt_state(__istate_t);

Descriptions Restores the interrupt state by setting the value returned by the 
__get_interrupt_state function.

For information about the __istate_t type, see __get_interrupt_state, page 221.
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__set_R4_register

Syntax void __set_R4_register(unsigned short);

Description Writes a specific value to the R4 register. This intrinsic function is only available when 
R4 is locked.

See also --lock_r4, page 154

__set_R5_register

Syntax void __set_R5_register(unsigned short);

Description Writes a specific value to the R5 register. This intrinsic function is only available when 
R5 is locked.

See also --lock_r5, page 154

__set_SP_register

Syntax void __set_SP_register(unsigned short);

Description Writes a specific value to the SP stack pointer register. A warning message is issued if 
the compiler has used the stack in any way at the location where this intrinsic function 
is used.

__swap_bytes

Syntax unsigned short __swap_bytes(unsigned short);

Description Inserts an SWAPB instruction and returns the argument with the upper and lower parts 
interchanged.

Example __swap_bytes(0x1234)

returns 0x3412.
C430-7

MSP430 IAR C/C++ Compiler
Reference Guide



The preprocessor
This chapter gives a brief overview of the preprocessor, including reference 
information about the different preprocessor directives, symbols, and other 
related information.

Overview of the preprocessor
The preprocessor of the MSP430 IAR C/C++ Compiler adheres to the ISO/ANSI 
standard. The compiler also makes the following preprocessor-related features available 
to you:

● Predefined preprocessor symbols

These symbols allow you to inspect the compile-time environment, for example the 
time and date of compilation. For details, see Descriptions of predefined 
preprocessor symbols, page 226.

● User-defined preprocessor symbols defined using a compiler option

In addition to defining your own preprocessor symbols using the #define directive, 
you can also use the option -D, see -D, page 145.

● Preprocessor extensions

There are several preprocessor extensions, for example many pragma directives; for 
more information, see the chapter Pragma directives in this guide. Read also about 
the corresponding _Pragma operator and the other extensions related to the 
preprocessor, see Descriptions of miscellaneous preprocessor extensions, page 228.

● Preprocessor output

Use the option --preprocess to direct preprocessor output to a named file, see 
--preprocess, page 163.

Some parts listed by the ISO/ANSI standard are implementation-defined, for example 
the character set used in the preprocessor directives and inclusion of bracketed and 
quoted filenames. To read more about this, see Preprocessing directives, page 256.
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Descriptions of predefined preprocessor symbols
Descriptions of predefined preprocessor symbols
The following table describes the predefined preprocessor symbols:

Predefined symbol Identifies

__BASE_FILE__ A string that identifies the name of the base source file (that is, 
not the header file), being compiled. See also __FILE__, 
page 226, and --no_path_in_file_macros, page 158.

__BUILD_NUMBER__ A unique integer that identifies the build number of the 
compiler currently in use. The build number does not 
necessarily increase with a compiler that is released later.

__CORE__ An integer that identifies the chip core in use. The symbol 
reflects the --core option and is defined to __430__ for the 
MSP430 architecture and to __430X__ for the MSP430X 
architecture. These symbolic names can be used when testing 
the __CORE__ symbol.

__cplusplus An integer which is defined when the compiler runs in any of 
the C++ modes, otherwise it is undefined. When defined, its 
value is 199711L. This symbol can be used with #ifdef to 
detect whether the compiler accepts C++ code. It is 
particularly useful when creating header files that are to be 
shared by C and C++ code.*

__DATA_MODEL__ An integer that identifies the data model in use. The symbol 
reflects the --data_model option and can be defined to 
__DATA_MODEL_SMALL__, 
__DATA_MODEL_MEDIUM__, or 
__DATA_MODEL_LARGE__.

__DATE__ A string that identifies the date of compilation, which is 
returned in the form "Mmm dd yyyy", for example "Oct 30 

2007". *

__embedded_cplusplus An integer which is defined to 1 when the compiler runs in 
any of the C++ modes, otherwise the symbol is undefined. 
This symbol can be used with #ifdef to detect whether the 
compiler accepts C++ code. It is particularly useful when 
creating header files that are to be shared by C and C++ 
code.*

__FILE__ A string that identifies the name of the file being compiled, 
which can be the base source file as well as any included 
header file. See also __BASE_FILE__, page 226, and 
--no_path_in_file_macros, page 158.*

Table 39: Predefined symbols 
C430-7

MSP430 IAR C/C++ Compiler
Reference Guide



The preprocessor
__func__ A string that identifies the name of the function in which the 
symbol is used. This is useful for assertions and other trace 
utilities. The symbol requires that language extensions are 
enabled, see -e, page 150. See also __REGISTER_MODEL__, 
page 227.

__FUNCTION__ A string that identifies the name of the function in which the 
symbol is used. This is useful for assertions and other trace 
utilities. The symbol requires that language extensions are 
enabled, see -e, page 150. See also __REGISTER_MODEL__, 
page 227.

__IAR_SYSTEMS_ICC__ An integer that identifies the IAR compiler platform. The 
current value is 6. Note that the number could be higher in a 
future version of the product. This symbol can be tested with 
#ifdef to detect whether the code was compiled by a 
compiler from IAR Systems.

__ICC430__ An integer that is set to 1 when the code is compiled with the 
MSP430 IAR C/C++ Compiler.

__LINE__ An integer that identifies the current source line number of 
the file being compiled, which can be the base source file as 
well as any included header file.*

__POSITION_INDEPENDENT

_CODE__

An integer that is set to 1 when the code is compiled with the 
option --pic.

__PRETTY_FUNCTION__ A string that identifies the function name, including parameter 
types and return type, of the function in which the symbol is 
used, for example "void func(char)". This symbol is 
useful for assertions and other trace utilities. The symbol 
requires that language extensions are enabled, see -e, page 
150. See also __func__, page 227.

__REGISTER_MODEL__ An integer that equals one of the following: 
__REGISTER_MODEL_REG16__ (for 430 and 430X in the 
Small data model) or __REGISTER_MODEL_REG20__ (for 
430X in the Medium and Large data model).

__STDC__ An integer that is set to 1, which means the compiler adheres 
to the ISO/ANSI C standard. This symbol can be tested with 
#ifdef to detect whether the compiler in use adheres to 
ISO/ANSI C.*

Predefined symbol Identifies

Table 39: Predefined symbols  (Continued)
C430-7

Part 2. Compiler reference 227



228

Descriptions of miscellaneous preprocessor extensions
* This symbol is required by the ISO/ANSI standard.

Note: The predefined symbol __TID__ is recognized for backward compatibility, but 
it is recommended to use the symbols __CORE__ and __ICC430__ instead.

Descriptions of miscellaneous preprocessor extensions
The following section gives reference information about the preprocessor extensions 
that are available in addition to the predefined symbols, pragma directives, and 
ISO/ANSI directives.

NDEBUG 

Description This preprocessor symbol determines whether any assert macros you have written in 
your application shall be included or not in the built application.

If this symbol is not defined, all assert macros are evaluated. If the symbol is defined, 
all assert macros are excluded from the compilation. In other words, if the symbol is:

● defined, the assert code will not be included

● not defined, the assert code will be included

This means that if you have written any assert code and build your application, you 
should define this symbol to exclude the assert code from the final application.

__STDC_VERSION__ An integer that identifies the version of ISO/ANSI C standard 
in use. The symbols expands to 199409L. This symbol does 
not apply in EC++ mode.*

__SUBVERSION__ An integer that identifies the version letter of the compiler 
version number, for example the C in 4.21C, as an ASCII 
character.

__TIME__ A string that identifies the time of compilation in the form 
"hh:mm:ss".*

__VER__ An integer that identifies the version number of the IAR 
compiler in use. The value of the number is calculated in the 
following way: (100 * the major version number 
+ the minor version number). For example, for 
compiler version 3.34, 3 is the major version number and 34 is 
the minor version number. Hence, the value of __VER__ is 
334.

Predefined symbol Identifies

Table 39: Predefined symbols  (Continued)
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Note that the assert macro is defined in the assert.h standard include file.

In the IAR Embedded Workbench IDE, the NDEBUG symbol is automatically defined if 
you build your application in the Release build configuration.

_Pragma() 

Syntax _Pragma("string")

where string follows the syntax of the corresponding pragma directive.

Description This preprocessor operator is part of the C99 standard and can be used, for example, in 
defines and has the equivalent effect of the #pragma directive.

Note: The -e option—enable language extensions—does not have to be specified.

Example #if NO_OPTIMIZE
  #define NOOPT _Pragma("optimize=none")
#else
  #define NOOPT
#endif

See also See the chapter Pragma directives.

#warning message 

Syntax #warning message

where message can be any string.

Description Use this preprocessor directive to produce messages. Typically, this is useful for 
assertions and other trace utilities, similar to the way the ISO/ANSI standard #error 
directive is used.

__VA_ARGS__

Syntax #define P(...)       __VA_ARGS__
#define P(x,y,...)   x + y + __VA_ARGS__

__VA_ARGS__ will contain all variadic arguments concatenated, including the 
separating commas.

Description Variadic macros are the preprocessor macro equivalents of printf style functions. 
__VA_ARGS__ is part of the C99 standard.
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Example #if DEBUG
  #define DEBUG_TRACE(S,...) printf(S,__VA_ARGS__)
#else
  #define DEBUG_TRACE(S,...)
#endif
...
DEBUG_TRACE("The value is:%d\n",value);

will result in:

printf("The value is:%d\n",value);
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This chapter gives an introduction to the C and C++ library functions. It also 
lists the header files used for accessing library definitions.

For detailed reference information about the library functions, see the online 
help system.

Introduction
The MSP430 IAR C/C++ Compiler provides two different libraries:

● IAR DLIB Library is a complete ISO/ANSI C and C++ library. This library also 
supports floating-point numbers in IEEE 754 format and it can be configured to 
include different levels of support for locale, file descriptors, multibyte characters, 
et cetera.

● IAR CLIB Library is a light-weight library, which is not fully compliant with 
ISO/ANSI C. Neither does it fully support floating-point numbers in IEEE 754 
format or does it support Embedded C++. 

Note that different customization methods are normally needed for these two libraries. 
For additional information, see the chapter The DLIB runtime environment and The 
CLIB runtime environment, respectively.

For detailed information about the library functions, see the online documentation 
supplied with the product. There is also keyword reference information for the DLIB 
library functions. To obtain reference information for a function, select the function 
name in the editor window and press F1.

For additional information about library functions, see the chapter 
Implementation-defined behavior in this guide.

HEADER FILES

Your application program gains access to library definitions through header files, which 
it incorporates using the #include directive. The definitions are divided into a number 
of different header files, each covering a particular functional area, letting you include 
just those that are required.

It is essential to include the appropriate header file before making any reference to its 
definitions. Failure to do so can cause the call to fail during execution, or generate error 
or warning messages at compile time or link time.
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LIBRARY OBJECT FILES

Most of the library definitions can be used without modification, that is, directly from 
the library object files that are supplied with the product. For information about how to 
choose a runtime library, see Basic settings for project configuration, page 5. The linker 
will include only those routines that are required—directly or indirectly—by your 
application.

REENTRANCY

A function that can be simultaneously invoked in the main application and in any 
number of interrupts is reentrant. A library function that uses statically allocated data is 
therefore not reentrant. 

Most parts of the DLIB library are reentrant, but the following functions and parts are 
not reentrant as they need static data:

● Heap functions—malloc, free, realloc, calloc, as well as the C++ operators 
new and delete

● Time functions—asctime, localtime, gmtime, mktime

● Multibyte functions—mbrlen, mbrtowc, mbsrtowc, wcrtomb, wcsrtomb, 
wctomb

● The miscellaneous functions setlocale, rand, atexit, strerror, strtok

● Functions that use files in some way. This includes printf, scanf, getchar, and 
putchar. The functions sprintf and sscanf are not included.

For the CLIB library, the qsort function is non-reentrant, as well as functions that use 
files in some way. This includes printf, scanf, getchar, and putchar. The 
functions sprintf and sscanf are not included.

In addition, some functions share the same storage for errno. These functions are not 
reentrant, since an errno value resulting from one of these functions can be destroyed 
by a subsequent use of the function before it has been read. Among these functions are:

exp, exp10, ldexp, log, log10, pow, sqrt, acos, asin, atan2, 
cosh, sinh, strtod, strtol, strtoul

Remedies for this are:

● Do not use non-reentrant functions in interrupt service routines

● Guard calls to a non-reentrant function by a mutex, or a secure region, etc.
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IAR DLIB Library
The IAR DLIB Library provides most of the important C and C++ library definitions 
that apply to embedded systems. These are of the following types:

● Adherence to a free-standing implementation of the ISO/ANSI standard for the 
programming language C. For additional information, see the chapter 
Implementation-defined behavior in this guide.

● Standard C library definitions, for user programs.

● Embedded C++ library definitions, for user programs.

● CSTARTUP, the module containing the start-up code. It is described in the chapter 
The DLIB runtime environment in this guide.

● Runtime support libraries; for example low-level floating-point routines.

● Intrinsic functions, allowing low-level use of MSP430 features. See the chapter 
Intrinsic functions for more information.

In addition, the IAR DLIB Library includes some added C functionality, partly taken 
from the C99 standard, see Added C functionality, page 236.

C HEADER FILES

This section lists the header files specific to the DLIB library C definitions. Header files 
may additionally contain target-specific definitions; these are documented in the chapter 
Compiler extensions.

The following table lists the C header files:

Header file Usage

assert.h Enforcing assertions when functions execute

ctype.h Classifying characters

errno.h Testing error codes reported by library functions

float.h Testing floating-point type properties

inttypes.h Defining formatters for all types defined in stdint.h

iso646.h Using Amendment 1—iso646.h standard header

limits.h Testing integer type properties

locale.h Adapting to different cultural conventions

math.h Computing common mathematical functions

setjmp.h Executing non-local goto statements

signal.h Controlling various exceptional conditions

stdarg.h Accessing a varying number of arguments

Table 40: Traditional standard C header files—DLIB 
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IAR DLIB Library
C++ HEADER FILES

This section lists the C++ header files.

Embedded C++

The following table lists the Embedded C++ header files:

stdbool.h Adds support for the bool data type in C.

stddef.h Defining several useful types and macros

stdint.h Providing integer characteristics

stdio.h Performing input and output

stdlib.h Performing a variety of operations

string.h Manipulating several kinds of strings

time.h Converting between various time and date formats

wchar.h Support for wide characters

wctype.h Classifying wide characters

Header file Usage

complex Defining a class that supports complex arithmetic

exception Defining several functions that control exception handling

fstream Defining several I/O stream classes that manipulate external files

iomanip Declaring several I/O stream manipulators that take an argument

ios Defining the class that serves as the base for many I/O streams classes

iosfwd Declaring several I/O stream classes before they are necessarily defined

iostream Declaring the I/O stream objects that manipulate the standard streams

istream Defining the class that performs extractions

new Declaring several functions that allocate and free storage

ostream Defining the class that performs insertions

sstream Defining several I/O stream classes that manipulate string containers

stdexcept Defining several classes useful for reporting exceptions

streambuf Defining classes that buffer I/O stream operations

string Defining a class that implements a string container

strstream Defining several I/O stream classes that manipulate in-memory character 
sequences

Table 41: Embedded C++ header files 

Header file Usage

Table 40: Traditional standard C header files—DLIB  (Continued)
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The following table lists additional C++ header files:

Extended Embedded C++ standard template library

The following table lists the Extended EC++ standard template library (STL) header 
files:

Using standard C libraries in C++

The C++ library works in conjunction with 15 of the header files from the standard C 
library, sometimes with small alterations. The header files come in two forms—new and 
traditional—for example, cassert and assert.h. 

Header file Usage

fstream.h Defining several I/O stream classes that manipulate external files

iomanip.h Declaring several I/O stream manipulators that take an argument

iostream.h Declaring the I/O stream objects that manipulate the standard streams

new.h Declaring several functions that allocate and free storage

Table 42: Additional Embedded C++ header files—DLIB 

Header file Description

algorithm Defines several common operations on sequences

deque A deque sequence container

functional Defines several function objects

hash_map A map associative container, based on a hash algorithm

hash_set A set associative container, based on a hash algorithm

iterator Defines common iterators, and operations on iterators

list A doubly-linked list sequence container

map A map associative container

memory Defines facilities for managing memory

numeric Performs generalized numeric operations on sequences

queue A queue sequence container

set A set associative container

slist A singly-linked list sequence container

stack A stack sequence container

utility Defines several utility components

vector A vector sequence container

Table 43: Standard template library header files 
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IAR DLIB Library
The following table shows the new header files:

LIBRARY FUNCTIONS AS INTRINSIC FUNCTIONS

Certain C library functions will under some circumstances be handled as intrinsic 
functions and will generate inline code instead of an ordinary function call, for example 
memcpy, memset, and strcat.

ADDED C FUNCTIONALITY

The IAR DLIB Library includes some added C functionality, partly taken from the C99 
standard.

The following include files provide these features:

● ctype.h

● inttypes.h

Header file Usage

cassert Enforcing assertions when functions execute

cctype Classifying characters

cerrno Testing error codes reported by library functions

cfloat Testing floating-point type properties

cinttypes Defining formatters for all types defined in stdint.h

climits Testing integer type properties

clocale Adapting to different cultural conventions

cmath Computing common mathematical functions

csetjmp Executing non-local goto statements

csignal Controlling various exceptional conditions

cstdarg Accessing a varying number of arguments

cstdbool Adds support for the bool data type in C.

cstddef Defining several useful types and macros

cstdint Providing integer characteristics

cstdio Performing input and output

cstdlib Performing a variety of operations

cstring Manipulating several kinds of strings

ctime Converting between various time and date formats

cwchar Support for wide characters

cwctype Classifying wide characters

Table 44: New standard C header files—DLIB 
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● math.h

● stdbool.h

● stdint.h

● stdio.h

● stdlib.h

● wchar.h

● wctype.h

ctype.h

In ctype.h, the C99 function isblank is defined.

inttypes.h

This include file defines the formatters for all types defined in stdint.h to be used by 
the functions printf, scanf, and all their variants.

math.h

In math.h all functions exist in a float variant and a long double variant, suffixed 
by f and l respectively. For example, sinf and sinl.

The following C99 macro symbols are defined:

HUGE_VALF, HUGE_VALL, INFINITY, NAN, FP_INFINITE, FP_NAN, FP_NORMAL, 
FP_SUBNORMAL, FP_ZERO, MATH_ERRNO, MATH_ERREXCEPT, math_errhandling.

The following C99 macro functions are defined:

fpclassify, signbit, isfinite, isinf, isnan, isnormal, isgreater, isless, 
islessequal, islessgreater, isunordered.

The following C99 type definitions are added:

float_t, double_t.

stdbool.h

This include file makes the bool type available if the Allow IAR extensions (-e) option 
is used.

stdint.h

This include file provides integer characteristics.
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stdio.h

In stdio.h, the following C99 functions are defined:

vscanf, vfscanf, vsscanf, vsnprintf, snprintf

The functions printf, scanf, and all their variants have added functionality from the 
C99 standard. For reference information about these functions, see the library reference 
available from the Help menu.

The following functions providing I/O functionality for libraries built without FILE 
support are definded:

stdlib.h

In stdlib.h, the following C99 functions are defined:

_Exit, llabs, lldiv, strtoll, strtoull, atoll, strtof, strtold.

The function strtod has added functionality from the C99 standard. For reference 
information about this functions, see the library reference available from the Help 
menu.

The __qsortbbl function is defined; it provides sorting using a bubble sort algorithm. 
This is useful for applications that have a limited stack.

wchar.h

In wchar.h, the following C99 functions are defined:

vfwscanf, vswscanf, vwscanf, wcstof, wcstolb.

wctype.h

In wctype.h, the C99 function iswblank is defined.

IAR CLIB Library
The IAR CLIB Library provides most of the important C library definitions that apply 
to embedded systems. These are of the following types:

● Standard C library definitions available for user programs. These are documented in 
this chapter.

__write_array Corresponds to fwrite on stdout.

__ungetchar Corresponds to ungetc on stdout.

__gets Corresponds to fgets on stdin.
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● The system startup code. It is described in the chapter The CLIB runtime 
environment in this guide.

● Runtime support libraries; for example low-level floating-point routines.

● Intrinsic functions, allowing low-level use of MSP430 features. See the chapter 
Intrinsic functions for more information.

LIBRARY DEFINITIONS SUMMARY

This following table lists the header files specific to the CLIB library:

* The functions isxxx, toupper, and tolower declared in the header file ctype.h evaluate 
their argument more than once. This is not according to the ISO/ANSI standard.

Header file Description

assert.h Assertions

ctype.h* Character handling

errno.h Error return values

float.h Limits and sizes of floating-point types

iccbutl.h Low-level routines

limits.h Limits and sizes of integral types

math.h Mathematics

setjmp.h Non-local jumps

stdarg.h Variable arguments

stdbool.h Adds support for the bool data type in C

stddef.h Common definitions including size_t, NULL, 
ptrdiff_t, and offsetof

stdio.h Input/output

stdlib.h General utilities

string.h String handling

Table 45: IAR CLIB Library header files 
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Segment reference
The MSP430 IAR C/C++ Compiler places code and data into named segments 
which are referred to by the IAR XLINK Linker. Details about the segments 
are required for programming assembler language modules, and are also useful 
when interpreting the assembler language output from the compiler.

For more information about segments, see the chapter Placing code and data.

Summary of segments 
The table below lists the segments that are available in the MSP430 IAR C/C++ 
Compiler:

Segment Description

CODE Holds the program code.

CSTACK Holds the stack used by C or C++ programs.

CSTART Holds the startup code.

DATA16_AC Holds __data16 located constant data.

DATA16_AN Holds __data16 located uninitialized data.

DATA16_C Holds __data16 constant data.

DATA16_HEAP Holds the heap used for dynamically allocated data.

DATA16_I Holds __data16 static and global initialized variables.

DATA16_ID Holds initial values for __data16 static and global variables in 
DATA16_I.

DATA16_N Holds __no_init __data16 static and global variables.

DATA16_Z Holds zero-initialized __data16 static and global variables.

DATA20_AC Holds __data20 located constant data.

DATA20_AN Holds __data20 located uninitialized data.

DATA20_C Holds __data20 constant data.

DATA20_HEAP Holds the heap used for dynamically allocated data.

DATA20_I Holds __data20 static and global initialized variables.

DATA20_ID Holds initial values for __data20 static and global variables in 
DATA20_I.

Table 46: Segment summary 
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Descriptions of segments
This section gives reference information about each segment.

The segments are placed in memory by using the segment placement linker directives 
-Z and -P, for sequential and packed placement, respectively. Some segments cannot 
use packed placement, as their contents must be continuous.

In each description, the segment memory type—CODE, CONST, or DATA—indicates 
whether the segment should be placed in ROM or RAM memory; see Table 5, XLINK 
segment memory types, page 32.

For information about the -Z and the -P directives, see the IAR Linker and Library Tools 
Reference Guide.

For information about how to define segments in the linker command file, see 
Customizing the linker command file, page 33.

For detailed information about the extended keywords mentioned here, see the chapter 
Extended keywords.

CODE

Description Holds program code, except the code for system initialization.

Segment memory type CODE

Memory placement MSP430:  0x0002–0xFFFF

MSP430X: 0x00002–0xFFFFF

Access type Read-only

DATA20_N Holds __no_init __data20 static and global variables.

DATA20_Z Holds zero-initialized __data20 static and global variables.

DIFUNCT Holds pointers to code, typically C++ constructors, that should be 
executed by the system startup code before main is called.

INTVEC Contains the reset and interrupt vectors.

ISR_CODE Holds interrupt functions when compiling for the MSP430X architecture.

REGVAR_AN Holds __regvar located uninitialized data.

RESET Holds the reset vector.

Segment Description

Table 46: Segment summary  (Continued)
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CSTACK 

Description Holds the internal data stack.

Segment memory type DATA

Memory placement 0x0002–0xFFFD (also for the MSP430X architecture)

Access type Read/write

See also The stack, page 37.

CSTART

Description Holds the startup code.

This segment cannot be placed in memory by using the -P directive for packed 
placement, because the contents must be continuous. Instead, when you define this 
segment in the linker command file, the -Z directive must be used. 

Segment memory type CODE

Memory placement 0x0002–0xFFFF

Access type Read-only

DATA16_AC

Description Holds __data16 located constant data.

Because the location is known, this segment does not have to be specified in the linker 
command file. Located means being placed at an absolute location using the @ operator 
or the #pragma location directive.

DATA16_AN

Description Holds __no_init __data16 located data.

Because the location is known, this segment does not have to be specified in the linker 
command file. Located means being placed at an absolute location using the @ operator 
or the #pragma location directive.
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DATA16_C

Description Holds __data16 constant data.

Segment memory type CONST

Memory placement 0x0001–0xFFFE

Access type Read-only

DATA16_HEAP

Description Holds the heap used for dynamically allocated data in data16 memory, in other words 
data allocated by malloc and free, and in C++, new and delete. 

Segment memory type DATA

Memory placement This segment must be placed in the first 64 Kbytes of memory.

Access type Read/write

See also  The heap, page 39 and New and Delete operators, page 106.

DATA16_I

Description Holds __data16 static and global initialized variables initialized by copying from the 
segment DATA16_ID at application startup.

This segment cannot be placed in memory by using the -P directive for packed 
placement, because the contents must be continuous. Instead, when you define this 
segment in the linker command file, the -Z directive must be used.

Segment memory type DATA

Memory placement 0x0001–0xFFFE

Access type Read/write
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DATA16_ID

Description Holds initial values for __data16 static and global variables in the DATA16_I segment. 
These values are copied from DATA16_ID to DATA16_I at application startup.

This segment cannot be placed in memory by using the -P directive for packed 
placement, because the contents must be continuous. Instead, when you define this 
segment in the linker command file, the -Z directive must be used.

Segment memory type CONST

Memory placement 0x0001–0xFFFE

Access type Read-only

DATA16_N

Description Holds static and global __no_init __data16 variables.

Segment memory type DATA

Memory placement 0x0001–0xFFFE

Access type Read/write

DATA16_Z

Description Holds zero-initialized __data16 static and global variables. The contents of this 
segment is cleared by the system startup code.

This segment cannot be placed in memory by using the -P directive for packed 
placement, because the contents must be continuous. Instead, when you define this 
segment in the linker command file, the -Z directive must be used.

Segment memory type DATA

Memory placement 0x0001–0xFFFE

Access type Read/write
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DATA20_AC

Description Holds __data20 located constant data.

Because the location is known, this segment does not have to be specified in the linker 
command file. Located means being placed at an absolute location using the @ operator 
or the #pragma location directive.

DATA20_AN

Description Holds __no_init __data20 located data.

Because the location is known, this segment does not have to be specified in the linker 
command file. Located means being placed at an absolute location using the @ operator 
or the #pragma location directive.

DATA20_C

Description Holds __data20 constant data.

Segment memory type CONST

Memory placement 0x00001–0xFFFFE

Access type Read-only

DATA20_HEAP

Description Holds the heap used for dynamically allocated data in data20 memory, in other words 
data allocated by data20_malloc and data20_free, and in C++, new and delete. 

Segment memory type DATA

Memory placement 0x00001–0xFFFFE

Access type Read/write

See also  The heap, page 39 and New and Delete operators, page 106.
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DATA20_I

Description Holds __data20 static and global initialized variables initialized by copying from the 
segment DATA20_ID at application startup.

This segment cannot be placed in memory by using the -P directive for packed 
placement, because the contents must be continuous. Instead, when you define this 
segment in the linker command file, the -Z directive must be used.

Segment memory type DATA

Memory placement 0x00001–0xFFFFE

Access type Read/write

DATA20_ID

Description Holds initial values for __data20 static and global variables in the DATA20_I segment. 
These values are copied from DATA20_ID to DATA20_I at application startup.

This segment cannot be placed in memory by using the -P directive for packed 
placement, because the contents must be continuous. Instead, when you define this 
segment in the linker command file, the -Z directive must be used.

Segment memory type CONST

Memory placement 0x00001–0xFFFFE

Access type Read-only

DATA20_N

Description Holds static and global __no_init __data20 variables.

Segment memory type DATA

Memory placement 0x00001–0xFFFFE

Access type Read/write
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DATA20_Z

Description Holds zero-initialized __data20 static and global variables. The contents of this 
segment is cleared by the system startup code.

This segment cannot be placed in memory by using the -P directive for packed 
placement, because the contents must be continuous. Instead, when you define this 
segment in the linker command file, the -Z directive must be used.

Segment memory type DATA

Memory placement 0x00001–0xFFFFE

Access type Read/write

DIFUNCT

Description Holds the dynamic initialization vector used by C++.

Segment memory type CONST

Memory placement This segment must be placed in the first 64 Kbytes of memory.

Access type Read-only

INTVEC 

Description Holds the interrupt vector table generated by the use of the __interrupt extended 
keyword in combination with the #pragma vector directive.

Segment memory type CODE

Placement The start address depends on the device and the end address must be 0xFFFF.

Access type Read-only
C430-7

MSP430 IAR C/C++ Compiler
Reference Guide



Segment reference
ISR_CODE

Description Holds interrupt functions when compiling for the MSP430X architecture. This segment 
is not used when compiling for the MSP430 architecture.

Segment memory type CODE

Memory placement 0x0002–0xFFFF

Access type Read-only

REGVAR_AN

Description Holds __regvar located uninitialized data.

RESET

Description Holds the reset vector.

Segment memory type CODE

Memory placement 0xFFFE–0xFFFF

Access type Read-only
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Implementation-defined 
behavior
This chapter describes how the MSP430 IAR C/C++ Compiler handles the 
implementation-defined areas of the C language.

ISO 9899:1990, the International Organization for Standardization standard - 
Programming Languages - C (revision and redesign of ANSI X3.159-1989, 
American National Standard), changed by the ISO Amendment 1:1994, 
Technical Corrigendum 1, and Technical Corrigendum 2, contains an appendix 
called Portability Issues. The ISO appendix lists areas of the C language that ISO 
leaves open to each particular implementation.

Note: The MSP430 IAR C/C++ Compiler adheres to a freestanding 
implementation of the ISO standard for the C programming language. This 
means that parts of a standard library can be excluded in the implementation.

Descriptions of implementation-defined behavior
This section follows the same order as the ISO appendix. Each item covered includes 
references to the ISO chapter and section (in parenthesis) that explains the 
implementation-defined behavior.

TRANSLATION

Diagnostics (5.1.1.3)

Diagnostics are produced in the form:

filename,linenumber level[tag]: message

where filename is the name of the source file in which the error was encountered, 
linenumber is the line number at which the compiler detected the error, level is the 
level of seriousness of the message (remark, warning, error, or fatal error), tag is a 
unique tag that identifies the message, and message is an explanatory message, possibly 
several lines.
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ENVIRONMENT

Arguments to main (5.1.2.2.2.1)

The function called at program startup is called main. There is no prototype declared for 
main, and the only definition supported for main is:

int main(void)

To change this behavior for the IAR DLIB runtime environment, see Customizing 
system initialization, page 59. To change this behavior for the IAR CLIB runtime 
environment, see Customizing system initialization, page 80. 

Interactive devices (5.1.2.3)

The streams stdin and stdout are treated as interactive devices.

IDENTIFIERS

Significant characters without external linkage (6.1.2)

The number of significant initial characters in an identifier without external linkage is 
200.

Significant characters with external linkage (6.1.2)

The number of significant initial characters in an identifier with external linkage is 200.

Case distinctions are significant (6.1.2)

Identifiers with external linkage are treated as case-sensitive.

CHARACTERS

Source and execution character sets (5.2.1)

The source character set is the set of legal characters that can appear in source files. The 
default source character set is the standard ASCII character set. However, if you use the 
command line option --enable_multibytes, the source character set will be the host 
computer’s default character set.

The execution character set is the set of legal characters that can appear in the execution 
environment. The default execution character set is the standard ASCII character set. 
However, if you use the command line option --enable_multibytes, the execution 
character set will be the host computer’s default character set. The IAR DLIB Library 
needs a multibyte character scanner to support a multibyte execution character set. The 
IAR CLIB Library does not support multibyte characters.
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See Locale, page 64.

Bits per character in execution character set (5.2.4.2.1)

The number of bits in a character is represented by the manifest constant CHAR_BIT. The 
standard include file limits.h defines CHAR_BIT as 8.

Mapping of characters (6.1.3.4)

The mapping of members of the source character set (in character and string literals) to 
members of the execution character set is made in a one-to-one way. In other words, the 
same representation value is used for each member in the character sets except for the 
escape sequences listed in the ISO standard.

Unrepresented character constants (6.1.3.4)

The value of an integer character constant that contains a character or escape sequence 
not represented in the basic execution character set or in the extended character set for 
a wide character constant generates a diagnostic message, and will be truncated to fit the 
execution character set.

Character constant with more than one character (6.1.3.4)

An integer character constant that contains more than one character will be treated as an 
integer constant. The value will be calculated by treating the leftmost character as the 
most significant character, and the rightmost character as the least significant character, 
in an integer constant. A diagnostic message will be issued if the value cannot be 
represented in an integer constant.

A wide character constant that contains more than one multibyte character generates a 
diagnostic message.

Converting multibyte characters (6.1.3.4)

The only locale supported—that is, the only locale supplied with the IAR C/C++ 
Compiler—is the ‘C’ locale. If you use the command line option 
--enable_multibytes, the IAR DLIB Library will support multibyte characters if 
you add a locale with multibyte support or a multibyte character scanner to the library. 
The IAR CLIB Library does not support multibyte characters.

See Locale, page 64.

Range of 'plain' char (6.2.1.1)

A ‘plain’ char has the same range as an unsigned char.
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INTEGERS

Range of integer values (6.1.2.5)

The representation of integer values are in the two's complement form. The most 
significant bit holds the sign; 1 for negative, 0 for positive and zero. 

See Basic data types, page 170, for information about the ranges for the different integer 
types.

Demotion of integers (6.2.1.2)

Converting an integer to a shorter signed integer is made by truncation. If the value 
cannot be represented when converting an unsigned integer to a signed integer of equal 
length, the bit-pattern remains the same. In other words, a large enough value will be 
converted into a negative value.

Signed bitwise operations (6.3)

Bitwise operations on signed integers work the same way as bitwise operations on 
unsigned integers; in other words, the sign-bit will be treated as any other bit.

Sign of the remainder on integer division (6.3.5)

The sign of the remainder on integer division is the same as the sign of the dividend.

Negative valued signed right shifts (6.3.7)

The result of a right-shift of a negative-valued signed integral type preserves the sign-bit. 
For example, shifting 0xFF00 down one step yields 0xFF80.

FLOATING POINT

Representation of floating-point values (6.1.2.5)

The representation and sets of the various floating-point numbers adheres to IEEE 
854–1987. A typical floating-point number is built up of a sign-bit (s), a biased 
exponent (e), and a mantissa (m). 

See Floating-point types, page 172, for information about the ranges and sizes for the 
different floating-point types: float and double.

Converting integer values to floating-point values (6.2.1.3)

When an integral number is cast to a floating-point value that cannot exactly represent 
the value, the value is rounded (up or down) to the nearest suitable value.
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Demoting floating-point values (6.2.1.4)

When a floating-point value is converted to a floating-point value of narrower type that 
cannot exactly represent the value, the value is rounded (up or down) to the nearest 
suitable value.

ARRAYS AND POINTERS

size_t (6.3.3.4, 7.1.1)

See size_t, page 174, for information about size_t.

Conversion from/to pointers (6.3.4)

See Casting, page 174, for information about casting of data pointers and function 
pointers.

ptrdiff_t (6.3.6, 7.1.1)

See ptrdiff_t, page 174, for information about the ptrdiff_t.

REGISTERS

Honoring the register keyword (6.5.1)

User requests for register variables are not honored.

STRUCTURES, UNIONS, ENUMERATIONS, AND BITFIELDS

Improper access to a union (6.3.2.3)

If a union gets its value stored through a member and is then accessed using a member 
of a different type, the result is solely dependent on the internal storage of the first 
member.

Padding and alignment of structure members (6.5.2.1)

See the section Basic data types, page 170, for information about the alignment 
requirement for data objects.

Sign of 'plain' bitfields (6.5.2.1)

A 'plain' int bitfield is treated as a signed int bitfield. All integer types are allowed as 
bitfields.
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Allocation order of bitfields within a unit (6.5.2.1)

Bitfields are allocated within an integer from least-significant to most-significant bit.

Can bitfields straddle a storage-unit boundary (6.5.2.1)

Bitfields cannot straddle a storage-unit boundary for the chosen bitfield integer type. 

Integer type chosen to represent enumeration types (6.5.2.2)

The chosen integer type for a specific enumeration type depends on the enumeration 
constants defined for the enumeration type. The chosen integer type is the smallest 
possible.

QUALIFIERS

Access to volatile objects (6.5.3)

Any reference to an object with volatile qualified type is an access.

DECLARATORS

Maximum numbers of declarators (6.5.4)

The number of declarators is not limited. The number is limited only by the available 
memory.

STATEMENTS

Maximum number of case statements (6.6.4.2)

The number of case statements (case values) in a switch statement is not limited. The 
number is limited only by the available memory.

PREPROCESSING DIRECTIVES

Character constants and conditional inclusion (6.8.1)

The character set used in the preprocessor directives is the same as the execution 
character set. The preprocessor recognizes negative character values if a 'plain' character 
is treated as a signed character.

Including bracketed filenames (6.8.2)

For file specifications enclosed in angle brackets, the preprocessor does not search 
directories of the parent files. A parent file is the file that contains the #include 
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directive. Instead, it begins by searching for the file in the directories specified on the 
compiler command line.

Including quoted filenames (6.8.2)

For file specifications enclosed in quotes, the preprocessor directory search begins with 
the directories of the parent file, then proceeds through the directories of any 
grandparent files. Thus, searching begins relative to the directory containing the source 
file currently being processed. If there is no grandparent file and the file has not been 
found, the search continues as if the filename was enclosed in angle brackets.

Character sequences (6.8.2)

Preprocessor directives use the source character set, with the exception of escape 
sequences. Thus, to specify a path for an include file, use only one backslash:

#include "mydirectory\myfile"

Within source code, two backslashes are necessary:

file = fopen("mydirectory\\myfile","rt");

Recognized pragma directives (6.8.6)

In addition to the pragma directives described in the chapter Pragma directives, the 
following directives are recognized but will have no effect:

alignment

ARGSUSED

baseaddr

can_instantiate

codeseg

cspy_support

define_type_info

do_not_instantiate

function

hdrstop

instantiate

keep_definition

memory

module_name

none

no_pch

NOTREACHED
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once 

__printf_args

public_equ

__scanf_args

section

system_include

VARARGS

warnings

Default __DATE__ and __TIME__ (6.8.8)

The definitions for __TIME__ and __DATE__ are always available.

IAR DLIB LIBRARY FUNCTIONS

The information in this section is valid only if the runtime library configuration you have 
chosen supports file descriptors. See the chapter The DLIB runtime environment for 
more information about runtime library configurations.

NULL macro (7.1.6)

The NULL macro is defined to 0.

Diagnostic printed by the assert function (7.2)

The assert() function prints:

filename:linenr expression -- assertion failed

when the parameter evaluates to zero.

Domain errors (7.5.1)

NaN (Not a Number) will be returned by the mathematic functions on domain errors.

Underflow of floating-point values sets errno to ERANGE (7.5.1)

The mathematics functions set the integer expression errno to ERANGE (a macro in 
errno.h) on underflow range errors.

fmod() functionality (7.5.6.4)

If the second argument to fmod() is zero, the function returns NaN; errno is set to 
EDOM. 
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signal() (7.7.1.1)

The signal part of the library is not supported. 

Note: Low-level interface functions exist in the library, but will not perform anything. 
Use the template source code to implement application-specific signal handling. See 
Signal and raise, page 67.

Terminating newline character (7.9.2)

stdout stream functions recognize either newline or end of file (EOF) as the 
terminating character for a line.

Blank lines (7.9.2)

Space characters written to the stdout stream immediately before a newline character 
are preserved. There is no way to read the line through the stdin stream that was 
written through the stdout stream.

Null characters appended to data written to binary streams (7.9.2)

No null characters are appended to data written to binary streams.

Files (7.9.3)

Whether a write operation on a text stream causes the associated file to be truncated 
beyond that point, depends on the application-specific implementation of the low-level 
file routines. See File input and output, page 63.

remove() (7.9.4.1)

The effect of a remove operation on an open file depends on the application-specific 
implementation of the low-level file routines. See File input and output, page 63.

rename() (7.9.4.2)

The effect of renaming a file to an already existing filename depends on the 
application-specific implementation of the low-level file routines. See File input and 
output, page 63.

%p in printf() (7.9.6.1)

The argument to a %p conversion specifier, print pointer, to printf() is treated as 
having the type void *. The value will be printed as a hexadecimal number, similar to 
using the %x conversion specifier.
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%p in scanf() (7.9.6.2)

The %p conversion specifier, scan pointer, to scanf() reads a hexadecimal number and 
converts it into a value with the type void *.

Reading ranges in scanf() (7.9.6.2)

A - (dash) character is always treated as a range symbol.

File position errors (7.9.9.1, 7.9.9.4)

On file position errors, the functions fgetpos and ftell store EFPOS in errno.

Message generated by perror() (7.9.10.4)

The generated message is:

usersuppliedprefix:errormessage

Allocating zero bytes of memory (7.10.3)

The calloc(), malloc(), and realloc() functions accept zero as an argument. 
Memory will be allocated, a valid pointer to that memory is returned, and the memory 
block can be modified later by realloc.

Behavior of abort() (7.10.4.1)

The abort() function does not flush stream buffers, and it does not handle files, 
because this is an unsupported feature.

Behavior of exit() (7.10.4.3)

The argument passed to the exit function will be the return value returned by the main 
function to cstartup.

Environment (7.10.4.4)

The set of available environment names and the method for altering the environment list 
is described in Environment interaction, page 66.

system() (7.10.4.5)

How the command processor works depends on how you have implemented the system 
function. See Environment interaction, page 66.
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Message returned by strerror() (7.11.6.2)

The messages returned by strerror() depending on the argument is:

The time zone (7.12.1)

The local time zone and daylight savings time implementation is described in Time, page 
67.

clock() (7.12.2.1)

From where the system clock starts counting depends on how you have implemented the 
clock function. See Time, page 67.

IAR CLIB LIBRARY FUNCTIONS

NULL macro (7.1.6)

The NULL macro is defined to (void *) 0.

Diagnostic printed by the assert function (7.2)

The assert() function prints:

Assertion failed: expression, file Filename, line linenumber

when the parameter evaluates to zero.

Domain errors (7.5.1)

HUGE_VAL, the largest representable value in a double floating-point type, will be 
returned by the mathematic functions on domain errors.

Argument Message

EZERO no error

EDOM domain error

ERANGE range error

EFPOS file positioning error

EILSEQ multi-byte encoding error

<0 || >99 unknown error

all others error nnn

Table 47: Message returned by strerror()—IAR DLIB library
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Underflow of floating-point values sets errno to ERANGE (7.5.1)

The mathematics functions set the integer expression errno to ERANGE (a macro in 
errno.h) on underflow range errors.

fmod() functionality (7.5.6.4)

If the second argument to fmod() is zero, the function returns zero (it does not change 
the integer expression errno).

signal() (7.7.1.1)

The signal part of the library is not supported. 

Terminating newline character (7.9.2)

stdout stream functions recognize either newline or end of file (EOF) as the 
terminating character for a line.

Blank lines (7.9.2)

Space characters written to the stdout stream immediately before a newline character 
are preserved. There is no way to read the line through the stdin stream that was 
written through the stdout stream.

Null characters appended to data written to binary streams (7.9.2)

There are no binary streams implemented.

Files (7.9.3)

There are no other streams than stdin and stdout. This means that a file system is not 
implemented.

remove() (7.9.4.1)

There are no other streams than stdin and stdout. This means that a file system is not 
implemented.

rename() (7.9.4.2)

There are no other streams than stdin and stdout. This means that a file system is not 
implemented.
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%p in printf() (7.9.6.1)

The argument to a %p conversion specifier, print pointer, to printf() is treated as 
having the type 'char *'. The value will be printed as a hexadecimal number, similar 
to using the %x conversion specifier.

%p in scanf() (7.9.6.2)

The %p conversion specifier, scan pointer, to scanf() reads a hexadecimal number and 
converts it into a value with the type 'void *'.

Reading ranges in scanf() (7.9.6.2)

A - (dash) character is always treated explicitly as a - character.

File position errors (7.9.9.1, 7.9.9.4)

There are no other streams than stdin and stdout. This means that a file system is not 
implemented.

Message generated by perror() (7.9.10.4)

perror() is not supported.

Allocating zero bytes of memory (7.10.3)

The calloc(), malloc(), and realloc() functions accept zero as an argument. 
Memory will be allocated, a valid pointer to that memory is returned, and the memory 
block can be modified later by realloc.

Behavior of abort() (7.10.4.1)

The abort() function does not flush stream buffers, and it does not handle files, 
because this is an unsupported feature.

Behavior of exit() (7.10.4.3)

The exit() function does not return.

Environment (7.10.4.4)

Environments are not supported.

system() (7.10.4.5)

The system() function is not supported.
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Message returned by strerror() (7.11.6.2)

The messages returned by strerror() depending on the argument are:

The time zone (7.12.1)

The time zone function is not supported.

clock() (7.12.2.1)

The clock() function is not supported.

Argument Message

EZERO no error

EDOM domain error

ERANGE range error

<0 || >99 unknown error

all others error No.xx

Table 48: Message returned by strerror()—IAR CLIB library
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